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UNIT 1-TODAY’S TECHNOLOGIES 

Over the years, technology has revolutionized our world. Technology has created amazing tools and 
resources, putting useful information at their fingertips. Modern technology has made it possible for the 
discovery of many functional and utility devices like the smartwatch and the smartphone. With all these 
revolutions, technology has also made our lives easier, faster, better… and more fun. 

COMPUTERS 

A computer is a device that can be instructed to carry 
out sequences of arithmetic or logical operations automatically via computer programming. Modern 
computers have the ability to follow generalized sets of operations, called programs. These programs 
enable computers to perform an extremely wide range of tasks. A "complete" computer including 
the hardware, the operating system (main software), and peripheral equipment required and used for 
"full" operation can be referred to as a computer system. This term may as well be used for a group of 
computers that are connected and work together, in particular a computer network or computer 
cluster. 

Computers are used as control systems for a wide variety of industrial and consumer devices. This 
includes simple special purpose devices like microwave ovens and remote controls, factory devices 
such as industrial robots and computer-aided design, and also general purpose devices like personal 
computers and mobile devices such as smartphones. The Internet is run on computers and it 
connects hundreds of millions of other computers and their users. 

LAPTOPS 

A laptop computer, sometimes called a notebook computer 
by manufacturers, is a battery- or AC-powered personal 
computer generally smaller than a briefcase that can easily 
be transported and conveniently used in temporary spaces 
such as on airplanes, in libraries, temporary offices, and at 
meetings. A laptop typically weighs less than 5 pounds and is 
3 inches or less in thickness. Among the best-known makers 
of laptop computers are IBM, Apple, Compaq, Dell, and Toshiba. 

TABLETS  

A tablet computer, commonly shortened to tablet, is a mobile device, typically with a mobile operating 
system and touchscreen display processing circuitry, and a rechargeable battery in a single thin, flat 
package. Tablets, being computers, do what other personal computers do, but lack some input/output 
(I/O) abilities that others have. Modern tablets largely resemble modern smartphones, the only 
differences being that tablets are relatively larger than smartphones, with screens 7 inches (18 cm) or 
larger, measured diagonally, and may not support access to a cellular network. 

https://en.wikipedia.org/wiki/Sequence
https://en.wikipedia.org/wiki/Arithmetic
https://en.wikipedia.org/wiki/Boolean_algebra
https://en.wikipedia.org/wiki/Computer_programming
https://en.wikipedia.org/wiki/Computer_program
https://en.wikipedia.org/wiki/Computer_hardware
https://en.wikipedia.org/wiki/Operating_system
https://en.wikipedia.org/wiki/Software
https://en.wikipedia.org/wiki/Peripheral
https://en.wikipedia.org/wiki/Computer_network
https://en.wikipedia.org/wiki/Computer_cluster
https://en.wikipedia.org/wiki/Computer_cluster
https://en.wikipedia.org/wiki/Control_system
https://en.wikipedia.org/wiki/Programmable_logic_controller
https://en.wikipedia.org/wiki/Consumer_electronics
https://en.wikipedia.org/wiki/Microwave_oven
https://en.wikipedia.org/wiki/Remote_control
https://en.wikipedia.org/wiki/Industrial_robot
https://en.wikipedia.org/wiki/Computer-aided_design
https://en.wikipedia.org/wiki/Personal_computer
https://en.wikipedia.org/wiki/Personal_computer
https://en.wikipedia.org/wiki/Mobile_device
https://en.wikipedia.org/wiki/Smartphone
https://en.wikipedia.org/wiki/Internet
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The touchscreen display is operated by gestures executed by finger or digital pen (stylus), instead of 
the mouse, trackpad, and keyboard of larger computers. Portable 

computers can be classified according to the presence and 
appearance of physical keyboards. Two species of tablet, the 
slate and booklet, do not have physical keyboards and 
usually accept text and other input by use of a virtual 
keyboard shown on their touchscreen displays. To 
compensate for their lack of a physical keyboard, most 
tablets can connect to independent physical keyboards by 
wireless Bluetooth or USB; 2-in-1 PCs have keyboards, 

distinct from tablets (Wikipedia, 2019). 

DESKTOPS AND ALL-IN-ONES 

A desktop computer is a personal computer designed for regular 
use at a single location on or near a desk  or table due to its size 
and power requirements.  The most common configuration has a 
case that houses the power supply, motherboard, memory, and 
disk storage. The desktop uses a keyboard and a mouse as input 
devices.  The output devices are the monitor, speakers and printer.  
The case may sit horizontally or vertically and placed either 
underneath, beside or on top of the desk.   

Another type of desktop is called an all-in-one. An all-in-one does 
not contain a tower.  The same case is used to house the display and processing units.  

SERVER 

A server is a computer program or device that provides a 
service to another computer program and its user, also 
known as the client. In a data center, the physical 
computer that a server program runs on is also frequently 
referred to as a server. That machine may be a dedicated 
server, or it may be used for other purposes as well. A 
server can support from two to several thousand 
connected computers and devices at the same time. 
Servers are available in a variety of sizes and types for 
both small and large business applications.  

MOBILE AND GAME DEVICES 
A mobile device is a computing device small enough to hold in 
your hand.  Because of their reduced size, the screens on 
mobile devices are small (often between 3 and 5 
inches).  Some mobile devices are Internet capable, meaning 
that they can connect to the Internet wirelessly.  You often can 
exchange information between the Internet and a mobile 
device or between a computer or network and a mobile device.  
Popular types of mobile devices are smart-phones, digital 
cameras, portable and digital media players, e-book readers, 
and wearable devices.  

Mobile devices can be categorized as 
computers if they operate under the 
control of instructions stored in their 
own memory; can accept data; process 
the data according to specified rules; 
produce or display information; and 
store the information for future use.  
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SMARTPHONES 

A smartphone is an Internet-capable phone that usually also includes a calendar, an address book, a 
calculator, a notepad, games, and several other apps (which are programs on the smartphone). Other 
apps are available through an app store that typically is associated with the phone. Smartphones and 

basic phones are two categories of cell phones 
that are available on the market. The term basic 
phone was created to distinguish the phone from 
a smartphone. ... Smartphone is a mobile phone 
that operates on an operating system, like a mini 
computer. Smartphones are basically that – a 
mini computer. 

Many smartphones have touch screens. Instead 
of or in addition to a touch screen, some 
smartphones have a keyboard that slides in and 
out from behind the phone.  Others have built-in 
mini keyboards or keypads that contain both 
numbers and letters.  Some are called a phablet 

because they combine the features of a smartphone with a tablet.  

Instead of calling someone’s phone to talk, you can send messages to others by pressing images 
on an on-screen keyboard on the phone, keys on the phone’s mini keyboard, or buttons on the 
phone’s keypad.   

WEARABLE DEVICES 
Wearable technology, wearables, fashionable technology, wearable devices, tech togs, or fashion 
electronics are smart electronic devices (electronic device with micro-controllers) that can be incorporated 
into clothing or worn on the body as implants or accessories. 

Wearable devices such as activity trackers are an 
example of the Internet of Things, since "things" such 
as electronics, software, sensors, and connectivity 
are effectors that enable objects to exchange data 
through the internet with a manufacturer, operator, 
and/or other connected devices, without requiring 
human intervention. 

Wearable technology has a variety of applications which grows as the field itself expands. It appears 
prominently in consumer electronics with the popularization of the smartwatch and activity tracker. Apart 
from commercial uses, wearable technology is being incorporated into navigation systems, advanced 
textiles, and healthcare. 

GAME DEVICES 
Gaming is yet another area with a strong presence on the market for mobile devices. At the lower end are 
simple devices for small children. These are programmed with one game or just a few games. At the high 
end are sophisticated systems with the ability to load games and with internet connectivity. They have 
rich multimedia and enable multiple players to be linked together.  
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A game console is a mobile computing device designed for single-player or multiplayer video games. 
Gamers often connect the game console to a television so that they can view their gameplay on the 
television’s screen. Many game console models are Internet capable and allow you to listen to music and 
watch movies or view photos.  Typically weighing between three and eleven pounds, the compact size of 
game consoles makes them easy to use at home, in the car, in a 
hotel, or any location that has an electrical outlet and a television 
screen.  

Gaming devices provide a variety of interesting activities and ways 
for young people to engage with their friends and families. 

However, it is important to be aware of what these devices can do 
and how you can talk with your child to help them to use this 
technology in safe and positive way. 

All modern gaming devices offer parental controls to help you manage how your child uses their device, 
but these do need to be set up for them to be operational. 

OPERATING SYSTEMS 

An operating system (OS) is the software that controls a computer's hardware and peripheral devices and 
allows other programs to function. Early computers did not have disk drives but were hard-wired to carry 
out specific computations. Later, computers were able to store instructions loaded into the computer's 
memory using punch cards and later magnetic tapes. Computer memory space was limited and when the 
instructions to control a computer were moved onto a disk drive, such as a floppy disk or internal hard 
drive, it was considered cutting-edge technology. Today, any modern operating system would be 
considered a disk operating system (Rouse & Cobb, 2016). 

Disk operating system is also used to describe several very 
similar command line disk operating systems. PC-
DOS (Personal Computer Disk Operating System) was the first 
widely-installed disk operating system. It was developed for 
IBM by Microsoft Corporation, which also produced its own 
almost identical version called MS-DOS.  

The early operating systems did not multitask, as they were 
only able to run one program at a time. The command line 
interface, in which a user has to type in commands, required 

the user to remember commands to run programs or do other operating system tasks, making it difficult 
for novices to use. For example, typing the command "cd \directory_name" changed the current working 
directory to the named directory and typing the command "dir" listed the files in the current directory. 

When Microsoft first introduced Windows as a graphical user interface (GUI) for MS-DOS, early users had 
to type "WIN" at the DOS prompt to launch the Windows program. Windows has since evolved from being 
a GUI program running under DOS to a full operating system taking over as the default OS, though it was 
not until Windows XP that consumer versions of Windows stopped relying on the DOS program win.com 
to bootstrap the Windows kernel. 

The last retail version of MS-DOS was MS-DOS 6.22. After this release, MS-DOS was still bundled as 
part of Windows, but no longer required a separate license. It can still be run under Windows using the 

https://whatis.techtarget.com/definition/operating-system-OS
https://searchnetworking.techtarget.com/definition/hardware
https://searchmobilecomputing.techtarget.com/definition/peripheral
https://whatis.techtarget.com/definition/instruction
https://whatis.techtarget.com/reference/History-of-the-punch-card
https://searchdatabackup.techtarget.com/definition/magnetic-tape
https://searchstorage.techtarget.com/definition/RAM-random-access-memory
https://searchstorage.techtarget.com/definition/diskette
https://searchmobilecomputing.techtarget.com/definition/PC-DOS
https://searchmobilecomputing.techtarget.com/definition/PC-DOS
https://whatis.techtarget.com/definition/multitasking
https://searchwindowsserver.techtarget.com/definition/command-line-interface-CLI
https://searchwindowsserver.techtarget.com/definition/command-line-interface-CLI
https://searchwindowsserver.techtarget.com/definition/Windows
https://searchwindevelopment.techtarget.com/definition/GUI
https://searchenterprisedesktop.techtarget.com/definition/Windows-XP
https://whatis.techtarget.com/definition/bootstrap
https://searchdatacenter.techtarget.com/definition/kernel
https://searchcio.techtarget.com/definition/software-license
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Command Prompt program. There is an open source version of DOS called FreeDOS which is based on 
and compatible with MS-DOS. 

Note: The acronym DoS with a lowercase O is short for Denial of Service, a method of attacking a 
networked computer by sending it an abnormally high number of requests in order to exhaust its 
resources so that genuine users cannot gain access. 

MACINTOSH OPERATING SYSTEMS 
The family of Macintosh operating systems developed by Apple Inc. includes the graphical user interface-
based operating systems it has designed for use with its Macintosh series of personal computers since 
1984, as well as the related system software it once created for compatible third-party systems 
(Wikipedia, 2019). 

In 1984, Apple debuted the operating system that is now known as the "Classic" Mac OS with its release 
of the original Macintosh System Software. The system, rebranded "Mac OS" in 1996, was preinstalled on 
every Macintosh until 2002 and offered on Macintosh clones for a short time in the 1990s.  

The current Mac operating system is macOS, originally named "Mac OS X" until 2012 and then "OS X" 
until 2016. Developed between 1997 and 2001 after Apple's purchase of NeXT, Mac OS X brought an 
entirely new architecture based on NeXTSTEP, a Unix system, that eliminated many of the technical 
challenges that the classic Mac OS faced.  

Prior to the introduction of Mac OS X, Apple experimented with several other concepts, releasing different 
products designed to bring the 
Macintosh interface or applications to 
Unix-like systems or vice versa, 
A/UX, MAE, and MkLinux. Apple's 
effort to expand upon and develop a 
replacement for its classic Mac OS in 
the 1990s led to a few cancelled 
projects, code named Star Trek, 
Taligent, and Copland. 

Although they have different 
architectures, the Macintosh 
operating systems share a common 
set of GUI principles, including a 
menu bar across the top of the screen; the Finder shell, featuring a desktop metaphor that represents 
files and applications using icons and relates concepts like directories and file deletion to real-world 
objects like folders and a trash can; and overlapping windows for multitasking. 

CREATING FOLDERS & UNZIPPING FILES 
Folders on a computer function much like folders in a file cabinet: they help organize information and 
documents into folders that can be organized in a variety of ways.  An example of how one might 
organize information is chapters in a cookbook.  Rather than have all recipes printed alphabetically, they 
are usually grouped into subject areas such as meat dishes, vegetable dishes, casseroles, salads, cakes 
and cookies. 

https://searchsecurity.techtarget.com/definition/denial-of-service
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You may find that the cakes and cookies section is subdivided into cakes and cookies.  The cookies 
section may be subdivided into drop cookies, rolled cookies and bar cookies.  Doing this makes finding 
one specific type of recipe much faster and easier.   

You have practiced creating, renaming and deleting folders.  Now it is time to put what you did into action 
for this class.  You will create folders for the student lab files and PowerPoint documents that have been 
provided to you, as well as folders where to save the documents you create as you do lab exercises. 

RETRIEVE LESSON FILES FROM THE ONLINE COURSE ROOM 
Step 1. Review the video “How to Unzip a Folder in Canvas”. This will give you step 

by step illustrations on how to do this when it is necessary. I have tried to place all 
the files you need in the zipped folder; however, occasionally there may be a file 
that needs to be downloaded separately. The process used is always the same. The 
video explains this in detail. 

Step 2. Double click on the CIS 210 Units folder. You may note there are 16 folders in 
this folder. Each folder contains file for the chapters in the book you will be 
working on for the units. You need these files for the various lessons you will 
be 
completing in the class. 

THE UNITS FOLDERS 

Step 1. The unit folders are named with the following naming convention: 

 u01a1 
 u02a1 
 u03a1 
 … u16a1 

Step 2. Most of the folders contain the 
student lesson files for that unit. If 
the particular unit does not have any files in it, do not worry you will be 
filling it with a file. That is the plan. You should be using these folders 
as you work on each assignment. If you save the files for each unit in the 
appropriate unit folder, it will make it much easier on you to find lessons 
you have completed. 

CAPTURE YOUR SCREEN - WINDOWS 
The following instructions are for capturing your screen to prove you have done the activity. 
For 

this assignment, you will be submitting a copy of the file structure you have 
created. I need to see the CIS Unit folders and the CIS 210 Student File Folders. 

Step 1. Open a blank Word document and save it as u01a1-2 
Screen shot File Folders Step 2. Using your Snipping Tool 

• u = unit 
• 01 = unit number 
• a = assignment 
• 1= first assignment for the unit. 
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i. To open Snipping Tool, type Snipping Tool in the search box on 
the taskbar, and then select 
Snipping Tool. 

ii. To take a screenshot with 
Snipping Tool, select 
New, and then select the 
part of the screen that 
you want to capture. 
Choose from freeform, 
rectangular, window, or 
full-screen snips by 
selecting the arrow on the 
New button. 

Step 3. Show a view of your folders – Your textbook has detailed 
instructions on pages OFF 31-33 on how to view these folders. Once you 
have a good view of the folders, I want you to use your snipping tool to 
capture that screen. 

Step 4. Copy your Screen Capture – With your 
captured screen now on your snipping tool, click 
Edit copy. 

Step 5. Navigate to your Word document. Notice 
on the Home ribbon band the word Paste is now 
dark click on it. This will paste a screen copy of the 
folders you have created. 

Step 6. Save Your u01a1-2 Screen Shot File 
Folders file again and upload it to Canvas in 
the assignment area for u01a1. 

CAPTURE YOUR SCREEN – MACINTOSH (OS X) 
HOW TO TAKE A SCREENSHOT OF YOUR ENTIRE SCREEN  

Step 1. Press Shift-Command (⌘)-3.  
Step 2. Find the screenshot as a .png file on your desktop.  

HOW TO TAKE A SCREENSHOT OF A SELECTED PORTION OF YOUR SCREEN  
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Step 1. Press Shift-Command-4. The pointer changes to a 
crosshair. 

Step 2. Move the crosshair to where you want to start the 
screenshot, then drag to select an area. While dragging, you can 
hold Shift, Option, or Space bar to change the way the selection 
moves. 

Step 3. When you've selected the area you want, release your 
mouse or trackpad button. To cancel, press the Esc (Escape) 
key before you release the button.  

Step 4. Find the screenshot as a .png file on your desktop.  

HOW TO TAKE A SCREENSHOT OF A WINDOW  

Step 1. Press Shift-Command-4. The pointer changes to 
a crosshair.  
Step 2. Press the Space bar. The pointer changes to a 
camera. 
Step 3. Move the camera over a window to highlight it. 
Step 4. Click your mouse or trackpad. To cancel, press 
the Esc (Escape) key before you click.  
Step 5. Find the screenshot as a .png file on your 
desktop. 

This works with windows in the Finder and most apps.  

HOW TO TAKE A SCREENSHOT OF A MENU  

Step 1. Click the menu to reveal its contents. 
Step 2. Press Shift-Command-4. The pointer changes to a crosshair. 
Step 3. Drag to select the menu. 
Step 4. Release your mouse or trackpad button. To cancel, press the Escape (esc) key before 

you release the button. 
Step 5. Find the screenshot as a .png file on your desktop.  

These steps capture the contents of a menu, but not its title:  

Step 1. Click the menu to reveal its contents. 
Step 2. Press Shift-Command-4. The pointer changes to a crosshair. 
Step 3. Press the Space bar. The pointer changes to a camera. 
Step 4. Move the camera over the menu to highlight it. 
Step 5. Click your mouse or trackpad. To cancel, press the Esc (Escape) key before you click. 
Step 6. Find the screenshot as a .png file on your desktop. 
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UNIT 1 QUIZ – STUDY GUIDE 

TRUE/FALSE 
1. Electronic components in computers process data using instructions, which are the 

steps that tell the computer how to perform a task 

2. An all-in-one contains a separate tower. 

3. Smartphones typically communicate wirelessly with other devices or computers. 

4. Data conveys meaning to users, and information is a collection of un processed 
items, which can include text, numbers, images, audio, and video. 

5. The terms, web and Internet, are interchangeable. 

6. One way to protect your computer from malware is to scan any removable media 
before using it. 

7. Operating systems are a widely recognized example of system software. 

8. A headset is a type of input device. 

9. A scanner is a light-sensing output device. 

10. Although some forms of memory are permanent, most memory keeps data and 
instructions temporarily, meaning its contents are erased when the computer is turned off. 

11. A solid-state drive contains one or more inflexible, circular platters that use magnetic 
particles to store data, instructions, and information. 

12. You usually do not need to install web apps before you run them.  

 

MULTIPLE CHOICE 

13. Operating systems are a widely recognized example of system software. 

a. Storage 
b. Solid-state drives 
c. Cloud Storage 

14. ___________ is an Internet service that provides remote storage to computer users. 

a. Cloud storage 
b. Smart TV 
c. Bluetooth 
d. Solid-state drive (SSD) 
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15. A computer that delivers requested webpages to your computer or mobile device is a(n) 
___ _. 

a. FTP device 
b. VoIP computer 
c. Web server 
d. Hard drive 

16. A ________ is software that enables users with an Internet connection to access and view 
webpages on a computer or mobile device. 

a. Search Engine 
b. Wiki 
c. Digital media player 
d. Browser 

17. A(n) ____ is any hardware component that allows you to enter data and instructions into 
a computer or mobile device. 

a. Output device 
b. Display 
c. Communications device 
d. Input device 

 
18. Which of the following is not an example of an output device? 

a. Display 
b. Speaker 
c. Printer 
d. Scanner 

19. ____ consists of electronic components that store instructions waiting to be executed and 
the data needed by those instructions. 

a. Memory 
b. Storage 
c. Solid-state drives 
d. Cloud Storage 

20. ____ is an Internet service that provides remote storage to computer users. 

a. Cloud storage 
b. Smart TV 
c. Bluetooth 
d. Solid-state drive (SSD) 
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21. _____ uses short-range radio signals to enable computers and devices to communicate 
with each other. 

a. Wi-Fi 
b. A hot spot 
c. Cellular radio 
d. Bluetooth 

22. A(n) ______ is a collaborative website that allows users to create, add to, modify, or 
delete the content via their browser. 

a. Podcast 
b. Blog 
c. Wiki 
d. Online social network 

MATCHING 
Match the following terms with the correct definition: 

1. All-in-one 
2. Server 
3. Phablet 
4. Digital device Convergence 
5. Touchpad 
6. Storage Device 
7. Solid-state Drive 
8. File 
9. Software 
10. Operating System 

Definitions 

A. Term that describes the trend of computers and devices with technologies that overlap 
B. Mobile device that combines features of a smartphone and a tablet. 
C. Storage device that typically uses flash memory to store data, instructions, and information. 
D. Small, flat, rectangular pointing device that is sensitive to pressure and motion. 
E. Set of programs that coordinates all the activities among computer or mobile device hardware.  
F. Named collection of stored data, instructions, or information 
G. Type of desktop computer that does not contain a tower and instead uses the same case to 

house the display and the processing circuitry 
H. Series of related instructions, organized for a common purpose, that tells the computer what 

tasks to perform and how to perform them 
I. Computer that is dedicated to providing one or more services to other computers or devices on a 

network. 
J. Component that records and/or retrieves items to and from storage media.  
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UNIT 2 – DIGITAL SECURITY RISKS 

A digital security risk is an event or action that could cause a loss of or 
damage to computer or mobile device hardware, software, data, 
information or processing capability.  The more common digital security 
risks include Internet and network attacks, unauthorized access and use, 
hardware theft, software theft, information theft, and system failure.  

Some breaches to digital security are accidental, many or intentional.  
Some intruders do not disrupt a computer or device’s functionality; they 
merely access data, information, or programs on the computer or mobile 
device before signing out. Other intruders indicate some evidence of their 
presence either by leaving a message or by deliberately altering or 
damaging data.  

RISK MANAGEMENT 
Risk management occurs everywhere in the financial world. It occurs when an investor buys low-risk 
government bonds over riskier corporate bonds, when a fund manager hedges his currency exposure 
with currency derivatives, and when a bank performs a credit check on an individual before issuing a 
personal line of credit.  Stockbrokers use financial instruments like options and futures, and money 
managers use strategies like portfolio and investment diversification to mitigate or effectively manage risk. 

 Inadequate risk management can result in severe consequences for companies, 
individuals, and for the economy. For example, the subprime mortgage meltdown 
in 2007 that helped trigger the Great Recession stemmed from poor risk-
management decisions, such as lenders who extended mortgages to individuals 
with poor credit, investment firms who bought, packaged, and resold these 
mortgages, and funds that invested excessively in the repackaged, but still risky, 
mortgage-backed securities (MBS) (Kenton, 2018). 

CYBER CRIME 
The National Computer Security Survey (NCSS) documents the nature, prevalence, and impact of cyber 
intrusions against businesses in the United States. It examines three general types of cybercrime: 

 Cyber-attacks are crimes in which the computer system is the target. Cyber-attacks consist of 
computer viruses (including worms and Trojan horses), denial of service attacks, and electronic 
vandalism or sabotage. 

 Cyber theft comprises crimes in which a computer is used to steal money or other things of value. 
Cyber theft includes embezzlement, fraud, theft of intellectual property, and theft of personal or 
financial data. 

 Other computer security incidents encompass spyware, adware, hacking, phishing, spoofing, 
pinging, port scanning, and theft of other information, regardless of whether the breach was 
successful 

CYBER-TERRORIST 
A Cyber-terrorist is a criminal who uses computer technology and the Internet, especially to cause fear 
and disruption.  Some cyber-terrorists spread computer viruses, and others threaten people electronically.  

https://www.investopedia.com/terms/s/subprime-meltdown.asp
https://www.investopedia.com/terms/s/subprime-meltdown.asp
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 Spyware - The Dangers of Spyware. Spyware is software 
that is downloaded onto your computer to track your 
activities without your knowledge. ... Most of the time 
spyware is used to monitor your internet surfing habits, and 
this information is used in conjunction with adware to target 
specific advertisements to your tastes. 

 Cryptocurrency mining - Cyber criminals are using tools to 
perform cryptocurrency mining in the background 
unbeknownst to a user, essentially a form of malware that 
eats up bandwidth and poses security risks. 

 Supply chain compromises - Not only are software supply chains at risk, but hardware supply 
chains are as well. Because cloud objects can also be unexpected entry vectors, supply chain 
attacks have become a broad category of threat. 

 Adware -- Adware is the name given to programs that are designed to display advertisements on 
your computer, redirect your search requests to advertising websites and collect marketing-type 
data about you – for example, the types of websites that you visit – so that customized adverts 
can be displayed. 

 Hacking – Hacking is identifying weakness in computer systems or networks to exploit its 
weaknesses to gain access. Example of Hacking: Using password cracking algorithm to gain 
access to a system 

 Phishing – Phishing is when a scammer uses fraudulent emails or texts, or copycat websites to 
get you to share valuable personal information – such as account numbers, Social Security 
numbers, or your login IDs and passwords. Scammers use your information to steal your money 
or your identity or both (Office of Justice Programs, 2019). 

 Spoofing -- For scammers, spoofing is a tool for getting information or bypassing call blockers. 
Typically, scammers use spoofing to pose as a bank, business, or government agency to trick 
people into giving up personal or financial information. According to the IRS, scammers posing as 
tax collectors snagged about $26.5 million from people using spoofed phone numbers. 

 Pinging -- The Ping utility is an online free tool that help you to verify if a domain/server is 
operating and network accessible. This Ping tool uses the Internet Control Message Protocol 
(ICMP) Echo function as detailed in RFC 792. A small packet will be sent through the network to a 
given IP address (IPv4) or host name. This packet contains 64 bytes - 56 data bytes and 8 bytes 
of protocol reader information. The device that sent the packet then waits and listens for a return 
packet. If the connections are good and the target domain/server is up, a good return packet will 
be received. Ping can also tell the user the number of hops between two targets and the amount 
of time it takes for a packet to make the complete trip. In addition, this tool can also be used to 
resolve the host name to an IP address. Instead of entering the IP address, you can enter the host 
name for pinging. 

 Port Scanning – A port scanner is an application designed to probe a server or host for open 
ports. Such an application may be used by administrators to verify security policies of their 
networks and by attackers to identify network services running on a host and exploit 
vulnerabilities. 

Summary of Findings 

 67% detected at least one cybercrime. 
 Nearly 60% detected one or more types of cyber-attack. 

https://www.wired.com/2017/03/phone-companies-will-soon-no-excuse-not-blocking-robocalls/
https://www.wired.com/2017/03/phone-companies-will-soon-no-excuse-not-blocking-robocalls/
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 11% detected cyber theft. 
 24% detected other computer security incidents. 
 Most businesses did not report cyber-attacks to law enforcement authorities. 
 The majority of victimized businesses (86%) detected multiple incidents, with half of these (43%) 

detecting 10 or more incidents during the year. 
 Approximately 68% of the victims of cyber theft sustained monetary loss of $10,000 or more. By 

comparison, 34% of the businesses detecting cyber-attacks and 31% of businesses detecting 
other computer security incidents lost more than $10,000. 

 System downtime lasted between 1 and 24 hours for half of the businesses and more than 24 
hours for a third of businesses detecting cyber-attacks or other computer security incidents 
(Office of Justice Programs, 2019). 

PASSWORDS 
Some websites and companies force us to use complex passwords that are a minimum length or contain 
uppercase characters, numbers, and even special characters (!, @, #, etc). Why are such complicated, 
hard-to-remember passwords important?  

WHY USE PASSWORDS AT ALL? 

With so many details of our life now being stored or managed online, using strong passwords is more 
important than ever! It's all too easy to go about your online life without ever thinking twice about using 
secure passwords, or maybe you find passwords to be a nuisance. It can happen, though. Imagine if a 
hacker was to gain access to your: 

• Email account to monitor your personal communications 
• Online banking account to make transfers or view account numbers 
• Facebook, Twitter, etc. to post negative or defamatory comments to your friends. 
• Online shopping account to make purchases with your saved credit card numbers 
• Online file storage to access or delete your personal information. 
• Remote business connection to spread viruses through your company network 

HOW TO CREATE A STRONG PASSWORD 

Creating a strong password can be broken down into two requirements: 

1. PASSWORD LENGTH - We recommend a minimum of 8 characters. This is the absolute, most 
important consideration for creating a strong password. For example, assuming you followed the 
rest of the recommendations below, the time a computer would need to guess a password 
containing only 6 characters is 52 seconds. Increase that to 8 characters and now you're looking 
at 3 days. Add another 2 characters (up to 10 now) and a hacker would need to spend about 58 
years. 

2. PASSWORD COMPLEXITY - We recommend using all 4 types of complex characters. A 
complex password doesn't mean it has to be a random bunch of characters. Complexity means 
that a password uses more than just lowercase characters. Ideally, you want your password to 
contain at least one of each of the following: lowercase letters, uppercase letters, numbers, and 
special characters (!, @, #, etc). A 10-letter long, all lowercase password that might take a 
computer 9 hours to guess is boosted to 14 years by simply using 1 uppercase letter and 1 
special character instead. 



  

~ 15 ~ 

 

These passwords should be treated like the keys to your home. It can certainly be difficult to remember a 
different, super-complex password for all of the different things you use. Try some of these tips to create 
strong passwords that you can actually remember (Hurt, 2012). 

HOW TO REMEMBER A STRONG PASSWORD 

Use sentences instead of single words. Use something easy for you to remember and has some kind of 
personal significance. 

1. Start with an easy-to-remember phrase — For example: Diamonds are a girls best friend 
2. Remove the spaces and shorten the words — DiamondsRgbf! 
3. Change some letters into numbers or special characters — Di@m0ndsRgbf! 

USE A PASSPHRASE. A passphrase can be abbreviations or initials of a longer phrase, such as a 
favorite song. For example, "My baloney has a first name, it's OSCAR!" could become "Mbhafn,IO!" 

USE A PASSWORD MANAGER. A password manager is a software program that can store your 
various user names and passwords for many different websites and computers. This way, you can use 
more complex passwords without fear of forgetting them. Of course, they're all protected by your one, 
primary password, so make sure that's a good one!  

IS YOUR PASSWORD HACKER-PROOF? 

Here are a couple of great websites to test your password to see how long it would take a computer to 
crack your password by simply guessing every possible variation. 

1. https://howsecureismypassword.net/— Try clicking the "Show Details" and "Show Settings" links 
for more details. 

2. https://www.grc.com/haystack.htm/— This one shows you online attack scenarios as well. 

 
UNIT 2 QUIZ – STUDY GUIDE 

TRUE/FALSE QUESTIONS 
1. Any illegal act involving the use of a computer or related devices generally is referred to as a 

crimeware. 
2. A rootkit displays an outline advertisement in a banner or pop-up window on webpages, email, or 

other Internet services. 
3. Viruses, worms, and other malware can be hidden in downloaded game files and mobile apps. 
4. An audit trail records in a file both successful and unsuccessful access attempts. 
5. It is good practice to change your passwords frequently. 
6. Intentionally erasing software would be considered software theft. 
7. A typical license agreement allows you to rent or lease the software. 
8. Unencrypted readable data is called ciphertext. 
9. Private key encryption is also called asymmetric key encryption. 
10. VPNs encrypt data to help ensure that the data is safe from being intercepted by unauthorized 

people. 
11. When data is traveling to or from a computer to a cloud service, it is subject to interception. 
12. A good practice to secure your wireless network is to immediately broadcast the SSID. 

https://howsecureismypassword.net/
https://www.grc.com/haystack.htm/
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MULTIPLE CHOICE 
13. A   is someone who demands payment to stop an attack on an organization’s technology 

infrastructure. 
a. Cyberextortionist 
b. Script kiddie 
c. Cracker 
d. Cyberterrorist 

14.    Is a program that hides in a computer or mobile device and allows someone from a 
remote location to take full control of the computer or device. 

a. Spyware 
b. A trojan horse 
c. A rootkit 
d. Adware 

15. A   is a program or set of instructions in a program that allows users to bypass security 
controls when accessing a program, computer, or network. 

a. Session cookie 
b. Botnet 
c. Back door 
d. Zombie 

16. An employee using an organization’s computer to send personal email messages might be an 
example of  . 

a. Unauthorized access and use 
b. Hardware vandalism 
c. Cybercrime 
d. Intellectual property rights violation 

17. A   is a private combination of words, often up to 100 characters in length and containing 
mixed capitalization and punctuation, associated with a user name that allows access to certain 
computer resources. 

a. Private key 
b. Passphrase 
c. Passcode 
d. Encryption algorithm 

18. A(n)   is a set of characters that the originator of the data uses to encrypt the text and the 
recipient of the data use to decrypt the text. 

a. Plaintext 
b. Public key 
c. Encryption key 
d. Cipher 

19. A(n)   backup method is the only real-time back up, providing very fast recovery of data. 
a. Continuous data protection 
b. Full 
c. Selective 
d. Incremental 

20. Online shopping websites generally use a    to keep track of items in a user’s 
shopping cart. 

a. Location sharing algorithm 
b. Phishing filter 
c. Keygen 
d. Session cookie 

MATCHING 
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Match the terms with their definitions: 

21. Script kiddie    
22. Zombie     
23. Bot     
24. Spoofing    
25. Access Control    
26. Keygen     
27. Digital certificate    
28. Technology ethics   
29. Digital rights management   
30. Cookie     

a. Compromised computer or device whose owner is unaware the computer or device is 
being controlled remotely by an outsider. 

b. Technique intruders use to make their network or Internet transmission appear legitimate 
to a victim computer or network. 

c. Program that performs a repetitive task on a network. 
d. Small text file that a web server stores on your computer 
e. Notice that guarantees a user or website is legitimate 
f. Strategy designed to prevent illegal distribution of movies, music, and other digital 

content. 
g. Program that creates software registration numbers and sometimes activation codes. 
h. Hacker who does not have the technical skills and knowledge of a cracker 
i. Security measure that defines who can access a computer, device, or network; when 

they can access it; and what actions they can take while accessing it. 
j. Moral guidelines that govern the use of computers, mobile devices, information systems, 

and related technologies.  

 

MICROSOFT OFFICE SUITE 
Office 365 is a subscription that comes with premium apps like Word, Excel, PowerPoint, OneNote, 
Outlook, Publisher, and Access (Publisher and Access available on PC only). The apps can be 
installed on multiple devices, including PCs, Macs, iPads, iPhones, Android tablets, and Android 
phones. 

The prices and the services for the applications available vary depending on the package you have 
purchased.  This is a link to the current retail pricing for home and business users: 
https://www.microsoft.com/en-us/microsoft-365/buy/compare-all-microsoft-365-products?tab=1  

MS WORD – This is a full featured word processing program that allows you to create 
professional-looking documents and revise them easily. 

• MS POWERPOINT – PowerPoint is a presentation program that enables you to produce 
professional-looking presentations and then deliver them to an audience. 

• MS EXCEL– Excel is a powerful spreadsheet program that allows you to organize data, 
complete calculations, make decisions, graph data, develop professional-looking reports, 
publish organized data to the web, and access real-time data from websites. 

• MS ACCESS (PC Only)—Access is a database management system that enables your to 
create a database; add, change, and delete data in the database; ask questions concerning the data 
in the database; and create forms and reports using the data in the database. 

• MS OUTLOOK—Outlook is a communications and scheduling program that allows you to 
manage emails accounts, calendars, contacts, and access to other Internet content. 

https://www.microsoft.com/en-us/microsoft-365/buy/compare-all-microsoft-365-products?tab=1
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• MS PUBLISHER (PC Only)—Publisher is a desktop publishing program that helps you 
create professional-quality publications and marketing materials that can be shared easily. 

• MS ONENOTE—OneNote is a note taking application that allows you to store and share 
information in notebooks with other people. 

• SHAREPOINT WORKSPACE—SharePoint is a collaboration application that allows you 
to access and revise files stored on your computer from other locations. 

• TEAMS-- Get your team on the same page with group chat, online meetings, calling, and web 
conferencing. Collaborate on files with built-in Office 365 apps like Word, Excel, PowerPoint, 
and SharePoint. 

• EXCHANGE -- A Microsoft Exchange account is a work or school email account. The 
organization that gave you the Exchange email account is running a Microsoft Exchange Server, 
or is using Microsoft Office 365 which uses Exchange Server to provide email. When you use an 
Exchange account, your email messages are delivered to and saved in your mailbox on the 
Exchange server. Your contacts and calendar are saved there, too. When your business or school 
sets up their Exchange server, they choose what method your Exchange account uses to access 
email on the server. This will determine how your email works. 

• ONE DRIVE -- OneDrive is Microsoft's storage service for hosting files in the "cloud." It is 
available for free to all the owners of a Microsoft account. OneDrive offers users a simple way to 
store, sync and share various types of files, with other people and devices on the internet. 
Windows 10, Windows 8.1, and Xbox One use OneDrive to synchronize system settings, visual 
customization, themes, app settings, and even Microsoft Edge's tabs, browsing history and saved 
passwords. 

TABLE OFFICE SUITES 
APPS 
LICENSES 

OFFICE 365 
FAMILY 

OFFICE 365 
PERSONAL 

OFFICE 
HOME & 
STUDENT 

OFFICE 365 
BUSINESS 
STANDARD 

OFFICE 365 
PREMIUM 

OFFICE 365 
APPS 

Word      Web Only 

PowerPoint      Web Only 
Excel      Web Only 

Access      PC Only 

Outlook      Web Only 
Publisher       PC Only 

OneNote       
Teams       

Services One Drive, 
Skype 

One Drive, 
Skype 

One Drive, 
Skype 

One Drive, 
Exchange, 
Share Point 

One Drive 
Skype 

Exchange 
Share Point 

Intune 
Azure 

One Drive 

Licenses 6 1 1 5 5 1 user 
 

MS WORD 
The MS Office Applications are set with similar features.  We will start out introduction with the word 
processing application (MS Word) this should give you a foundation to learn how the applications are 
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designed.  When you click on the Word icon you may see a screen that contains all or some of the 
following components: 

 

 

Step 1. Click New (Choose Blank Document) – The next screen you see will contain 
a blank document.  this screen contains the following components: 

 

The Word window consists of a variety of components to make your work more efficient and documents 
more professional.  These include the document window, ribbon, mini toolbar, shortcut menus, Quick 
Access Toolbar, and Microsoft Account area.  Most of these components are common to other Microsoft 
Office applications; others are unique to Word.   

SCROLL BARS  

A scroll bar is used to display different portions of a document in the document window.  At the right 
edge of the document window is a vertical scroll bar.  If a document is too wide to fit in the document 
window, a horizontal scroll bar also appears at the bottom of the document window.  On a scroll bar, 
the position of the scroll box reflects the location of the portion of the document that is displayed in 
the document window. 

  

A. Title Bar  
B. Help Button 
C. Maximize Button 
D. Close Button 
E. Blank Document 
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STATUS BAR 

The status bar is located at the bottom of the document window displays the status of certain 
commands and keys; it also provides controls for viewing the document.  As you type text or perform 
certain tasks, various indicators and buttons may appear on the status bar.  

 

 

 

 

RIBBON 

The ribbon located near the top of the window below the title bar is the control center in Word and 
other Office Apps.  The ribbon provides easy, central access to the tasks you perform while creating a 
document.  The ribbon consists of tabs groups, and commands.  Each tab contains a collection of 
groups, and each group contains related commands.  When you run an Office app, such as Word, it 
initially displays seral main tables, also called default or top-level tabs.  All Office apps have a HOME 
tab, which contains the more frequently used commands.  

CONTEXTUAL TABS  

In addition to the main tabs, the Office apps display tool tabs, also called contextual tabs, when 
you perform certain tasks or work with objects such as picture or tables. it you insert a picture in a 
Word document, for example, the PICTURE TOOLS tab and its related subordinate FORMAT tab 
appear, collectively referred to as the PICTURE TOOLS FORMAT tab.  When you are finished 
working with the picture, the PICTURE TOOLS FORMAT tab disappears from the ribbon.  Word 
and other Office apps determine when tool tabs should appear and disappear based on tasks you 
perform.  Some tool tabs such as the TABLE TOOLS tab, have more than one related 
subordinate tab.  

  

Views Available Current Position on the page Additional Details Quick Zoom 

Ribbon Arrow Main tabs In-ribbon gallery 

Gallery 
scroll 

More button Groups 
button 
 

PICTURES TOOLS, DRAWING TOOLS 
Contextual tabs for pictures and shapes 
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GROUP PROJECT - REPORT 

The style of reports should be concise, giving precise detail. Flowery language should not be used. Data 
may be presented as charts, graphs, or 
tables, if appropriate. 

Descriptions of methodology should be 
sufficiently clear and detailed to allow 
someone else to replicate them exactly. 

USING THE PASSIVE VOICE 

Scientific reports tend to be written in what is 
called the passive voice, which is more formal. For example, “The experiment would have been better if 
….”, rather than “I could have improved the experiment by ….”. Similarly, “It is recommended that….” 
rather than “I recommend….”. This is because a scientific report is intended to be objective and based on 
the analysis of data, rather than subjective and based on personal views and opinions. 

However, many leading scientists (including the Astronomer Royal, Sir Martin Rees) are encouraging a 
return to the active voice where appropriate. If you are unsure about this, you should ask your tutor. 

To make the group assignment easier for this unit, I have listed some basic MLA report formatting 
techniques.  You should refer to these techniques while creating your group report.  The same techniques 
will be reviewed in detail for Unit 3.  

MS WORD MLA GENERAL GUIDELINES 
MLA style specifies guidelines for formatting manuscripts and using the English language in writing. MLA 
style also provides writers with a system for referencing their sources through parenthetical citation in 
their essays and Works Cited pages. 

Writers who properly use MLA also build their credibility by demonstrating accountability to their source 
material. Most importantly, the use of MLA style can protect writers from accusations of plagiarism, which 
is the purposeful or accidental uncredited use of source material by other writers. 

If you are asked to use MLA format, be sure to consult the MLA Handbook (8th edition). Publishing 
scholars and graduate students should also consult the MLA Style Manual and Guide to Scholarly 
Publishing (3rd edition). The MLA Handbook is available in most writing centers and reference libraries; it 
is also widely available in bookstores, libraries, and at the MLA web site. See the Additional Resources 
section of this handout for a list of helpful books and sites about using MLA style. 

GENERAL GUIDELINES 

• Type your paper on a computer and print it out on standard, white 8.5 x 11-inch paper. 
• Double-space the text of your paper, and use a legible font (e.g. Times New Roman). Whatever 

font you choose, MLA recommends that the regular and italics type styles contrast enough that 
they are recognizable one from another. The font size should be 12 pt. 

• Leave only one space after periods or other punctuation marks (unless otherwise instructed by 
your instructor). 

• Set the margins of your document to 1 inch on all sides. 
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• Indent the first line of paragraphs one half-inch from the left margin. MLA recommends that you 
use the Tab key as opposed to pushing the Space Bar five times. 

• Create a header that numbers all pages consecutively in the upper right-hand corner, one-half 
inch from the top and flush with the right margin. (Note: Your instructor may ask that you omit the 
number on your first page. Always follow your instructor's guidelines.) 

• Use italics throughout your essay for the titles of longer works and, only when necessary, 
providing emphasis. 

• If you have any endnotes, include them on a separate page before your Works Cited page. Entitle 
the section Notes (centered, unformatted). 

MARGINS 
The top, bottom, left, and right margins should each be 1 in (2.5 cm) wide. This is the default setting for 
MS Word 2019; before you start, double check your Word 
settings to make sure they have not been modified. 

Step 1. Open a blank Word document (File > New) 
Step 2. Click the Layout tab  
Step 3. In the Page Setup group, click Margins 
Step 4. In the dropdown menu click on the NORMAL 

option.  This will set your margins at 1” on all 
sides. 

SAVE THE FILE 
Step 5. Now that the margins are set, you should save your file. An easy saving method is to use 

your CTRL key with the letter S.  In a new document, if you hold down CTRL and hit the 
letter S, you will receive a Save As dialog box. 

Step 6. Click on the Browse option and navigate to your folders for this class. In the illustration 
my folder is in School\Cuesta\Credit Courses\CIS-AGB 210\CIS 210 UNITS\ UNIT-02

 
Step 7. In the section marked File name, type your file name as u02a2 – Group Project.  

NOTE: You will eventually be uploading your completed portion to the group discussion 
area (u02d1-Group Project: Discussion).  This is for the other members of your group 
to review your submission.  The managing editor of your group will be compiling the 
reports that have been uploaded to the group discussion area.  

Step 8. Click Save.  You will see the new file name appear in the title bar of your document. 
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ADJUST LINE AND PARAGRAPH SPACING 

Line spacing is the amount of vertical space between lines of text in a paragraph.  Paragraph spacing is 
the amount of space above and below a paragraph.  By default, the normal style places 8 points of blank 
space after each paragraph and inserts a vertical space equal to 1.08 lines between each line of text.  

The MLA and APA documentation styles requires that you double-space the entire research paper.  
Double-space means that the amount of vertical space between each line of text above and below the 
paragraph should be equal to one blank line.  

Use these steps when adjusting the line spacing: 

Step 1. Click the Home tab to bring the Home ribbon into view 
Step 2. Navigate to the Paragraph group.  In the group, you should notice a small triangle 

pointing down.  You will click on the down triangle next to the line spacing option 
Step 3. Click 2.0 for the spacing 
Step 4. Click Remove Space after Paragraph

 

You should now have the proper spacing for the report.   

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from loosing your work.  

CREATING A HEADER 

In word processing, one or more lines of text that appears at the top of each page of a document. Once 
you specify the text that should appear in the header, the word processor automatically inserts it.  MS 
Word allows you to use special symbols in the header that represent changing values such as page 
numbers or dates.   

Word will also allow you to specify different headers, for example, one 
for odd-numbered pages (odd headers) and another for even-number 
pages (even headers). 

Follow these guidelines to set the header using MLA style in your 
report.  

Step 1. Click on the word Insert to display the ribbon band.  
Step 2. In the Header & Footer Group, Click Header 
Step 3. In the drop-down menu, Click Edit Header 
Step 4. Click the Home tab to display the home ribbon band. 
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Step 5. While editing the header, click the show/hide option.  

The show/hide button shows the paragraph marks for the 
activity.  Note that the paragraph is now left aligned.   

Step 6. Click on the Align Right Option. 

Step 7. When writing an MLA paper, you would usually put your last name and then insert the 
page number.  Because this is a group project, I am expecting to see your group name 
and the page number.  Type your group name and hit the space bar. The example is 
showing Beehives as the group name.  Make sure you use your actual group name.  

Step 8. Click on the Insert tab to display the Insert ribbon band.  
Step 9. In the Header & Footer Group, Click on Page Number. 
Step 10. Choose Current Position. Click on the Plain Number 

option.  Word will automatically place the current page 
number next to the space after the name.  This is a code.  
As your paper progresses, you will note that all the pages 
are automatically numbered with the current page number 
for that page.   

Step 11. Next Click on the contextual tab labeled Header 
and Footer Tools. This menu only appears when 
you are in the header & footer option of MS Word.   

Step 12. You will notice a red X at the end of the menu.  
Click on the option to Close Header and Footer.  

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from loosing your work.  

NAME AND COURSE INFORMATION (PAGE 1) 

MLA style does not require a separate title page for research papers.  Since we are learning MLA format, 
you will be following all the guidelines for the style.  The title page added after the report will be completed 
for your instructor to identify which members of your group helped with the activity. 
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For the group activity, you will be placing your group name and course information in a block at the top of 
the first report page. This is the format used in this section: 

Student Name 

Instructor Name 

Course Number 

Date (use month day, year option) 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from loosing your work.  

DRAFT REPORT WITH REFERENCES 

The draft document will need your typed submission to the group with the references you used.  If your 
references are created properly in MS Word, your group managing editor will have a much easier time 
creating your document.  Each report will be unique in that your group should decide what you will 
research and what the group plans to submit.  

This does not need to be a long report.  I am primarily interested in checking the group submission for 
the correct format, content and details that will eventually follow through to the UNIT 3 assignment.  

MS WORD SOURCE REFERENCES 

During your research, be sure to record essential publication information about each of your sources.  
MLA documentation style requires information for many types of publications.  These are just a few of the 
MLA documentation requirements: 

• Book: full name of author(s), complete title of book, edition (if available), volume (if available), 
publication city, publisher name, publication year, and publication medium 

• Magazine: full name of author(s), complete title of article, magazine title, issue number (if 
available), date of magazine, page numbers of article, publication medium, and date viewed (if 
medium is a website). 

• Website: full name of author(s), title of website, website publisher or sponsor (if none, write n.p.) 
publication date (if none, write n.d.), publication medium, and date viewed 

As you are working on your paper you should record your sources using the Word reference feature.  
Follow these guidelines: 

Step 1. Click on the References option to open the References ribbon band.  
Step 2. Find the Citations & Bibliography group 
Step 3. In the Style option choose MLA.  
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NOTE: Word 2019 is using the Seventh Edition. When writing a report, it is important to ask your 
instructor which style and edition he or she requires.  The rules change over time and many instructors 
follow rigid guidelines. 

Step 4. Now that the style has been determined, you Click on Manage Sources 
Step 5. This opens the source manager.  Since this is new source you Click on New…  
Step 6. When creating a source, it is important to pay close attention to detail.  First choose the 

type of source. This will give you the important fields for citing the document you are 
referencing.  

Step 7. Make sure the Show All Bibliography Fields option is checked.  This will illustrate 
more available options. It is not necessary to fill in every field but the more detail the 
better.  This gives you the option to record the reference in detail.  You may need to refer 
to this source for a different document. 

 

CITATIONS WITH MULTIPLE AUTHORS 

Step 8. If your source has multiple authors, you should list all names.  To do this Click on the 
Edit option next to the Author Field 
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Step 9. The illustration shows a list of authors that have been entered for a book.  Each name is 
entered in the appropriate field and then the Add option appears.   

Step 10. Once all the authors have been listed in the Names section, Click OK. The list of names 
now appears in the correct format for the book that has been used. 

 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

MANAGING EDITOR - COMBINING REPORTS 

If all members of the group use the reference feature, space their reports properly and upload them to the 
discussion area in a timely manner; it will be easy for the Managing Editor to combine the information 
submitted. This is what should happen: 

Step 1. The group agrees to a designated day in the week for the draft documents to be 
submitted. Look at this as a cutoff date.  If you want to receive credit for this assignment, 
you must submit to the discussion area (u02d1 – GROUP PROJECT: Discussion) by the 
submission date and time the group has agreed.  

Step 2. Once the reports are submitted, the Managing Editor will upload the reports from all the 
participants to their computer.  Each Draft report should have at least one reference.   

The Managing Editor will merge the references and content into one final document.  
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COMBINING THE REPORTS 

Step 1. Use one of the reports submitted as your initial template.  Save the file and make any 
edits necessary to the grammar, punctuation or spelling.  If you see any obvious 
formatting mistakes correct them as well. Save the file as u02a1 Final Report. 

Step 2. Open another report submitted and copy the reference used to your initial template.   
a. Click the References tab to show the References ribbon 
b. In the Citations & Bibliography Group, Click Manage Sources 
c. Refer to the Current List 
d. Highlight all the references listed and Click <-Copy. This will copy the references to 

your Master List on your computer.  

Step 3. Open your u02a1 Final Report created.  
Step 4. Select the references from the Master List that should be copied to the Current List 
Step 5. Click the Copy -> option.  This will copy the reference from the Master list to the Current 

List 

 

Step 6. Click Close to return to the document.  
Step 7. In the document, make sure you have copied all the text you need for the group report 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 



  

~ 29 ~ 

 

GENERATE AND FORMAT - WORK CITED PAGE 

The works cited page alphabetically lists sources that are referenced directly in the paper. MLA requires 
the list of sources to begin on a new page.  These are some of the requirements: 

• Center the title “Work Cited”.  Do not underline, bold or italicize it.  
• The font should be the same as the title of the report (Times New Roman, 12 points, black) 
• The first line of the citation is outdented 
• The entire list of references is double spaced 

CREATE WORK CITED PAGE 

Step 1. Make sure all applicable references have been included in the Current List of sources. 
Step 2. Hold down your CTRL key and hit the END key.  This will take you to the end of the 

document. 
Step 3. If your document has extra returns that are not visible, 

this is a good time to delete those extra returns.  Turn 
on your show/hide button Click on the Home tab.  

Step 4. In the paragraph group click on the paragraph symbol 
or use the key stroke method CTRL + * 

Step 5. Remove any unnecessary returns with your delete key. 
Step 6. Insert a page break hold down the CRTL 

key and hit ENTER or Click the Insert tab 
and select the page break option.  

Step 7. Navigate to the top of the new blank 
page just created. 

Step 8. Click the References tab to display the 
references ribbon band 

Step 9. In the Citations & Bibliography group, 
click the down arrow next to the word 
Bibliography 

Step 10. Choose the Works Cited Option 
Step 11. Word will automatically generate the 

Works Cited; however, for MLA educational reports you need to format information that is 
generated.  

Step 12. Select the entire Works Cited including the title 
Step 13. Click the Home tab to display the home ribbon  
Step 14. Change the font to Times New Roman 12 Points 
Step 15. With the entire Work Cited still selected, change the text color to black or automatic 
Step 16. Change the line spacing to 2.0 and remove space before  

Step 17. Place your cursor on the words Work Cited and click on the center option 
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Step 18. Click away from the update Citations and Bibliography menu.  
Your Work Cited should look like the picture to the right.  

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding 
down the CRTL key and taping the S key.  This is a good habit and keeps you 
from losing your work. 

 

CREATING THE COVER PAGE 

Once the report is complete, it is easy to create the cover page.  The cover 
page is important in that it contains the names of everyone in your group that 
participated in this activity.  Please DO NOT include names of students that 
did not participate.  These are the steps to creating the cover page: 

Step 1. Navigate to the top of the document. Hold down the CTRL 
key and hit the HOME key. 

Step 2. Click the Insert tab to display the Insert Ribbon 
Step 3. In the Pages group, Click Cover Page.  
Step 4. Click on your desired cover page.  It will automatically 

insert above the first page of the report.  
Step 5. Fill out the template.  Make sure you list all the members 

of our group that worked on the report.  

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply 
holding down the CRTL key and taping the S key.  This is a good habit and 
keeps you from losing your work. 

Navigate to the u02a2 assignment and submit the file.  Make sure only one submission is made for your 
group. The group members listed on the cover page will be the members that get credit for the 
submission.  
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UNIT 03 – CREATING A RESEARCH PAPER WITH REFERENCES AND SOURCES 

In Unit 02 you learned how to adjust line and paragraph spacing, use headers to number pages and 
create bibliographical list of sources.  Unit 03 will expand on those lessons by establishing a roadmap to 
the following activities: 

1. Change the Document Settings 
2. Create the Header for each page of the research paper 
3. Type the Research Paper with Citations 
4. Create an Alphabetical Works Cited page 
5. Proofread and Revise the Research Paper 

WRITING STYLES FOR REPORTS 

When writing a report, the question is often what type of report style to use.  The citation style you choose 
will largely be dictated by the discipline in which you're writing, and for most assignments your instructor 
will assign a style to you. However, as you progress through your academic career, you may find more 
flexibility in choosing a style that works for you. It's always best to check with your instructor and 
colleagues as to what style is appropriate. If you have flexibility, use the guide below to help you decide. 

Modern Language Association 
(MLA) 

American Psychological 
Association 

(APA) 

Chicago 

Humanities: English, Art History, 
Philosophy, Music, Religion, 
Language, Linguistics, Etc. 

Social Sciences, Education, 
Engineering, etc. 

History, or the 
Humanities 

The humanities place emphasis 
on authorship and interpreting 
primary sources in a historical context. 
The author's name is the first piece of 
information preceding title and 
publication information on the "Works 
Cited" list at the end of the work. 

These disciplines place emphasis 
on the date of creation or 
publication, to track currency and 
relevancy. The date is listed 
immediately following the author's 
name in the "References" list. 

Typically accompanied 
by a "Bibliography" 
page. 

AMERICAN PSYCHOLOGICAL ASSOCIATION (APA) 

The American Psychological Association (APA) style is, originally, a set of rules that authors use when 
submitting papers for publications in the journals of the APA. Established in 1929, the style has since 
been used to guide research writers and help them achieve – through the use of established standards 
for language, the construction of correct reference citations, the avoidance of plagiarism, the proper use 
of headers, among many others – "minimum distraction and maximum precision". 

 

As a complete style and guideline for writing, the APA is a valuable tool for writing scientific papers, 
laboratory reports, and papers covering topics in the field of psychology, education, and other social 
sciences. The APA style allows for in-text citations, direct quotations, and endnotes and footnotes. It is 
also enables the author to use the past tense of verbs in the reportage. 
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MODERN LANGUAGE ASSOCIATION (MLA) 

The Modern Language Association (MLA) style is the leading style of documentation for literary research, 
as well as academic papers in the humanities field. It follows a specific set of rules for formatting 
manuscripts, and is considered, along with the APA style, a standardized reference format in college. 
Compared to the APA style, however, the MLA style focuses on the citation of books, anthologies, literary 
works, audio-visual material, multimedia, and similar works with much more detail. 

Unlike the APA style, the present tense of verbs is most used in the MLA style. 

CHICAGO MANUAL STYLE REPORTS 

The Chicago Style of writing is used for academic writing in the field of Humanities, especially history. 
Specific guidelines for formatting a paper in Chicago Style are outlined in manuals such as the 16th 
edition of the Chicago Manual of Style, which was issued in September 2010, and the 7th edition of A 
Pocket Guide to Writing in History by Mary Lynn Rampolla, which was issued in 2012. 

 
CHANGE DOCUMENT SETTINGS 
MARGINS 
The top, bottom, left, and right margins should each be 1 in (2.5 cm) wide. This is the default setting for 
MS Word 2019; before you start, double check your Word 
settings to make sure they have not been modified. 

Step 1. Open a blank Word document (File > New) 
Step 2. Click the Layout tab  
Step 3. In the Page Setup group, click Margins 
Step 4. In the dropdown menu click on the NORMAL 

option.  This will set your margins at 1” on all 
sides. 

SAVE THE FILE 
Step 5. Now that the margins are set, you should save your file. An easy saving method is to use 

your CTRL key with the letter S.  In a new document, if you hold down CTRL and hit the 
letter S, you will receive a Save As dialog box. 

Step 6. Click on the Browse option and navigate to your folders for this class. In the illustration 
my folder is in School\Cuesta\Credit Courses\CIS-AGB 210\CIS 210 UNITS\ UNIT-03

 
Step 7. In the section marked File name, type your file name as: 
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u03a1 Headphones and Earbuds  

Step 8. Click Save.  You will see the new file name appear in the title bar of your document. 

 
 

ADJUST LINE AND PARAGRAPH SPACING 

Line spacing is the amount of vertical space between lines of text in a paragraph.  Paragraph spacing is 
the amount of space above and below a paragraph.  By default, the normal style places 8 points of blank 
space after each paragraph and inserts a vertical space equal to 1.08 lines between each line of text.  

The MLA and APA documentation styles requires that you double-space the entire research paper.  
Double-space means that the amount of vertical space between each line of text above and below the 
paragraph should be equal to one blank line.  

Use these steps when adjusting the line spacing: 

Step 9. Click the Home tab to bring the Home ribbon into view 
Step 10. Navigate to the Paragraph group.  In the group, you should notice a small triangle 

pointing down.  You will click on the down triangle next to the line spacing option 
Step 11. Click 2.0 for the spacing 
Step 12. Click Remove Space after Paragraph

 
You should now have the proper spacing for the report.   

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work.  

CREATING A HEADER 

In word processing, one or more lines of text that appears at the top of each page of a document. Once 
you specify the text that should appear in the header, the word processor automatically inserts it.  MS 
Word allows you to use special symbols in the header that represent changing values such as page 
numbers or dates.   
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Word will also allow you to specify different headers, for example, one 
for odd-numbered pages (odd headers) and another for even-number 
pages (even headers). 

Follow these guidelines to set the header using MLA style in your 
report.  

Step 1. Click on the word Insert to display the ribbon band.  
Step 2. In the Header & Footer Group, Click Header 
Step 3. In the drop-down menu, Click Edit Header 
Step 4. Click the Home tab to display the home ribbon band. 
Step 5. While editing the header, click the show/hide option.  

The show/hide button shows the paragraph marks for the 
activity.  Note that the paragraph is now left aligned.   

Step 6. Click on the Align Right Option. 

Step 7. When writing an MLA paper, you would usually put your last name and then insert the 
page number.  Because this is a group project, I am expecting to see your group name 
and the page number.  Type your last name and hit the space bar. 

 
Step 8. Click on the Insert tab to display the Insert ribbon band.  



  

~ 35 ~ 

 

Step 9. In the Header & Footer Group, Click on Page Number. 
Step 10. Choose Current Position. Click on the Plain Number 

option.  Word will automatically place the page current 
page number next to the space after the name.  This is a 
code.  As your paper progresses, you will note that all the 
pages are automatically numbered with the current page 
number for that page.   

Step 11. Next Click on the contextual tab labeled Header and 
Footer Tools. This menu only appears when you are in 
the header & footer option of MS Word.   

Step 12. You will notice a red X at the end of the menu.  Click on 
the option to Close Header and Footer.  

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work.  

NAME AND COURSE INFORMATION (PAGE 1) 

MLA style does not require a separate title page for research papers.  Since we are learning MLA format, 
you will be following all the guidelines for the style.  The title page added after the report will be completed 
for your instructor to identify which members of your group helped with the activity. 

You will be placing your name and course information in a block at the top of the first report page. This is 
the format used in this section: 

Student Name 

Instructor Name 

Course Number 

Date (use month day, year option) 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work.  

CLICK AND TYPE 

After you have configured the first page information using your name and current date, hit the enter key 1 
time.  Double check the following settings: 

1. Font is Times New Roman 12 points 
2. Line spacing is 2.0 with no extra spacing before or after the paragraph 
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You are now ready to begin the report.  The title of the report is centered on the page.  Follow these steps 
to center the title. 

Step 1. Click on the Home tab to display 
the Home Ribbon  

Step 2. Navigate to the paragraph group  
Step 3. Click on the Center option or hold 

down your CTRL key and tap the 
letter E 

Step 4. Type the title of the report 
Headphones and Earbuds 

Step 5. Hit Enter 
Step 6. Using the Home-ribbon; paragraph-group, set the alignment 

back to left.  This can also be done by holding down the 
CRTL key and hitting the letter L 

DISPLAY THE RULERS 

Word’s rulers let you control the margins of your page and the indentation of paragraphs. They’re great 
for precisely lining up images, text, and other elements. If you’re printing a document, the rulers can help 
ensure that what you see on your screen translates into what you’ll get on the printed page. 

The trouble is, rulers aren’t even visible by default in Word anymore. Here’s how to turn them on, and 
how to make the most out of them. 

Step 1. Click on the View option to display the View Ribbon band 
Step 2. Navigate to the Show group.  This group has 3 options Ruler, Gridlines and Navigation 

Pane.  
Step 3. Click on Ruler this will display both the horizonal and vertical rulers of the page. 

WORD WRAP 

The word processor has a feature called Word Wrap.  Word Wrap is used to force all text to fit within the 
defined margins. When you fill one line with text, the word processor automatically jumps to the next line. 
You are not required to keep track of line lengths or to press the Enter key after each line.   

Step 1. With the insertion point below the title, HIT your TAB one time.  This will automatically 
indent the first line of the paragraph .5 inch.  For MLA papers, paragraphs should be 
indented .5 inch unless after a level B heading.  We will not be creating any level B 
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headings in this document; therefore, all new paragraphs will have a first line indent of .5 
inch.   

Step 2. Type Over the past several years, 
headphones have gone from the red-headed 
step-child of the audio world to a must-have 
fashion accessory. Today, there is a wider 
selection of headphones than ever before. 

Step 3. Hit your space bar and then type the 
beginning of the next sentence, misspelling the 
word, the as follows: Headphones cover or are 
placed outside of teh 

Step 4. Press the spacebar and watch Word 
automatically correct the misspelled word.  Type the rest of the sentence: ear, whereas earbuds 
rest inside the ear canal. 

Step 5. Finish the paragraph with the following misspelled words: With these listening devices, 
only the individual wearing the devices hears the sould. Using headphones or earbuds 
improperly can lead to permanent hearing loss. Items that may protect hearing include 
quality of these devices and volume levels. 

NOTE: Some of the words are intentionally spelled incorrectly.  You will be using the Word spelling and 
grammar check to fix the errors later in the activity.  

Step 6. Hit Enter to start a new paragraph 
Step 7. Remember the first line of the new paragraph is indented .5 inch.  STRIKE your TAB key 

one time. 
Step 8. Type The features of certain headphones and earbuds can help to prevent hearing 

loss. Higher-quality headphones and earbuds tend to produce a clearer sound, 
enabling wearers to listen at a lower volume (then press the spacebar)

 

CREATE CITATION #1 

Step 1. Click on the References option to open the References ribbon band.  
Step 2. Find the Citations & Bibliography group 
Step 3. In the Style option choose MLA.  
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NOTE: Word 2019 is using the Seventh Edition. When writing a report, it is important to ask your 
instructor which style and edition he or she requires.  The rules change over time and many instructors 
follow rigid guidelines. 

Step 4. Now that the style has been determined, you Click on Manage Sources 
Step 5. This opens the source manager.  Since this is new source you Click on New…  
Step 6. When creating a source, it is important to pay close attention to detail.  First choose the 

type of source. This will give you the important fields for citing the document you are 
referencing.  

Step 7. Make sure the Show All Bibliography Fields option is checked.  This will illustrate 
more available options. It is not necessary to fill in every field but the more detail the 
better.  This gives you the option to record the reference in detail.  You may need to refer 
to this source for a different document. 

 
Step 8. CITATION #1 

a. TYPE OF SOURCE:  Article or Periodical 
b. AUTHOR: Mingzhu Lin Tu 
c. TITLE: Headphones and Earbuds 
d. PERIODICAL: Technology and Trends Today 
e. YEAR: 2017 
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f. MONTH: Aug. 
g. PAGES: n. pag. 
h. MEDIUM: Web 

CHECK SHOW ALL BIBLIOGRAPHY FIELDS 
i. YEAR ACCESSED: 2017 
j. MONTH ACCESSED: Oct. 
k. DAY ACCESSED:  3 

NOTE:  MLA documentation abbreviates all 
months, except May, June, and July 

 n. pag. means there is no pagination 
INSERT CITATION AND TEXT 

With your insertion point after space in the word volume (second paragraph), 
you are ready to insert the citation you created.  Follow these steps: 

Step 1. Click on the References tab to display the reference ribbon 
Step 2. In the Citations and Bibliography group, Click Insert Citation 
Step 3. Navigate to the citation by Tu and Click on it. 

NOTE: Word automatically set the last name of the author first. This is a 
convenient feature. If you type the name in the regular format (First name Last 
name), word knows to search for the last name and use that name for the 
reference. 

Step 4. Type a period with a space after it at the end of the citation.  
Step 5. Type more text: Properly designed headphones should have a close fit for optimal 

listening. Similarly, earbuds should seal tightly in the ear canal of the person 

wearing the device. Headphones and earbuds also should include noise-canceling 
technology.   

INSERT FOOTNOTE 

The MLA documentation style specifies that a superscript ((raised number) be used for a note reference 
mark to signal that a note exists either at the bottom of the page as a footnote or at the end of the 
document as an endnote.  

Footnotes appear at the bottom of the page and endnotes come at the endo of the document. A number 
or symbol on the footnote or end note matches up with a reference mark in the document.   

* IMPORTANT NOTE: Once you have created the footnote it is important that you click back into the 
main portion of the document. Please follow these detailed instructions: 
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Step 1. Click on the References tab to display the references ribbon 
Step 2. Look for the Footnotes group.  
Step 3. After the period (no space) in the word technology, Click Insert Footnote.  
Step 4. A number superscript number will appear, and your mouse will be directed down to 

the bottom of the page. Notice there is a separator line that has been automatically 
created.  The footnote is numbered in the document and at the bottom of the page. 

 
Step 5. Type the footnote: Gupta and Padro state that effective noise-cancelling technology 

reduces the interference of sounds from the surrounding environment, reducing 
the volume level required by headphones and earbuds. HIT YOUR SPACE BAR AFTER 
THE PERIOD. 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work.  

INSERT CITATION PLACEHOLDER 

With your cursor insertion point at the end of the footnote, you are going to insert a citation placeholder 
following these instructions:

 

Step 1. Click on the References tab to display the references ribbon 
Step 2. In the Citations & Bibliography group, Click on Insert Citation 
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Step 3. The drop-down menu will display several options.  Click on Add New Placeholder.

 
Step 4. Type Gupta as the tag name for the 

source 
Step 5. Click OK 

 

MODIFY FOOTNOTE STYLE 

The default Footnote Text style specifies left-aligned 
single-spaced paragraphs with a 10-point font size for 
text. To meet MLA document style, the footnotes should 
be double-spaced with a first-line indent and Times New 
Roman 12-point font.  Follow these instructions to change 
the format for the footnote style: 

Step 1. Right-click anywhere in the footnote 
Step 2. Click the Style. . .  option 
Step 3. Because you chose the style option while 

in the footnote, the style menu opens to 
edit the footnote text. Click Modify 

Step 4. Change the font to Times New Roman 
Step 5. Change the size to 12 
Step 6. Click the Line spacing option (image 

below) to double 
Step 7. Click the Format option 
Step 8. Click the Paragraph option 
Step 9. Click the tab for Indents and Spacing 
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Check the settings.  You should have the following set for your footnote text 

i. ALIGNMENT:   left  
ii. OUTLINE LEVEL:   Body Text 

iii. INDENTATION LEFT:  0” 
iv. INDENTATION RIGHT:  0” 
v. INDENTATION SPECIAL:  First line 

1. By: 0.5” 
vi. SPACING BEFORE:  0 pt 
vii. SPACING AFTER: 0 pt 
viii. LINE SPACING:  Double 

Step 10. Once your paragraph settings are complete, Click OK 
Step 11. In the Modify Style dialog box, Click on Apply 

NOTE: Changing style for the footnote changes the settings throughout the document.  If you create a 
second footnote, it will use the new style.  Keep in mind, unless you change the default style, your style 
changes stay with the current document.  

EDIT A SOURCE 

Step 1. Click the placeholder (Gupta) for the citation. 
Step 2. Click the Citation Options arrow (next to the placeholder) 
Step 3. Click Edit Source 

Step 4. Click on the Edit option next to the Author Field. Each name is entered in the appropriate 
field and then the Add option appears.   
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Step 5. Enter the following 
information for each 
author 
a. AUTHOR #1 

i. LAST:  Gupta 
ii. FIRST: Elena 
iii. MIDDLE:  Maia 

Step 6. Click Add 
a. AUTHOR #2 

i. LAST:  Padro 
ii. FIRST: Adelbert 
iii. MIDDLE:  Luis 

Step 7. Click Add 
Step 8. Click OK 
Step 9. You are now ready to enter the book 

information.  In each field enter the 
following (tab to each entry):  
a. TYPE OF SOURCE:  Book 
b. AUTHOR:  Tab to the title field 
c. TITLE:  Hearing Projection Methods 
d. YEAR:  2017 
e. CITY: Orlando 
f. PUBLISHER: Palm Press 

Step 10. Click OK 
 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

NOTE: When you are entering these, it is 
easiest to tab after each entry.  That will 
automatically take you to the next field.  (ie: 
Enter last name, tab; Enter first name, tab; Enter 
middle, Add) 
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EDIT A CITATION 

The citation in the report now has two authors listed. MLA document style requires the page numbers are 
included with citation.  This is the process you should follow to insert the page numbers into the citation 
we just created: 

Step 1. Select the citation drop-down menu to reveal the options. 
Step 2. Click Edit Citation 
Step 3. Our citation is only going to show the page number.  In the Edit Citation display box, Click 

the following: 
a. SUPPRESS:  Author and Title 

Type the entries for the pages as follows (NUMBERS ONLY) 

b. PAGES:  75-78 

Step 4. Click OK 

The footnote will look like the following screen.  After you have verified the screen is information is 
correct, you need to make sure you have exited the footnote feature.  This is done by following these 
guidelines: 

Step 5. In the document, Click into the text area after the footnote reference (number). 
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SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

 

ENTER CITATION #3 AND TEXT 

With your insertion point after the reference number in the document, follow these steps: 

Step 1. Hit your Enter key to start a new paragraph 
Step 2. Tab to indent the first line of the paragraph 
Step 3. Type The volume level of the sound that transmits from headphones or earbuds 

into the ear of a person we4aring this type of device has been linked to hearing 
loss. The volume should be set low enough that other people nearby cannot hear 
the sound being transmitted.  The quieter the sounds, the less possibility of 
hearing damage. Further, listening at a higher volume for extended periods of time 
could be unsafe. One expert suggests people should listen at only 30 percent 
maximum  

Step 4. Hit your Spacebar after the word maximum 
Step 5. Click on the References option to open the References ribbon band.  
Step 6. Find the Citations & Bibliography group 
Step 7. In the Style option choose MLA.  

NOTE: Word 2019 is using the Seventh Edition. When writing a report, it is important to ask your 
instructor which style and edition he or she requires.  The rules change over time and many instructors 
follow rigid guidelines. 

Step 8. Now that the style has been determined, you Click on Manage Sources 
Step 9. This opens the source manager.  Since this is new source you Click on New…  
Step 10. When creating a source, it is important to pay close attention to detail.  First choose the 

type of source. This will give you the important fields for citing the document you are 
referencing.  

Step 11. Make sure the Show All Bibliography Fields option is checked.  This will illustrate 
more available options. It is not necessary to fill in every field but the more detail the 
better.  This gives you the option to record the reference in detail.  You may need to refer 
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to this source for a different document. 

 
Step 12. CITATION #3 

a. TYPE OF SOURCE:  Website 
b. AUTHOR: Megan Lynn Chamberlain 
c. TITLE: Understand How Volume Levels Affect Hearing 
d. COMPANY: Course Technology 
e. YEAR:  
f. MONTH:  

CHECK SHOW ALL BIBLIOGRAPHY FIELDS 
g. YEAR ACCESSED: 2017 
h. MONTH ACCESSED: Sept. 
i. DAY ACCESSED:  16 
j. MEDIUM: Web 

NOTE:  MLA documentation abbreviates all months, except May, June, and July 

  
Step 13. Click OK (your citation is now complete) 
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Step 14. Click Insert Citation

 
Step 15. Choose the Chamberlain citation and Click on it 
Step 16. Place your punctuation after the citation.  Enter a period. 
Step 17. Hit enter to advance to the next paragraph 
Step 18. Hit Tab to indent the first line of the paragraph 
Step 19. Type More and more people are using headphones and earbuds with their 

computers and portable devices. Using high-quality listening devices and lowering 
the volume can help to lessen potential hearing loss from the use of headphones 
and earbuds. 

Step 20. Enter a manual page break by holding down your CTRL key and HIT ENTER 
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SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

BIBLIOGRAPHICAL LIST – MLA WORK CITED 

The next task is to use Word to format the list of sources and alphabetize them in a biographical list. The 
following steps are for creating an MLA-styled biographical list from the sources previously entered. 

The works cited page alphabetically lists sources that are referenced directly in the paper. MLA requires 
the list of sources to begin on a new page.  These are some of the requirements: 

• Center the title “Work Cited”.  Do not underline, bold or italicize it.  
• The font should be the same as the title of the report (Times New Roman, 12 points, black) 
• The first line of the citation is outdented 
• The entire list of references is double spaced 

CREATE WORK CITED PAGE 

Step 1. Make sure all applicable references have been included in the Current List of sources. 
Step 2. Hold down your CTRL key and hit the END key.  This will take you to the end of the 

document. 
Step 3. If your document has extra returns that are not visible, 

this is a good time to delete those extra returns.  Turn 
on your show/hide button Click on the Home tab.  

Step 4. In the paragraph group click on the paragraph symbol 
or use the key stroke method CTRL + * 

Step 5. Remove any unnecessary returns with your delete key. 
Step 6. Insert a page break hold down the CRTL 

key and hit ENTER or Click the Insert tab 
and select the page break option.  

Step 7. Navigate to the top of the new blank 
page just created. 

Step 8. Click the References tab to display the 
references ribbon band 

Step 9. In the Citations & Bibliography group, 
click the down arrow next to the word 
Bibliography 

Step 10. Choose the Works Cited Option 
Step 11. Word will automatically generate the 

Works Cited; however, for MLA educational reports you need to format information that is 
generated.  

Step 12. Select the entire Works Cited including the title 
Step 13. Click the Home tab to display the home ribbon  
Step 14. Change the font to Times New Roman 12 Points 
Step 15. With the entire Work Cited still selected, change the text color to black or automatic 
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Step 16. Change the line spacing to 2.0 and remove space before  

Step 17. Place your cursor on the words Work Cited and click on the center option 
Step 18. Click away from the update Citations and Bibliography menu.  

Your Work Cited should look like the picture to the right.  

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding 
down the CRTL key and taping the S key.  This is a good habit and keeps you 
from losing your work. 

 

MODIFY A SOURCE 

As you proofread your paper, you may find errors with the sources that should be revised.  If you modify 
the contents of any source, the list of sources automatically updates.  Follow these steps to modify the 
sources in this document: 

Step 1. Click the References tab to display the References ribbon band 
Step 2. In the Citations & Bibliography group, Click Manage Sources 

You may have many sources from previous papers; however, the sources for this paper will appear in the 
right panel of the page. 
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Step 3. Click on the Current List reference for Tu 
Step 4. Click Edit 
Step 5. Change the reference for the Periodical Title 
Step 6. Remove the word and 

a. PERIODICAL TITLE: Technology Trends Today 
Step 7. Click OK 

Step 8. Whenever you change the current list of references, you are prompted to change the 
Master List as well.  Click Yes to confirm the change to the Master list.  

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

UPDATE THE WORK CITED 

Once you have made changes to the sources in the document, you can update the sources generated 
very easily.  Follow these steps to update the Work Cited references: 

Step 1. Right-click anywhere in the Work Cited bibliography text. This will display the shortcut 
menu 

Step 2. Click Update Field 
Step 3. If your font and spacing changed, make sure you change it back to the correct settings. 

Select the entire Works Cited including the title 
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Step 4. Click the Home tab to display the home ribbon  
Step 5. Change the font to Times New Roman 12 Points 
Step 6. With the entire Work Cited still selected, change the text color to black or automatic 
Step 7. Change the line spacing to 2.0 and remove space before  

The following document displays the Works Cited with all the new adjustments made: 

 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

COPYING, CUTTING, AND PASTING 

The Office Clipboard allows you to copy up to 24 items from Office documents or other programs and 
paste them into another Office document. For example, you can copy text from an email message, data 
from a workbook or datasheet, and a graphic from a presentation, and then paste them all into a 
document. By using the Office Clipboard, you can arrange the copied items the way that you want in the 
document. 

You’re not limited to only pasting the last item you copied or cut when you use the Clipboard task pane. 
The Clipboard task pane holds many of the last images and text you copied or cut. 

NOTE: You can still do simple cut, copy, and paste the way you're used to, either by using the buttons 
on the ribbon or the keyboard shortcuts CTRL+X (Cut), CTRL+C (Copy), or CTRL+V (Paste). 
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• Copy (CTRL+C) –The copy command places items on the Office Clipboard, leaving the item in 
the document. 

• Cut (CTRL+ X) – This removes the item from the document before placing it on the Office 
Clipboard.  

• Paste (CTRL+V) – The process of copying an item from the Office Clipboard into the document 
at the location of the insertion point.  

For the activity, you will be copying the word volume from the report you created and pasting it into 
another location.  Follow these steps: 

Step 1. Click the Home tab to display the Home Ribbon 

Step 2. Double-click the word “volume” at the end of the first paragraph 
Step 3. Once you highlight the word, the copy command appears on the ribbon band. In the 

Clipboard group, Click Copy or hold down the CTRL key and hit the letter C (CTRL+C) 

Step 4. Place your cursor in the space after the word maximum in paragraph 3.  
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Step 5. In the Clipboard group, Click Paste or hold down the 
CTRL key and hit the letter V (CTRL+V) 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by 
simply holding down the CRTL key and taping the S key.  This is a good habit and keeps you from losing 
your work. 

FIND AND REPLACE 

All editions of Microsoft Word offer a feature called Find and Replace. You use this when you need to 
search for a specific word, number, or phrase in a document and replace it with something else. This is 
quite useful if you need to make a lot of replacements at once like changing the name of the main 
character in a novel you’ve written or something you've consistently misspelled. 

Fortunately, you can tell Word to make all of the changes automatically. You can also replace numbers, 
punctuation, and even cap or uncap words; just type what to find and what to replace it with and let Word 
do the rest. 

Step 1. With your report open, Click the Home tab to display the Home Ribbon 
Step 2. In the Editing group, Click on the Replace option 

Step 3. Using the Find and Replace dialog box type the following: 
a. FIND WHAT:  portable 

https://www.lifewire.com/microsoft-word-4159373
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b. REPLACE WITH: mobile 

Step 4. Click Replace All 
Step 5. Click OK 
Step 6. Click the Close button to close the dialog box 

USING SYNONYMS 

In addition to the spell checking and grammar checking tools that Microsoft 
Word offers, there is also the Word thesaurus we can take advantage of to 
improve our documents. Using the thesaurus, you can find synonyms 
(different words with the same meaning) and antonyms (words with the 
opposite meaning). 

Step 1. In your open report, navigate to the word lessen in the last 
paragraph 

Step 2. Right-click lessen 
Step 3. Point to the word Synonyms. A shortcut menu will appear 

to display the Synonyms in the MS Word Thesaurus.  
Step 4. Choose the alternate word diminish.  Your sentence now 

reads “Using high-quality listening devices and lowering the 
volume can help to diminish potential hearing loss from the 
use of headphones and earbuds.” 

CHECK SPELLING AND GRAMMAR 

All Microsoft Office programs can check the spelling and grammar. You can check spelling and grammar 
all at once by running the spelling and grammar checker, or you can check spelling and grammar 
automatically and make corrections as you work. You can also turn the automatic spelling and grammar 
off if you'd like. 
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The Microsoft Word spelling and grammar check will run a basic spell check and will correct basic 
punctuation errors. But that’s as far as it goes. It doesn’t check for proper sentence structure and it 
doesn’t check context.  

Follow these steps to complete the spell check in your report: 

Step 1. Start at the top of the document by holding down your CTRL key and hitting the HOME 
key (CTRL+HOME). This technique will take you to the first position of the document.   

Step 2. Click the Review tab to reveal the Review Ribbon.  Note that this menu has several 
options to choose from. 

Step 3. In the Proofing group, Click Spelling & Grammar 

Step 4. The first word found is the misspelling of should (sould).  Note that the word is highlighted 
and three options to choose from appear.  Click on should.  The word is replaced with the 
correct spelling.   

For example, if you use the wrong “there” a basic spelling check will show that the word is 
correct. It won’t use context checking to ensure it’s the actual correct word usage. 

While in theory, you’re spelling is correct, if you use the wrong words, you will still make 
the wrong impression on professors, potential employers or prospective clients. 
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Step 5. You will then receive a message to Click on OK.  This completes the spelling and 
grammar check in Word; however, there is another obvious typing error in the document.  
It is further down the page in paragraph 3. 

Step 6. The error was a typing mistake, but Word missed the problem.  It is recommended that 
you proof read all documents before you confirm your document is complete. To fix the 
error, Click between the 4 and a 

Step 7. Hit your Backspace key  

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

SMART LOOKUP IN MICROSOFT WORD 

Get more insight into what you're working on by using Smart Lookup. Just follow a few simple steps to 
find articles, top searches from the web, and more. 

Step 1. In the first paragraph of your paper, double-click the word headphones in the first 

paragraph.  The double click will select the word. 
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Step 2. Right-click the word you have selected (headphones). 

 
Step 3. If you receive a prompt regarding intelligent services, Click 

Turn on 
Step 4. Word will display definitions, images and web sources for 

purchase.  This is an example of the result for the word 
headphones: 

ZOOM MULTIPLE PAGES 

When laying out your document in Word, it’s sometimes helpful to view multiple pages on the screen at 
one time, especially if you have a large monitor. Seeing multiple pages at a time allows you to get a 
sense of how your overall layout looks.  

The Zoom feature allows you to view your text in different sizes without adjusting any fonts in the 
document. For a research paper, it is good practice to zoom out and view multiple pages at once.   

Step 1. Click on the View tab to display the View Ribbon 
Step 2. In the Views Group, Click Print Layout
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Step 3. In the Show Group, Click the Ruler option.  All other options should be unchecked. 

Step 4. In the Zoom Group, Click Multiple Pages.  Check for all the MLA format changes that 
should be in the document.  When you are satisfied with your report format, save the file 
and submit it in the assignment are for u03a1 Headphones and Earbuds. 

 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

SUBMIT ASSIGNMENT: u03a1 Headphones and Earbuds 

ON YOUR OWN ACTIVITY 

For this activity you are creating a short research paper with a footnote and 3 references.  The research 
paper should be in MLA format with your name as the student name.  You will be following the MLA 
formatting guidelines you learned in the tutorial for UNIT 03. Follow these guidelines; however, refer back 
to the lessons for details on how to apply the processes: 

Step 1. Open a new Word document 
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Step 2. Change your document settings to the MLA format  
Step 3. Create the Report Header using your last name 
Step 4. Format the first page of the report with the MLA guidelines for educational reports  
Step 5. Click and type your heading for the report in the center of the page 

a. HEADING: Two-Step Verification 

Step 6. Save your report as u03a2 Two-Step Verification 
Step 7. Show your ruler bars 
Step 8. Remember to tab in the first line of the new paragraphs.  Type the following text: 

Step 9. Leave your cursor one space after the word account 
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Step 10. In the References tab, and enter the following reference source: 
a. TYPE OF SOURCE:  Article in Periodical 
b. AUTHOR: Hana Kei Tanaka 
c. ARTICLE TITLE:  Safeguards against Unauthorized Access and Use 
d. PERIODICAL TITLE: Technology Today 
e. YEAR: 2017 
f. MONTH: Sept. 
g. PAGES: no pages used (refer to Citation #1 tutorial) 
h. MEDIUM: Web 
i. YEAR ACCESSED: 2017 
j. MONTH ACCESSED: Oct. 
k. DAY ACCESSED: 3 

Step 11. Insert the citation after the word account using the proper punctuation after the citation.  
Step 12. Add the following text and footnote to the document:

 
Step 13. Add a reference to this document in the sources: 

a. TYPE OF SOURCE: Book 
b. AUTHORS: Aaron Bradley Moore 

 Brianna Clare O’Sullivan 

c. TITLE: Authentication Techniques 
d. YEAR: 2017 
e. CITY: Detroit 
f. PUBLISHER: Great Lakes Press 
g. MEDIUM: Print 

Step 14. Insert the new citation at the end of the footnote. 
Step 15. Modify the footnote style to the correct style for MLA documents 
Step 16. Edit the citation with following settings: 

a. SUPPRESS: Author and Title 
b. PAGES: 54 
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Step 17. Click back into the document, and type the following text after the footnote marker: 
Step 18. Add a third reference to the document in the sources: 

a. TYPE OF SOURCE: Website 
b. AUTHOR: Fredrick Lee Marcy 
c. NAME OF WEBPAGE: Two-Step Verification 
d. YEAR/MONTH/DAY: none given 
e. PRODUCTION COMPANY: Course Technology 
f. MEDIUM: Web 
g. YEAR ACCESSED: 2017 
h. MONTH ACCESSED: Sept. 
i. DAY ACCESSED: 18 

Step 19. Insert the citation at the end of the new paragraph and add the proper punctuation. 
Step 20. Type the remainder of the paragraph and add a citation from Moore and O’Sullivan and 

add the last paragraph shown in the illustration below: 
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Step 21. Insert a hard page break and generate the bibliographical list for the Work Cited 
Step 22. Format the Work Cited using the MLA guidelines outlined in the tutorial. 
Step 23. Save your work and submit your completed report to the u03a2 assignment area.  
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UNIT 04 - CREATING, FORMATTING AND EDITING A WORD DOCUMENT WITH A 
PICTURE  

In this exercise, you will learn how to create a flyer.  The following 
roadmap identifies general activities you will perform as you progress 
through the activity. 

A. ENTER TEXT in a new document 
B. FORMAT the TEXT in the flyer 
C. INSERT a PICTURE, called Mountain Trail, in the flyer 
D. FORMAT the PICTURE in the flyer 
E. ENHANCE the PAGE with a border and spacing. 
F. CORRECT errors AND REVISE text in the flyer 
G. PRINT OR READ the flyer. 

CHECK YOUR SETTINGS 

To complete the activity, it is important to check the settings before 
you begin the activity. After you have completed step 1 (opening a 
blank Word document), please verify the following: 

Verification Step 1. Click Design to expose the Design 
Ribbon  

Verification Step 2. Click Themes choose Office 
Verification Step 3. Click Home to show the Home 

Ribbon 
Verification Step 4. In the Font group, Font choose 

Calibri 11 points 
Verification Step 5. From Home tab, click the paragraph 

group dialog box (lower right corner 
of the group) to expose the 
paragraph settings  

Verification Step 6. Click the Indents and Spacing tab 
Verification Step 7. These are the settings you should see: 

a. GENERAL 
i. ALIGNMENT: Left 
ii. OUTLINE LEVEL: Body Text 
iii. INDENTATION: 

1. LEFT: 0” 
2. RIGHT: 0” 
3. SPECIAL: (NONE) 

iv. SPACING: 
1. BEFORE: 0 pt 
2. AFTER: 8 pt 
3. LINE SPACING: Multiple 
4. AT: 1.08 

Verification Step 8. Once you have verified the paragraph settings, you should check the margin 
settings. Click Layout to display the layout ribbon 

Verification Step 9. In the page setup group, Click Margins 

Figure 1 : Paragraph Settings Dialog Box and icon 
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Verification Step 10. The Normal setting of 1” for the left, right, top and bottom margins should 
be selected.  

NOTE: The reason why this is important is that many times the default settings for your program have 
been altered.  These should be the default settings for every Word 2019 document; however, if they 
were arbitrarily set at something different on your computer the instructions for the assignment may 
not produce the correct result.  

U04A1 ADVENTURE FLYER 
Step 1. Open MS Word – Click on the Word icon on your Windows desktop. If the icon is not on your 

desktop, ask your instructor how to set it up. 
Step 2. Click File > New – Choose the FILE ribbon can click on New.  This will open a blank 

Word document. 
Step 3. Print Layout -- If the Print Layout button on the status bar (page 3) is 

not selected, tap or click it so that your screen is in Print Layout view 
Step 4. Click the Home Tab to display the home ribbon band 
Step 5. In the styles group, check that Normal Style is active – If  Normal (HOME tab | Styles group) is not 

selected in the Styles gallery, tap or click it so that your document uses the Normal style. 

Step 6. To begin creating the flyer, type the headline in the document window. Type Adventure! 

What if you make an error while typing? You can press the BACKSPACE key until you have deleted 
the text in error and then retype the text correctly. 

What is the purpose of the Spelling and Grammar Check icon on the status bar? The spelling and 
Grammar Check icon displays either a check mar to indicate the entered text contains no spelling 
or grammar errors, or an X to indicate that it found potential 

errors.  Word flags potential errors in the document with a red, green or 
blue wavy underline. 

Step 7. Press the ENTER key to move the insertion point to the 
beginning of the next line. 

Print Layout  

Notice your insertion point moves 
to the right as you type 
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Why did blank space appear between the headline and the insertion point? Each time you press the 
ENTER key, Word creates a new paragraph and inserts blank space between the two paragraphs.  This 
spacing can be increased or decreased by using the spacing options in the paragraph group of the 
HOME ribbon band. 

Step 8. Display Formatting Marks – You may find it helpful to display formatting marks while working in a 
document.  Why? Formatting marks indicate where in a document you press the ENTER key, 
SPACEBAR, and other nonprinting characters.  A formatting 
mark is a character that WORD displays on the screen but is 
not visible on a printed document. For example, the 
paragraph mark (¶) is a formatting mark that indicates where 
you pressed the ENTER key.  A raised dot (.) shows where 
you pressed the SPACEBAR. Dis7play the marks on your 
document my clicking on the Show/Hide ¶ button on the 
(HOME tab | Paragraph group) to display the formatting 
marks.  

Step 9. Click on, Click off – Many of the options on the ribbon bands are turn off the same way you turn 
them on.  This means you click on them to turn them on and click again to turn them off.  To turn off 
the formatting marks, simply click the Show/Hide ¶ button again. 

Step 10. Zooming – If text is too small for you to read on the screen, you can 
zoom the document by dragging the Zoom slider on the status bar or 
tapping or clicking the Zoom Out or Zoom in buttons on the status bar.  
Changing the zoom has no effect 
on the printed document. 

Step 11. Insert a Blank Line – In the flyer, 
the digital picture of the mountain 
trial appears between the headline and body copy. 
You will not insert this picture until you enter and 
format all the text.  Why?  In order to learn the 
formatting techniques first we will be inserting the image later in the exercise; therefore, you need a 
place holder for the future picture.  Press ENTER to insert a blank line in the document.  

Step 12. VIEW tab | Zoom group – Tap or click the Page Width button (VIEW tab | Zoom group) to display 
the page the same width as the document window.  

If I change the zoom, will the document print differently?  Changing the zoom has no effect on the 
printed document. 

Zoom from the 
VIEW Ribbon 

Zoom from the 
status bar 

blank line inserted 

insertion point 
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What are the other predefined zoom options? Through the VIEW tab | Zoom group or the Zoom dialog 
box (Zoom button in Zoom group), you can zoom to one page (an entire single page appears in the 
document window), many pages (multiple pages appear at once in the document window), page width, 
text width, and a variety of set percentages.  Whereas page width zoom places the edges of the page at 
the edges of the document window, text width zoom places the document contents at the edges of the 
document window. 

SAVE YOUR DOCUMENT 

Step 1. On your keyboard, hit the F12 key.  This will open the Save as dialog box for this activity. 

Step 2. Using the Browse option, Open your UNIT 04 folder for this class  
Step 3. Enter the filename for this assignment: u04a1 Adventure Flyer 
Step 4. Click Save 

 

WORDWRAP AND SPELL CHECK 

Wordwrap allows you to type words in a paragraph continually without pressing the ENTER key at the 
end of each line.  As you type, if a word extends beyond the right margin, Word also automatically 
positions that word on the next line along with the insertion point.   
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Word creates a new paragraph each time you press the ENTER key. Thus, as you type test in the 
document window, do not press the ENTER key when the insertion point reaches the right margin.  
Instead, press the ENTER key only in these circumstances: 

1. To insert a blank line(s) in a document 
2. To begin a new paragraph 
3. To terminate a short line of text and advance to the next line 
4. To respond to questions or prompts in Word dialog boxes, task panes, and other on-screen 

objects. 
Step 1. With your cursor positioned at the last blank insertion point, type the first sentence of the body: 

Explore scenic trails with breathtaking views as you travel through meadows, forests, 
streams, and mountains in an off-road vehicle. 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 
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CHECK SPELLING AND GRAMMAR AS YOU TYPE 

In the following steps, the word, tours, has been misspelled 
intentionally.  Why? These steps illustrate the “check 
spelling as you type” feature. 

Step 1. Type Self-guided tuors and then press the 
SPACEBAR, so that a wavy line appears below 
the misspelled word. 

 

 

Step 2. Right-click the misspelled word (tuors, in this case) 
to display a shortcut menu that presents a list of 
suggested spelling corrections for the flagged word 

Step 3. Select the word tours – Tap or click tours on the 
shortcut menu to replace the misspelled word in the 
document with a correctly spelled word. 

 

ENTERING MORE TEXT 

After you change the spelling of the word tours, your 
cursor is on the word and not at the end of the line where 
you inserted a space.  This activity will take to you the end of a line with using only one key.  

Step 1. Press the END key – Press the END key to move the 
insertion point to the end of the current line. 

Step 2. Type available 
Step 3. press the ENTER key 
Step 4. Type Open March through October  
Step 5. press the ENTER key. 
Step 6. Type All vehicles and gear provided  
Step 7. press the ENTER key. 
Step 8. Type the signature line in the flyer: To book 

your adventure, call 555-8928! 

How should you organize text in a flyer? 
The text in a flyer typically is organized into three areas: headline, body copy, and signature line. 

• HEADLINE – The headline is the first line of text on the flyer.  It conveys the product or service 
being offered, such as a car for sale, personal lessons, or sightseeing tours, or the benefit that 
will be gained, such as a convenience, better performance, greater security, higher earnings, or 
more comfort, or it can contain a message, such as a lost or found pet. 

Space between misspelled 
word and insertion point 

Misspelled word flagged with 
red wavy underline 

Spelling and Grammar Check icon 
contains X, indicating Word detected 
a possible spelling or grammar error 
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• BODY -- The body copy consists of text between the headline and the signature line.  This text 
highlights the key points of the message in a few words as possible.  It should be easy to read 
and follow. While emphasizing the positive, the body copy must be realistic, truthful, and 
believable. 

• SIGNATURE - The signature line, which is the last line of text on the flyer, contains contact 
information or identifies a call to action. 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

 

FORMATTING PARAGRAPHS AND CHARACTERS 

The headline in the flyer currently is left aligned.  Why? Word, by default left-aligns text, unless you 
specifically change the alignment.  You want the 
headline centered, that is, positioned horizontally 
between the left and right margins on the page.  
Recall that Word considers a single short line of text, 
such as a one-word headline, a paragraph.  Thus, 
you will center the paragraph containing the 
headline. The following steps center a paragraph. 

 

 

Step 1. Click HOME to display the HOME ribbon band   
Step 2. Click somewhere in the first paragraph to be centered (in this case, the headline) to position 

the insertion point in the paragraph 

HOME TAB / PARAGRAPH GROUP 

A. Bullets 
B. Numbering 
C. Multilevel List 
D. Decrease Indent 
E. Increase Indent 
F. Sort 
G. Show/Hide 
H. Left Align 
I.  Center 
J.  Right Align 
K. Line and Paragraph Spacing 
L. Shading 
M. Borders 
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Step 3. In the Paragraph Group, Click the Center button  

SELECT A LINE 

The 
default font 
size of 11 
points is 
too small 
for a 
headline in 
a flyer.  To 
increase 
the font 
size of the 
characters 
in the 
headline, 
you first 
must select the line of text containing the headline.  
Why? If you increase font size of text without selecting 
any text, Word will increase the font size only of the word 
containing the insertion point. 

 

 

 

Step 4. Triple Click - With your insertion point in the centered 
headline (Adventure), triple click your mouse (three quick 
clicks).  This move will select the paragraph.  

Step 5. If you are using a mouse, point to 72 in the Font Size 
gallery to display a live preview of the selected text at the 
selected point size. 

Experiment – Point to various font sizes in the Font size gallery and watch the font size of the selected 
text change in the document window.  When you have finished, keep your final result in the 72 point size 
and progress onto the next step. 

Center button 
Selected 

Insertion Point 

HOME TAB / FONT GROUP 

A. Font Selector (shows current font) 
B. Font Size Selector (shows current size) 
C. Increase Font  
D. Decrease Font 
E. Change Case 
F. Clear all Formatting 
G. Bold 
H. Italic 
I. Underline 
J. Strikethrough 
K. Subscript 
L. Superscript 
M. Text Effects 
N. Text Highlighter 
O.  

The text to be 
formatted is 

selected. 
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CHANGE FONT OF SELECTED TEXT 

The default theme font for headings is Calibri Light and for all other text 
called body text in Word, is Calibri.  Many other fonts are available, 
however, so that you can add variety to documents.  The following steps 
change the font of the headline from Calibri to Berlin Sans FB Demi.  Why? 
To draw more attention to the headline, you change its font so that it differs 
from the font of other text in the flyer. 

Step 1. Check to make sure the Home ribbon 
band is in view.  Click the Home tab if 
necessary.  

Step 2. If the word “Adventure!” is still selected, 
you can proceed to the next step. If not, 
triple-click Adventure! to select the 
entire paragraph 

Step 3. If necessary, scroll through the Font 
gallery to display Berlin Sans FB Demi 
(or similar font). 

Step 4. If you are using a mouse, Click on Berlin 
Sans FB Demi (or a similar font 

Experiment – Point your mouse to various fonts in the Font gallery and watch the font of the selected text 
change in the document window.  When you have finished, keep your result in the Berlin Sans Demi (or a 
similar font) that you have chosen.  

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

  

Pointer on Berlin 
Sans FB Demi 

Font of selected text 
changes to Berlin Sans 
FB Demi, showing live 
preview of font to which 
you are pointing in the 
gallery 
 
Note: When you are 
using live view, the 
selection of the text 
disappears temporarily. 
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CHANGE THE CASE OF SELECTED TEXT 

The headline currently shows the first letting each word capitalized, which sometimes is referred to as 
initial cap.  The following steps change the headline to uppercase.  Why? To draw more attention to the 
headline, you would like the entire line of text to be capitalized, or in uppercase letters. 

Step 1. With the text selected, tap or click the Change Case button (HOME tab| Font group) to display 
the Change Case gallery. 

Step 2. Tap or click UPPERCASE in the Change Case gallery to change the case of the selected text. 

APPLY TEXT EFFECTS TO SELECTED TEXT 

Word provides many text effects to add interest and variety to text.  The following steps apply a text effect 
to the headline.  Why? You would like the text in the headline to be even more noticeable. 

Step 3. With the text selected, tap or Click the ‘Text Effects and Topography’ button (HOME tab | 
Font group) to display the Text Effects and topography gallery. 

Step 4. If you are using a mouse, point to Fill-White, Outline: Blue, Accent color 1; Glow: Accent 
color 1 (fourth text effect in second row) to display a live preview of the selected text in the 
selected text effect. 

Experiment – If you are using a mouse, point to various text effects in the Text Effects and Typography 
gallery and watch the text effects of the selected text change in the document window.  Return to the 
desired effect listed in step 38. 

Step 5. Click ‘Fill-White, Outline: Blue, Accent color 1; Glow: Accent color 1’ to change the text 
effect of the selected text 

Step 6. Click anywhere in the document window to remove the selection from the selected text. 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 
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SHADE A PARAGRAPH 

When you shade text, Word colors the rectangular area behind any text or graphics.  If the text to shade 
is a paragraph, Word shades the area from the left margin to the right margin of the current paragraph.  
To shade a paragraph, place the insertion point in the paragraph.  To shade any other text, you must first 
select the text to be shaded.  

This flyer uses green as the shading color for the headline.  Why? To make the headline of the flyer more 
eye-catching, you shade it.  The following steps shade a paragraph. 

Step 1. Click somewhere in the paragraph to be shaded (in this case the headline, ADVENTURE!) to 
position the insertion point in the paragraph to be formatted. 

Step 2. Click the Shading arrow (HOME tab | Paragraph group) to display the Shading gallery. 
Step 3. Click ‘Green Accent 6, Darker 25%’ (rightmost color in fifth row) to shad the current paragraph. 
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SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

 

SELECT MULTIPLE LINES 

The next formatting step for the flyer is to increase the font size of the characters between the headline 
and the signature line.  Why? You want this text to be easier to read from a distance. 

To change the font size of the characters in multiple lines you first must 
select all the lines to be formatted.  The following steps select multiple 
lines.  

Step 1. Scroll, if necessary, so that all text below the headline is 
displayed on the screen.  Click your insertion point in front of 
the sentence that starts with the word ‘Explore ….’ 

Step 2. Hold your shift key down and hit your down arrow until you 
have completely highlighted all the lines before the signature 
block. 

Step 3. Release your shift key and arrow button.  Leave your text 
highlighted and follow the steps to format these lines. 

CHANGE THE FONT SIZE OF SELECTED TEXT 

The characters between the headline and the 
signature line in the flyer currently are 11 point. To 
make them easier to read from a distance, this flyer 
users a 24-pont font size for characters.   

Step 4. With the text selected, tap or click the Font 
Size arrow (HOME tab | Font group) to 
display the Font size gallery 

Step 5. Tap or click 24 in the Font Size gallery to 
increase the font size of the selected text.  

Step 6. Tap or click anywhere in the document 
window to remove the selection from the 
text. 

Step 7. If necessary, scroll so that you can see all 
the resized text on the screen. 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

 

The text to be 
formatted is 

selected. 
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BULLET A LIST OF PARAGRAPHS 

A bulleted list is a series of paragraphs, each beginning with a bullet 
character. The next step is to format the three paragraphs about the 
tours that are above the signature line in the flyer as a bulleted list. 

To format a list of paragraphs with bullets, you first must select all the lines in 
the paragraphs.  Why? If you do not select all paragraphs, Word will place a 
bullet only in the paragraph containing the insertion point. 

Step 1. Click your insertion point in front of the 
word ‘Self-guided’. 

Step 2. Hold down your shift key and tap your 
down arrow until you have selected all 
three lines of text to be formatted with 
bullets 

Step 3. Tap or click the Bullets button (HOME tab | Paragraph 
group) to place a bullet character at the beginning of each 
selected paragraph. 

UNDO AND REDO ACTION 

Word provides a means of canceling your recent command (s) or 
action (s).  For example if you format text incorrectly, you can undo the 
format and try it again.  When you point to the Undo button, Word 
displays the action you can undo as part of a Screen Tip. 

If, after you undo an action, you decide you did not want to perform the 
undo, you can redo the undone action. Word does not allow you to 
undo or redo some actions, such as saving or printing a document.  
The following steps undo the bullet format just applied and then redo 
the bullet format.  Why?  These steps illustrate the undo and redo 
actions. 

Step 4. Tap or click the Undo button on the Quick Access Toolbar 
to reverse your most recent action (in this case, remove the bullets from the paragraphs). 

Step 5. Tap or click the Redo button on the Quick Access Toolbar to reverse your most recent undo (in 
this case, place a bullet character on the paragraphs again) 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

  

Font size changed to 
24 point 

The three 
paragraphs to be 

formatted with 
bullets are selected 
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ITALICIZE TEXT 

The next step is to italicize the word, breathtaking, in the flyer to further emphasize it.  As with a single 
paragraph, if you want to format a single word, you do not need to select it.   

Step 1. Tap or Click somewhere in the word to be italicized (breathtaking, in this case) to position 
the insertion point in the word to be formatted 

Step 2. Tap or Click the Italic button (HOME tab | Font group) to italicize the word containing the 
insertion point. 

Step 3. Tap or Click ‘Orange, Accent 2, Darker 25% (sixth color in fifth row) to change the color of the 
text. 

Step 4. Select the last sentence in the flyer. 
Step 5. Tap or Click the font size arrow to 

display the Font Size Gallery.  Choose 
28 for the for the new font size for the 
last sentence 

Step 6. With the sentences selected, change 
the font color to Orange, Accent 2, 
Darker 25% 

Step 7. Click Center to center the last line on 
vertically on the page.  

Step 8. Select the telephone number in the 
last line of text. 

Step 9. With the text selected, tap or Click the 
Underline button (HOME tab| Font 
group) to underline the selected text. 
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BOLD TEXT 

Bold characters appear somewhat thicker and darker than those 
that are not bold.  

Step 10. Select the text to be formatted (the text, off road, in this 
case) 

Step 11. With the text selected, tap or click the Bold button 
(HOME tab| Font group) to bold the selected text 

Step 12. Tap or click anywhere in the document window to 
remove the selection from the screen. 

TO ZOOM ONE PAGE  

Step 13. Tap or click VIEW on the 
ribbon to display the VIEW 
tab 

Step 14. Tap or click the One 
Page button (VIEW tab| 
Zoom group) to display 
the entire page in the 
document window as 
large as possible.  

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

CHANGE THEME COLORS 

A color scheme in Word is a document theme that identifies 12 complementary colors of text, 
background, accents, and links in a document.  With more than 20 predefined color schemes, Word 
provides a simple way to coordinate colors in a document. 

The default color scheme is called Office.  In the flyer, you will change the color scheme from Office to 
Green. Why? You want the colors in the flyer to suggest growth, harmony, blooming, trust, and stability, 
which are conveyed by shades of 
greens and blues.  In Word, the 
green color scheme uses these 
colors. 

Step 1. Tap or Click DESIGN on 
the ribbon to display the 
DESIGN tab. 

Step 2. Tap or Click the Theme 
Colors button (DESIGN 
tab | Document Formatting 
group) to display the 
Theme Colors Gallery 
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Step 3. Point to the Green in the Theme Colors gallery to display a live preview of the selected theme 
color. 

Experiment – Point your mouse to various color schemes in the Theme Colors gallery and watch the colors 
change in the document. 

Step 4. Click the Green in the Colors gallery to change the document theme colors. 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

INSERT AND FORMAT A PICTURE 

The next step is to insert a digital picture into the 
flyer then reduce its size. 

Step 1. Position the insertion point at the 
location where you want to insert the 
picture (in this case, on the centered 
blank paragraph below the headline). 

Step 2. Click INSERT on the ribbon to display 
the INSERT tab 

Step 3. Click the From File button (INSERT tab | illustrations group). 
Step 4. Click Pictures. Navigate to you documents folder. 
Step 5. In your UNIT 04 folder, you will find a folder called “UNIT 04 Student Files” this folder contains 

the image you need to complete this part of the activity. 
Step 6. After you have opened the folder, Insert the picture called Adventure Flyer. 
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SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

RESIZE THE GRAPHIC 

Resizing includes both increasing and reducing the 
size of a graphic. The next step is to resize the 
picture so that it is the desired size for the flyer. 

 

Step 1. Be sure the graphic is still selected. Click 
on the Picture 

Step 2. You will note when the picture is selected, 
the PICTURE TOOLS| FORMAT tab 
appears.  Click on PICTURE TOOLS| 
FORMAT 

Step 3. Click right-hand corner of the size 
group to display the size dialog box 

Step 4. Deselect the option to Lock Aspect Ratio.  This is a toggle (The term toggle implies that there 
are only two possible settings and that you are 
switching from the current setting to the other 
setting.).  Refer to the illustration.  The Lock Aspect 
Ratio should not be checked.  

Step 5. Change the size to 3.26” x 5.04” 

What is Aspect Ratio? The aspect ratio of an image is 
the ratio of the width of the image to its height, expressed 
as two numbers separated by a colon. That is, for an x:y 
aspect ratio, no matter how big or small the image is, if the 
width is divided into x units of equal length and the height 
is measured using this same length unit, the height will be 
measured to be y units. For example, consider a group of 
images, all with an aspect ratio of 16:9. One image is 16 
inches wide and 9 inches high. Another image is 16 
centimeters wide and 9 centimeters high. A third is 8 
yards wide and 4.5 yards high. 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 
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APPLY PICTURE STYLE 

A style is a named group of formatting characteristics Word provides more than 25 picture styles.   

Step 1. With the picture selected, tap or Click PICTURE TOOLS FORMAT on the ribbon to display the 
PICTURE TOOLS FORMAT tab| Picture Styles group. 

Step 2. Point to ‘Drop Shadow Rectangle’ in the Picture Styles gallery to display a live preview of 
the style applied to the picture in the document.   

Experiment – Point to various picture styles in the Picture Styles gallery and watch the style of the 
picture change in the document window.   

Step 3. Click the ‘Drop Shadow Rectangle’ in the Picture Styles gallery (fourth style in first row) to 
apply the style to the selected picture. 

 

APPLY PICTURE EFFECTS 

Word provides a variety of picture effects, such as shadows, reflections, glow, soft edges, bevel and 3-D 
rotation.  The difference between the effects and styles is that each effect has several options, providing 
you with more control over the exact look of the image. 

Picture Effects 
Button 
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Step 4. With the picture still 
selected, tap or Click the 
Picture Effects button 
(PICTURE TOOLS 
FORMAT tab| Picture 
Styles group) to display 
the Picture Effects menu.  

Step 5. Tap or Point to Glow on 
the Picture Effects menu 
to display the Glow 
gallery. 

Step 6. If you are using a 
mouse, Point to 
‘Turquoise, 5pt glow, 
Accent color 6’ in the 
Glow variations area 
(rightmost glow in the 
first row) to display a live 
preview of the selected 
glow effect applied to the 
picture in the document window.  

Experiment – Point to various glow effects in the Glow gallery 
and watch the picture change in the document window.  

Step 7. Click ‘Turquoise, 5 pt. glow, Accent color 6’ in the 
Glow gallery to apply the selected picture effect. 

Step 8. Click the Picture Effects button (PICTURE TOOLS 
FORMAT tab | Picture Styles group) to display the 
Picture Effects menu again. 

Step 9. Point to Bevel on the Picture Effects menu to display 
the Bevel gallery 

Step 10. Point to Angle in the Bevel area (first effect in second 
row) to display a live preview of the selected bevel 
effect applied to the picture in the document window. 

Experiment – Point to various bevel effects in the Bevel gallery and watch the picture change in the 
document window.  

Step 11. Click Angle in the Bevel gallery to apply the selected picture effect.  

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

 

ADD A PAGE BORDER 
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In Word you can add a border around the perimeter of an entire page.  We have chosen a light green 
border to complement the flyer. These are the steps to add the page border. 

Step 1. Click DESIGN to display the DESIGN ribbon. 
Step 2. Click the Page Borders in the Page Background group

 
Step 3. Choose the drop-down menu for the Color 
Step 4. Click ‘Turquoise, Accent 6, Darker 25%’ (fifth color in the turquoise column) in the Color 

palette to select the color for the page border.
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Step 5. Click the Width arrow to display the Width 
list 

Step 6. Click 1 ½ pt. to select the thickness of the 
page border. 

Step 7. Scroll through the Style option to choose 
the desired line style 

Step 8. Click the broken dashed line 
Step 9. Click the OK button to add the border to the 

page. 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your 
updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you 
from losing your work. 

SUBMIT ASSIGNMENT: 

u04a1 Adventure Flyer 

 

ON YOUR OWN ACTIVITY 

For this activity, you will be creating a flyer to promote the Gulliver’s Travel Agency.  You may need to 
reference the lessons presented in the tutorial portion of Unit 04.  All the same principles used in the unit 
are applied to this activity.  

Step 1. Open a New Word document 
Step 2. Use the verification steps to Verify the document settings are correct 
Step 3. Save as your file as  u04a2 Spring Break Flyer 
Step 4. Change the Theme to ION 
Step 5. Type the following HEADLINE: Spring Break 
Step 6. Hit ENTER 
Step 7. TYPE the SECOND HEADLINE: Party Packages 
Step 8. Hit ENTER, ENTER 
Step 9. TYPE the COMPANY NAME:  Gulliver’s Travel 
Step 10. Hit ENTER 
Step 11. TYPE the COMPANY ADDRESS: 758 Grant Street in Mulberry 
Step 12. Hit ENTER 
Step 13. TYPE the LINE 1: Packages include airfare, rental car, 

accommodations, and dining 
Step 14. Hit ENTER 
Step 15. TYPE the LINE 2:  Discounted attraction tickets 
Step 16. Hit ENTER 
Step 17. TYPE the LINE 3: Destinations around the country 
Step 18. Hit ENTER 
Step 19. TYPE the LINE 4: Fund-raising tools for you to use on Facebook, 

Twitter or via email 
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Step 20. Hit ENTER 
Step 21. TYPE the SIGNATURE LINE: Call us at 715-588-7500 or stop by today! 
Step 22. CLICK HOME to view the Home ribbon 
Step 23. TRIPLE-CLICK the HEADLINE to select the entire paragraph 

a. CENTER the TEXT 
b. Change the FONT to BROADWAY 
c. Font SIZE to 48 
d. Fill: Blue-Gray, Accent color 5; Outline: White, Background color 1; hard 

Shadow: Blue-Gray, Accent color 5 
Step 24. TRIPPLE-CLICK the SECOND HEADLINE to select the entire paragraph 

a. CENTER the TEXT 
b. Change the FONT to ARIAL ROUNDED MT BOLD 
c. Font SIZE to 28 
d. In the Paragraph group, SHADING:  PURPLE, ACCENT 6, LIGHTER 40% 
e. Set the FONT COLOR: WHITE, BACKGROUND 1 

Step 25. Select COMPANY NAME 
Step 26. CLICK Line Spacing in the Paragraph Group 
Step 27. CLICK Remove Space After 
Step 28. CENTER the COMPANY NAME and COMPANY ADDRESS 
Step 29. HIGHLIGHT the text containing COMPANY NAME, ADDRESS AND LINES 1-4 
Step 30. CHANGE THE FONT of the highlighted text to Arial Rounded MT Bold. 
Step 31. FONT SIZES: 

a. COMPANY NAME:  28 points 
b. COMPANY ADDRESS: 24 points 
c. LINES 1-4, & SIGNATURE: 22 points 

Step 32. Select LINES 1-4 
Step 33. In the paragraph group, CLICK the BULLETS option. You should have 4 bulleted lines of 

text. 
Step 34. Change the TEXT COLOR for COMPANY NAME and ADDRESS to BLUE-GREY, 

ACCENT 5, DARKER 25% 
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Step 35. UNDERLINE the COMPANY NAME 
Step 36. In LINE 1 of the bulleted text, ITALICIZE the word 

AND 
Step 37. In LINE 2 of the bulleted text, BOLD the word 

DISCOUNTED. Change the color of the word to 
PURPLE, ACCENT 6, DARKER 25% 

Step 38. TRIPLE-CLICK the SIGNATURE LINE to select 
the entire paragraph 
a. Use the shading option in the Paragraph 

group to SHADE the SIGNATURE LINE: 
PURPLE, ACCENT 6, LIGHTER 40% 

b. CENTER the SIGNATURE LINE 
c. Set the FONT COLOR: WHITE, 

BACKGROUND 1 
Step 39. ZOOM to view the entire page of the document 
Step 40. On the blank line after the second heading, 

INSERT PICTURES (Both images are in the UNIT 
04 Student Files.):  
a. SPRING BREAK-FLORIDA 
b. SPRING-BREAK NEW YORK 

Step 41. CHANGE FLORIDA IMAGE: 
a. SIZE: 2.4” X 3” 
b. FRAME: SIMPLE FRAME, WHITE 
c. PICTURE EFFECTS: 3-D ROTATION 
d. PERSPECTIVE: RIGHT 
e. WRAP: TIGHT 

Step 42. CHANGE NEW YORK IMAGE: 
a. SIZE: 2.4” X 3” 
b. FRAME: SIMPLE FRAME, WHITE 
c. ROTATION: 3-D ROTATION 
d. PERSPECTIVE: LEFT 
e. WRAP: TIGHT 

Step 43. PLACE THE IMAGES on the same line under the second headline 
Step 44. In the line spacing option, the SPACING BEFORE the SIGNATURE LINE should be 

12 pts.  
Step 45. PAGE BORDER: 

a. STYLE: THICK AND THIN LINE 
b. COLOR: PURPLE, ACCENT 6 
c. WIDTH: 6 pts.  

Step 46. Save your work and submit the file to the u04a2 assignment area.  
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UNIT 05 CREATE A BUSINESS LETTER WITH LETTERHEAD AND TABLE 

In this unit, your will learn how to create a block style letter and then modify it to modified block style.  The 
following roadmap identifies general activities you will perform as ou progress through the unit: 

 CREATE AND FORMAT a LETTERHEAD WITH GRAPHICS 
 SPECIFY the LETTER FORMATS according to Business letter guidelines 
 INSERT a TABLE in the letter 
 FORMAT the TABLE in the letter 
 INSERT a BULLETTED LIST in the letter 
 ADDRESS an ENVELOPE for the Letter 

VERIFY THE DOCUMENT SETTINGS 
Before you start, double check your Word settings to make sure they have not been modified. 

Step 1. Open a blank Word document (File > New) 
Step 2. Click the Layout tab  
Step 3. In the Page Setup group, click Margins 
Step 4. In the dropdown menu click on the NORMAL 

option.  This will set your margins at 1” on all 
sides. 

SAVE THE FILE 
Step 5. Now that the margins are set, you should save 

your file. An easy saving method is to use your CTRL key with the letter S.  In a new 
document, if you hold down CTRL and hit the letter S, you will receive a Save As dialog 
box. 

Step 6. Click on the Browse option and navigate to your folders for this class. In the illustration 
my folder is in School\Cuesta\Credit Courses\CIS-AGB 210\CIS 210 UNITS\ UNIT-05

 
Step 7. In the section marked File name, type your file name as: 

u05a1 Letterhead  
Step 8. Click Save.  You will see the new file name appear in the title bar of your document. 
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INSERT A SHAPE 
Word has a variety of predefined shapes, which are a type of drawing object, that you can insert in 
documents.  A drawing object is a graphic that you can create using Word.  Examples of shape drawing 
objects include rectangles, circles, triangles, arrows, flowcharting symbols, stars, banners, and callouts 
(Freund, et al., 2017).   

Use the following steps to insert a rectangle shape in the letterhead: 

Step 1. CLICK INSERT to display the Insert ribbon band. 
Step 2. In the Illustrations group, CLICK the drop-down arrow 

head next to SHAPES 
Step 3. CLICK the RECTANGLE SHAPE. The shape gallery 

will then disappear. Your pointer changes to a plus. 
Step 4. Use the NEW POINTER to DRAG THE MOUSE to the 

RIGHT and DOWNWARD 
Step 5. RELEASE THE MOUSE. Your shape should now 

show on your document.  

ADJUST THE SHAPE SIZE 

Step 6. SELECT the SHAPE you have created.  You will see sizing handles around the shape 
when it is selected.  

Step 7. With the shape selected, CLICK the DRAWING TOOLS to display the FORMAT options. 
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Step 8. In the Size group, change the HEIGHT .53” and the WIDTH 5.7” 

Step 9. After the shape size has been set, RELEASE the MOUSE  
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CHANGE THE POSITION OF THE OBJECT 

Step 10. With the shape still selected, change the position 
of the shape.  CLICK POSITION in the Arrange 
group.  

Step 11. In the With Text Wrapping option, change the 
position to center.  CLICK TEXT WRAP CENTER 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by 
simply holding down the CRTL key and taping the S key.  This is a 
good habit and keeps you from losing your work. 

CHANGE A SHAPE 
APPLY SHAPE STYLE 

Quick Styles let you apply a style to your 
shape with one click. You'll find the styles in 
the Quick Style gallery. When you rest your 
pointer over a Quick Style thumbnail, you 
can see how the style affects your shape. 

Step 1. SELECT the SHAPE 
Step 2. In the Drawing tools Shape 

Styles group, CLICK the 
MORE option in the gallery.  

Step 3. In the Theme Styles 
Gallery, choose Moderate 
Effect – Grey 50%, 
Accent 3 

ADD TEXT TO A SHAPE 

Step 4. RIGHT-CLICK the SHAPE 
to display a mini toolbar 
and/or shortcut menu 

Step 5. CLICK ADD TEXT  
Step 6. Type Village of Apple Park 
Step 7. Increase the FONT size to 26. 
Step 8. Emphasize the font- CLICK BOLD 

CHANGE THE THEME 

Step 9. CLICK on DESIGN to display the Design ribbon. 
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Step 10. CHANGE the THEME to CIRCUIT. Note that the color for the shape is now an apple red.
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SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply 
holding down the CRTL key and taping the S key.  This is a good habit 
and keeps you from losing your work. 

 

INSERT A PICTURE  
The image you will be using for this letterhead is an apple that has been 
provided for you in your UNIT 05 Student Files.  Please follow these 
instructions to insert the picture into your document: 

Step 1. CLICK the INSERT tab to display the Insert ribbon 
Step 2. In the Illustrations group, CLICK PICTURES 
Step 3. BROWSE your computer until you see the UNIT 05 

Student Files 
Step 4. CLICK apple-02.wmf.  This file is the type of file that is easy to alter.  It is important you 

use the file from the UNIT 05 Student files for this activity.  
Step 5. CLICK INSERT 

 

CHANGE THE COLOR OF A GRAPHIC 

We will be eventually resizing the apple graphic but before we do so, we are going to change some of the 
background properties by following these instructions: 

Step 6. Select the apple graphic that was just inserted into the text.  CLICK the PICTURE 
TOOLS option that appears when your graphic is selected.  

Step 7. From the Picture Tools Format menu, CLICK COLOR from the Adjust group.  



  

~ 92 ~ 

 

Step 8. CLICK 
WASHOUT to 
change the color 
of the picture  

Step 9. With the graphic 
still selected, 
CLICK the 
COLOR option 
again.  

Step 10. On the bottom left 
corner of the color 
option, you will 
see an option 
called Set 
Transparent Color. 
CLICK on SET 
TRANSPARENT 
COLOR 

Step 11. After you choose 
the transparent 
color option, you 
will notice your 
mouse turns into a 
pencil with a 
triangle in the 
bottom.  Use the 
new pointer to 
CLICK on the 
BACKGROUND. The background around the apple is now transparent.  

ADJUST THE BRIGHTNESS, CONTRAST AND SIZE OF A GRAPHIC 

Step 12. With the graphic still selected, CLICK 
CORRECTIONS on the Picture Tools Format 
menu.   

Step 13. CLICK BRIGHTNESS: -20% CONTRAST: -20% 
Step 14. If needed select the graphic again.  In the SIZE 

group of the Picture Tools Format option enter the 
HEIGHT .53” WIDTH .53”  

Step 15. RIGHT-CLICK the apple graphic after it has been 
sized and CLICK COPY 

Step 16. RIGHT-CLICK PASTE the copy of the apple with the background removed and the color 
changed. 

Step 17. CLICK the new copy of the APPLE to select it.   
Step 18. In the picture tools menu, navigate to the Arrange group.  CLICK the DROP-DOWN 

MENU under ROTATE OBJECTS 
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Step 19. CLICK FLIP HORIZONTAL.  You should now have two apples without any background, 
facing opposite directions.

 

CHANGE THE BORDER COLOR ON A GRAPHIC 

Step 20. With the apple graphic selected, CLICK the PICTURE TOOLS: FORMAT tab 
Step 21. In the picture styles group, CLICK PICTURE BORDER to display the drop-down menu 
Step 22. CLICK on LIME, ACCENT 1, DARKER 25% 

Step 23. The apply now has a lime green border around the picture.  RIGHT-CLICK on the 
APPLE WITH THE BORDER and select your FORMAT PAINTER 

Step 24. CLICK on the APPLE WITHOUT THE BORDER with your FORMAT PAINTER.  You 
should now have two apples with a border.   

Step 25. Change the WRAP on each APPLE to TIGHT 
Step 26. PLACE each apple on the ENDS of the SHAPE you created. You can do this by clicking 

on the graphic and placing it on the end of the shape. 
Step 27. CLICK on the SHAPE.  You can easily align the shape with the apples with your arrow 

keys.  Try nudging it into place. 
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SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

 

COPY AND PASTE GROUPED IMAGES 
Step 1. Once the apples are placed in alignment with the shape, select each of the 3 images. 

HOLD DOWN your SHIFT KEY and CLICK ON EACH IMAGE. The images should have 
selection marks around every graphic.   

Step 2. CLICK PICTURE TOOLS 
Step 3. In the arrange group, CLICK GROUP. Grouping lets you rotate, flip, move, or resize all 

shapes or objects at the same time as though they were a single shape or object. You 
can also change the attributes of all the shapes at one time. You can ungroup a group of 
shapes at any time and then regroup them later.  

CUT AND PASTE THE GROUP 

Step 4. CLICK on the HOME tab to reveal the home ribbon 
Step 5. CLICK the GROUPED IMAGE.  The selection should look like the following illustration: 

Step 6. In the clipboard group, CLICK CUT (represented with a pair of scissors). You have not 
lost your work.  This removes the grouped graphic from the page and places it in the 
clipboard.   

PLACE THE GRAPHIC IN THE HEADER 

Step 7. CLICK on the INSERT tab to reveal the insert ribbon 
Step 8. CLICK on the HEADER option in the Header & Footer group 
Step 9. CLICK EDIT HEADER 
Step 10. RIGHT-CLICK your MOUSE inside the header 
Step 11. CLICK PASTE.  Select the first paste option (use destination theme) 
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Step 12. CLICK on the GROUPED GRAPHIC to select it again. 
Step 13. You should MOVE the GRAPHIC to the desired location.  Keep in mind most printers will 

allow at least .25 inch from the top of the paper.  Once the graphic is selected, you can 
move it using your arrow keys or your mouse.  The following image illustrates an example 
moved inside the header before the header is closed: 

TYPE THE ADDRESS 
Step 1. CLICK the GROUPED GRAPHIC 
Step 2. In the PICTURE TOOLS menu, CLICK WRAP TEXT 
Step 3. CLICK the TOP AND BOTTOM option. 
Step 4. CLICK CENTER to center the text 
Step 5. Your cursor should appear below the graphic.  If it does not, you should hit enter.  From 

the HOME tab change the settings to the following: 
a. FONT SIZE 12. 
b. Align the text CENTER 

Step 6. Type 15 Center Street, Horizon, MT 35568 
Step 7. Enter a SPACE after the zip code 

INSERT A SYMBOL 

Step 8. CLICK the INSERT tab to open the Insert ribbon 
Step 9. In the Symbols group CLICK SYMBOL 
Step 10. CLICK MORE SYMBOLS . . .  

a. FONT: Wingdings 2 
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b. CLICK TRAIANGE WITH A SQUARE (refer to the graphic illustration)

 
c. CLICK INSERT to insert the symbol in the address. CLOSE the menu. 

Step 11. HIT SPACE 
Step 12. Type Phone: (802) 555-7896 
Step 13. HIT SPACE  
Step 14. INSERT ANOTHER SYMBOL (same as the first symbol). Since it was the last symbol 

you used, it will be first on the list.  
Step 15. Type Email: apple@applep.com 

REMOVE HYPERLINK 

Step 16. When you type the email address, it will automatically become a hyperlink.  RIGHT-
CLICK the EMAIL ADDRESS. 

Step 17. CLICK REMOVE HYPERLINK
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ADD PARAGRAPH UNDERLINE 

Step 1. CLICK  in the paragraph to be underlined (the address line). 
Step 2. Click the Borders and Shading Option (HOME tab | Paragraph group) to display the  

gallery  

Step 3. SELECT the BOTTOM BORDER option.  Address should now have an underline that 
extends the full length of the paragraph.  

 

Step 4. Using the Header & Footer tools menu, CLOSE the HEADER.   The letterhead will 
appear faded because it is in the header; however, it does not print faded.  You can test it 
with a print preview.  A copy of the finished letterhead as it appears in Word is below:
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SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

SUBMIT ASSIGNMENT: 

u05a1 Letterhead 

BUSINESS LETTERS (BLOCK AND MODIFIED BLOCK STYLES) 

Block Format 

Block format features all elements of the letter aligned to the left margin of the page. It has a neat and 
simple appearance. Paragraphs are separated by a double line space. 

Modified Block Format 

Modified block differs from block style in that the date, sign off, and signature lines begin at the center 
point of the page line. Depending on the length of the letter, paragraphs may be separated by a single- or 
double-line space. 

The following instructions are for a Block Style Letter:  

Step 1. OPEN u05a1 Letterhead.  If you saved it properly it is in your UNIT 05 folder.  
Step 2. CLICK FILE SAVE AS  
Step 3. Because the file was saved in the UNIT 05 folder, the save as location will also be 

UNIT O5  
Step 4. Type u05a2 Letter as the filename 
Step 5. CLICK SAVE

 

The letterhead usually takes up to 1-1.25 inch from the top edge of the paper. The first line of the letter 
should be the date.  The dateline for a large letter starts 1.5 inches from the top of the page. A short (1-
page letter) often takes less space.   To eliminate a large white space after the signature line, you can go 
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down the page as much as 3 inches from the top to start the dateline.  For this exercise, we will start our 
letter at the 2-inch mark. Follow these steps: 

Step 6. RIGHT-CLICK the STATUS BAR at the bottom of the 
page 

Step 7. In the Customize Status Bar menu, CLICK VERTICAL 
PAGE POSITION to select the option.  You should see 
the position of your cursor displayed on the status bar. 

Step 8. HIT ENTER UNTIL the STATUS BAR indicates AT 2” 
(2.1” is acceptable as well) 

Step 9. CLICK INSERT to display the Insert ribbon 
Step 10. In the text group, CLICK DATE AND TIME. You will 

see a list of date formats. 
Step 11. SELECT OPTION 3 (Month Day, Year). Your date will 

be automatically entered in the document. 
Step 12. HIT ENTER ENTER on your keyboard after the date 

Step 13. Type Ms. Tamara Lee 
Step 14.  HIT ENTER  

Step 15. Type Tam’s Artistic Designs 
Step 16. HIT ENTER 

Step 17. Type 1587 Willow Road 
Step 18. HIT ENTER 

Step 19. Type Juniper, MT 33522 
Step 20. HIT ENTER 

Step 21. Type Dear Ms. Lee: 
Step 22. HIT ENTER 

Step 23. Type The park district board has 
approved the vendor application for your business, 
Tam’s Artistic Designs. Your check for $150 for a 10 
x 20 booth has been deposited, and we are excited 
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that you will be participating in our Fall Festival. 
The table below outlines the timetable for vendors: 

Step 24. HIT ENTER 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 
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INSERT AND CREATE A TABLE 
Step 1. CLICK INSERT to display the insert ribbon 
Step 2. CLICK TABLE 
Step 3. CLICK INSERT TABLE 

a. NUMBER OF COLUMNS: 3 

b. NUMBER OF ROWS: 6 
Step 4. CLICK OK 
Step 5. The columns of the table are represented by letters 

and the rows by numbers.  This illustration helps to 
visualize the references:  

 

a. Column A, Row 1 (CELL A1): Vendor Time Table. After you enter 
the information in each cell, hit your tab key to advance to the next cell.  

b. Column A, Row 2 (CELL A2): Activity 
c. Column B, Row 2 (CELL B2): Event Dates 
d. Column C, Row 2 (CELL C2): Times 
e. CELL A3: Booth Setup 
f. CELL B3: Friday, October 27 
g. CELL C3: 5:00 to 9:00 p.m. 
h. CELL A4: Booth Sales 
i. CELL B4: Saturday, October 28 
j. CELL C4: 9:00 a.m. to 6:00 p.m.  
k. CELL A5: Booth Sales 

l. CELL B5: Sunday, October 29 

m. CELL C5: 9:00 a.m. to 3:00 p.m. 
n. CELL A6: Booth Takedown 

o. CELL B6: Sunday, October 29 
p. CELL C6: 3:00 to 7:00 p.m. 
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Step 6. Select anywhere inside the table to activate the Table 
Tools options.  In the Table Tools menu, CLICK 
DESIGN 

Step 7. In the Table Styles group select the More option to display 
the many table styles available.  In the Grid Tables group 
choose Grid Table 6 Colorful-Accent 3 

 

Step 8. In the Table Style Options, SELECT HEADER ROW and BANDED ROWS.  Your 
table will look like the following illustration: 

Step 9. With the insertion point in the table, CLICK LAYOUT in the Table Tools menu. 

Step 10. In the Cell Size group, CLICK the AUTOFIT option 
Step 11. In the drop-down menu CLICK the AUTOFIT CONTENTS option.  Word will 

automatically adjust the cell size to fit the contents of the cell.  
Step 12. In the Table group, CLICK the PROPERTIES option. 
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Step 13. CLICK the TABLE tab in the PROPERTIES menu

 
Step 14. CLICK the CENTER option to center the table in the letter.  
Step 15. CLICK OK 
Step 16. SELECT ROW 2 by highlighting all the contents of the cells A2, B2, and C2 
Step 17. CLICK BOLD 
Step 18. SELECT COLUMN C by clicking above the column.  You will get an arrow.  When you 

click, it selects the entire column. 

 
Step 19. RIGHT-CLICK your mouse to display 

the short-cut menu  
Step 20. CLICK CENTER to center the text in 

column C 
Step 21. SELECT ROW 1 by highlighting all 

the contents of the cells A1, B1, and 
C1 

Step 22. RIGHT-CLICK your mouse to display 
the shortcut menu 

Step 23. CLICK MERGE CELLS 
Step 24. Hold down your CTRL key and TAP 

your END. Your cursor should now be 
in the blank space below the table.  

Step 25. HIT ENTER  

Step 26. Type Please note the 
following vendor 
guidelines: 

Step 27. CLICK ENTER 
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SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

 

ADD BULLETED LIST 
Step 1. HIT ENTER after the colon in the sentence describing the list.    
Step 2. CLICK HOME to display the home ribbon. If you show/hide option is still showing, you 

may prefer to turn it off by clicking it again.  
Step 3. CLICK BULLETS 
Step 4. Type Vendors must bring their own tables and chairs. 
Step 5. HIT ENTER 

Step 6. Type Vendors must supply their own electrical cords. 
Step 7. HIT ENTER 

Step 8. Type Vendors shall comply with fire, safety, and 
health regulations. 

Step 9. HIT ENTER 
Step 10. CLICK the BULLET option again to turn bullets off. 

Step 11. Type We also request that all vendors donate one 
item from their booth to our fundraising efforts. We 
look forward to your business, Tam’s Artistic 
Designs, taking part in our event. Please contact 
me if you need additional information. 

Step 12. CLICK ENTER 
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Step 13. Type Sincerely,  
Step 14. CLICK ENTER ENTER 

Step 15. Type Your Name 
Step 16. HIT ENTER 

Step 17. Type Park District Events Coordinator

 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 
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ADJUST THE SPACING 
Step 1. INISIDE ADDRESS: Select the first 3 lines of the inside address. DO NOT select the City, 

State line. CLICK LINE AND PARAGRAPH SPACING in the paragraph group of the 
Home ribbon. 

Step 2. CLICK REMOVE SPACE AFTER 

Step 3. CLICK ANYWHERE IN 
YOUR SIGNATURE LINE 

Step 4. CLICK LINE AND 
PARAGRAPH SPACING 

Step 5. CLICK REMOVE SPACE 
AFTER 

SAVE YOUR UPDATES 

Since the file is already saved you can now save 
your updates by simply holding down the CRTL 
key and taping the S key.  This is a good habit 
and keeps you from losing your work. 
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ATTACH AN ENVELOPE 

Microsoft Office applications are designed with many unique and user-friendly features. These features 
not only allow users to do get things done but do a lot of things simultaneously. For example, you can 
create a professional envelope using the Microsoft Word application. 

For this exercise, we sill be attaching the envelope to the letter.  This is a nice feature but there are a few 
items you should keep in mind. 

 SIZE OF ENVELOPE – Envelopes come in a variety of sizes.  It is important to know the size of 
envelope you are using. 

 PRINTER LIMITS – Some printers may not accommodate printing envelopes.  Others may stop 
printing until the envelope is inserted.  

 ATTACHED TO DOCUMENT – If you have a printer that accommodates envelopes, you should 
know that your printer will prompt you for the envelope and then the letter.  It may take a few test 
runs to print properly.  

Follow these steps to attach your envelope to the document 

Step 1. With your u05a2 letter open, highlight the inside address (including the zip code) 
Step 2. CLICK MAILINGS to reveal the Mailings tool bar 
Step 3. CLICK ENVELOPES in the Create 

Group 
Step 4. The delivery address has been entered 

because you highlighted the inside 
address before you opened the option.  
You may note that the return address is 
blank.  Please type the name and 
address of the company in this area: 

Village of Apple Park 
15 Center Street 
Horizon, MT 35568 

Step 5. CLICK ADD TO DOCUMENT 
Step 6. The next screen will ask if you 

want to save the return address to 
the default return address. CLICK NO 
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SAVE YOUR UPDATES 

Since the file is already saved you can now save your 
updates by simply holding down the CRTL key and taping 
the S key.  This is a good habit and keeps you from losing 
your work. 

SUBMIT ASSIGNMENT: 

u05a2 Letter 

 

 

ON YOUR OWN ACTIVITY 

Step 1. Open a New Word document 
Step 2. Use the verification steps to Verify the document settings are correct 
Step 3. MARGINS: Moderate 

a. TOP/BOTTOM: 1” 
b. LEFT/RIGHT: .75” 

Step 4. Change the THEME to Berlin 
Step 5. Save as your file as u05a3 Rosewood Letter 

CREATE THE LETTERHEAD 

Step 6. Insert a Horizontal Scroll Shape with these specifications: 
a. HEIGHT: 0.74” 
b. WIDTH: 6.32” 
c. POSITION: Top center with square text wrapping 
d. TEXT WRAPPING: Top and Bottom 
e. STYLE: Subtle Effect – Rose Accent 6 

Step 7. Add the following text to the shape: Rosewood Memorial Hospital 
a. FONT: Script MT Bold 
b. SIZE: 28 points 
c. COLOR: Aqua, Accent 4, Darker 50% 
d. ALIGNMENT: Centered 

Step 8. From the UNIT 05 Student files, INSERT johnny-automatic-rose-scroll-800px 
a. COLOR TONE: 4700 K 
b. TEXT WRAPPING: In Front of Text 
c. HEIGHT: 0.45” 
d. WIDTH: 0.33” 

Step 9. COPY ROSE SCROLL GRAPHIC 
Step 10. PASTE INTO DOCUMENT 
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Step 11. MOVE the SCROLLS as shown in the illustration

 
Step 12. GROUP the IMAGES 
Step 13. CUT the GROUP 
Step 14. OPEN the HEADER 
Step 15. PASTE the GROUP INTO THE HEADER 
Step 16. WRAP TEXT TOP AND BOTTOM  
Step 17. Type the company address information.  

a. FONT: 11 points 
b. COLOR: Aqua, Accent 4 Darker 50% 
c. POSITION: CENTER 
d. Between each bit of information (address, phone, email), insert an open 

diamond symbol . 
e. ADDRESS: 9600 Brighton Parkway, Apollo, WY 29642 
f. PHONE: Phone: (212) 555-9600 
g. EMAIL: Email: info@rosewood.net 

Step 18. Remove Hyperlink created after entering the email address 
Step 19. Apply a PARAGRAPH LINE UNDER THE ADDRESS INFORMATION 

a. COLOR: Aqua, Accent 4 Darker 50% 
b. STYLE: Solid 
c. WIDTH: ½ point 

Step 20. Preview in the PRINT PREVIEW.  Because the item in the header appears 
faded, you need to perform a print preview to view the correct color 
specifications.  

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 
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CREATE THE LETTER 

The letter should appear with the following information in block style: 

 

TABLE SPECIFICATIONS 

Step 1. STYLE: Grid Table 5 Dark-Accent 4 
Step 2. OPTIONS: Header Row and Banded Rows 
Step 3. ROW 2: Bold 
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Step 4. COLUMN C: Center 

LAST SENTENCE SPECIFICATIONS 

Step 1. REMOVE HYPERLINK for the email address 
Step 2. USE NONBREAKING HYPHENS in the phone number. This will keep the phone 

number from splitting. 

A nonbreaking hyphen is not really a hyphen; rather, it is a command not to hyphenate. When placed in 
front of a word or a group of characters acting as a word, such as a phone number, web address or email 
address, that word will not be hyphenated. This is helpful not only in text, but also in headlines that you 
don’t want to break onto two lines. 

NONBREAKING HYPHEN COMMAND MICROSOFT® WORD 
• Command (Mac) or control (PC) + Shift + hyphen, or 
• From main menu, go to Insert > Symbol > Special Characters > Nonbreaking Hyphen. 

SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

SUBMIT ASSIGNMENT: 

u05a3 Rosewood Letter 
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GROUP - GROUND RULES 

RATIONALE:  College is a preparing ground for the “corporate world” and in the corporate world 
there will be many times where you will need to work within a group/team to accomplish a task. This 
project consists of creating a “fictitious” or “actual” company. An assignment for each application within 
Office (Word, Excel, and Access) will be given to demonstrate proficiency within the application. 
PowerPoint will be used for the presentation. 

GETTING STARTED: Introduce yourself to your team members, and acquire contact 
information such as email addresses, cell phone number and/or land line numbers. Next - discuss a 
“fictitious” or “actual” company which will provide a service, product or idea, and establish a company 
name. Some previous companies have been: pizza delivery service, a beverage company, surf shop, 
house cleaning service, DVD services, coffee shops and childcare centers. These are just a few ideas, 
but I look forward to your new creative ideas. Make sure your choice is appropriate and meets the 
guidelines for student conduct [i.e. nothing drug, sex related . . .] 

TEAM GROUND RULES 
A vital contract when forming a group/team and defining roles and responsibilities, assigning work, setting 
schedules and monitoring progress.    

Ground rules describe things like - how you should behave, communicate, prepare for and run meetings, 
make decisions, solve problems, and resolve conflicts. Good ground rules are clear, consistent, agreed 
to, reinforced (not enforced or policed), and followed. 

As soon as you can, discuss and define the most obvious ground rules. Don't expect to cover every 
conceivable issue. Just post your initial ideas on a chart that's visible during all meetings. As you run into 
new situations, add new ground rules, revise existing ones, and drop those that don't fit anymore. Use the 
questions on the next page as a starting point to establish your team ground rules. 

GROUND RULES WORKSHEET 
Use the following questions to explore how your team wants to operate. You can distribute these 
questions for individual consideration and then discuss your answers with the team. 

How will we . . .  
1. Assign roles and responsibilities?  
2. Work together? 
3. Establish plans and processes? 
4. Assign work/tasks and set schedules/timelines? 
5. Monitor and follow-up on work assignments? 
6. Keep each other fully informed? [Do you need a facilitator?] 
7. Give Feedback? 
8. Recognize accomplishments? 
9. Organize and conduct meetings? 
10. Ensure that everyone participates fully? 
11. Make decisions? 
12. Resolve differences and solve problems? 
13. Make the best use of limited resources? 
14. Ensure that we achieve desired results? 
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Your team should use the u04d4 discussion area to compose answers for the fourteen questions listed.  
When you are submitting a group project, only one member of the group should be assigned to do the 
submission.  The submission is for the entire group.  Make sure your group has agreed upon who will 
submit the project.  The ground rules are worth 25 points toward your grade. This is a copy of the 
grading criteria used for u05a4 Ground Rules: 

• QUESTIONS OUTLINED (10 PTS)- Each of the 14 questions has been addressed and clearly 
displayed in the summary presented.  

• REPORT FORMAT (10 PTS) - The format for the team ground rules has been done in a 
professional format with each of the 14 processes clearly visible. The group logo is at the top of 
the ground rules report. 

• File NAME (1 PT) - Your group has followed the guidelines and saved the report at u05a4 Team 
Guidelines. 

• TITLE PAGE (4 PTS) - Your team has created an attractive title page with the names of all team 
members that participated in this project.  DO NOT LIST INACTIVE MEMBERS!   The colors for 
the title page work well with the team logo chosen. 

When your group is working with this section of the project, make sure that you don't try to take the entire 
load on yourself.  The idea is to delegate the work and to check each section for each person to respond 
to.  One approach would be to assign different responsibilities.  If your group has 5 members, here are 
some ideas: 

• All Members - Decide what the name of the company will be and what the theme is that is going 
to be presented. 

• All Members - Present letterhead with logo and vote on the outcome. 
• Member 1 & 2 - Answer questions 2-4 
• Member 3 - Answers questions 5-8 
• Member 4 - Answers questions 9-12 
• Member 5 - Answers questions 1, 13-14 and creates the final submission 

If one or two members are not active, their answers to the questions can be absorbed by one of the 
members that is active.  Make sure your group agrees on a title page that is appropriate for your chosen 
company and that all of the participating members names are on that page. 

Remember everyone is more productive when they are working cohesively with a team.  

SUBMIT ASSIGNMENT 

The assignment should be submitted by a designated group member.  One submission is made for 
the entire group.  The correct filename for this assignment is u05a4 Ground Rules. 
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GROUP - LETTER AND FLYER 

Company Letterhead (5 points) 

Design a company letterhead, which includes a company logo/graphic, your 
company name and your company’s address. You may want to incorporate colored 
text or graphic features in this document. (see Word Chapter 3 for creating a 
letterhead) 

Letter of Introduction (10 points)  

Prepare a block style letter of introduction about your company, using the letterhead 
which you have designed (review UNIT 05 lessons for letter structure). Goal – one 
page. 

• Paragraph 1 – Introduction 
• Paragraph 2 – Ethics considerations for your business 
• Paragraph 3 – How will your group incorporate Social Media into your project? 
• Paragraph 4 – Summary 

Marketing Flyer (10 points)  

The flyer contains the three major elements discussed in UNIT 04 (headline, body, 
signature). The use of space is clearly defined, and the graphics relate clearly to the 
headline and body of the flyer. A separate title page has been attached that includes 
the names of the group members that participated in the project. 

u05d5 Discussion (10 points) 

Your team should use the u05d5 discussion area to contribute to the creation of the 
letter and flyer for this portion.  The discussion grade is a separate grade from the 
assignment grade.  I am monitoring your participation and contribution to the group.  

SUBMIT ASSIGNMENT 

The assignment should be submitted by a designated group member.  One submission 
is made for the entire group.  Your group will be submitting more than one file.  If you 
have never uploaded multiple files to Canvas, make sure you have reviewed the 
introduction on how to do so: (INTRO 6 - Uploading Multiple Files to Canvas) . 

This is what should be submitted:  

1. Company Promotional Letter 
2. Marketing Flyer with Title Page  

NOTE: The instructions on how to attach a title page to a document are outline in UNIT 
02 page 30 

https://cuesta.instructure.com/courses/14878/pages/intro-6-uploading-multiple-files-to-canvas


  

~ 115 ~ 

 

 

UNIT 06 MS POWERPOINT 

Visual documents are commonly used in business settings. A study done by the Wharton School of 
Business showed that the use of visuals reduced meeting times by 28 percent. Another study found that 
audiences believe presenters who use 
visuals are more professional and credible 
than presenters who merely speak. And still 
other research indicates that meetings and 
presentations reinforced with visuals help 
participants reach decisions and consensus 
in less time. A presentation program such as 
Microsoft PowerPoint, Apple Keynote, 
OpenOffice.org Impress or Prezi, is often 
used to generate the presentation content. 
Modern internet-based presentation 
software, such as the presentation 
application in Google Docs and Slide Rocket 
also allow presentations to be developed 
collaboratively by geographically separate 
collaborators. 

The following are formatting guidelines specific to using PowerPoint or similar presentation software: 

 Do not write out the entire presentation on your PowerPoint; instead, create bullet points and 
headings no longer than three to five words that give the main points 

 Include no more than five to seven lines per slide; better to split information onto two slides than it 
is to cram too much information onto one 

 Be consistent with your “theme” (do not use a different theme for each slide) 

 Do not overuse flashy transitions; they are meant to enhance your presentation, not take over 

 Be careful with your color scheme; again, this is meant to enhance your presentation 

 Make sure that the text is big enough for the audience to read 

 Do not use complicated or unreadable font 

 Use a font color that stands out against the background 

PowerPoint allows you to apply built-in templates, to apply your own custom templates, and to search 
from a variety of templates available on Office.com. Office.com provides a wide selection of popular 
PowerPoint templates, including presentations and design slides. 

PRESENTATION WITH BULLETED LIST AND PICTURES 
In this unit, you will learn how to perform basic tasks using PowerPoint. The objective is to produce a 
presentation, titled u06a1 Tall Oaks, to promote three programs at a nature center.  The show has a 
variety of pictures and visual elements to add interest and give facts about the events.  Some of the text 
has formatting and color enhancements.  Transitions are used to help one side flow gracefully into the 
next during the show.   
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CHOOSE A DOCUMENT THEME AND VARIANT 

Step 1. CLICK on the shortcut to open POWERPOINT.  The first screen will show you a series fo 
presentation themes already on your computer.   

Step 2. CLICK the BERLIN theme to display the theme preview 

Step 3. Notice you have four theme variants.  CLICK the GREEN VARIANT. Your middle image 
will change to the Green color layout.   

Step 4. CLICK CREATE to open the Berlin template in the green variant.  
Step 5. CLICK F12 to display the Save As dialog box 
Step 6. NAVIGATE to the UNIT-06 folder. 

Step 7. SAVE the presentation as u06a1 Tall Oaks 
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Step 8. CLICK SAVE 

CREATE A TITLE SLIDE 

The default Title Slide has placeholders (boxes with dotted or hatch-marked borders. Most layouts have a 
title text placeholder and at least one content placeholder.  Depending on the slide layout selected, title 
and subtitle placeholders are displayed for the slide title and subtitle.   

 

Step 1. CLICK the label to add a title INSIDE the TITLE PLACEHOLDER 
Step 2. Type Autumn Family Programs  
Step 3. DO NOT PRESS ENTER 

Step 4. CLICK to add the SUBTITLE 
Step 5. Type Tall Oaks Nature Center 
Step 6. DO NOT PRESS ENTER 



  

~ 118 ~ 

 

Step 7. TRIPLE-CLICK the paragraph for Tall Oaks Nature Center 
Step 8. The short-cut formatting menu should appear.  If it doesn’t, RIGHT-CLICK 

the SELECTED TEXT 

Step 9. Change the FONT SIZE to 36 
Step 10. CLICK the ITALIC option to italicize the text.  

 

CHANGE THE TITLE 

PowerPoint designers use many techniques to emphasize words and characters on a 
slide. In this activity, you will accentuate the word Autumn in the Title Slide just created.  

Step 11. Select the word Autumn by following these directions: DOUBLE-CLICK 
the word AUTUMN in the title. 

Step 12. CLICK the FONT COLOR option on the mini tool bar
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Step 13. CLICK ORANGE on the standard-colors palette  

SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

 

ADD A NEW SLIDE WITH A BULLETED LIST 

Step 1. CLICK on the HOME tab to review the home 
ribbon 

Step 2. In the Slides group, CLICK NEW SLIDE.  
PowerPoint will reveal multiple slide options.   

Step 3. CLICK the TITLE AND CONTENT option. 
Step 4. In the placeholder for the title, type 

Morning Bird Walks 
Step 5. Navigate down to the area marked for a 

bulleted list and type your first bulleted item: 
Enjoy a hike on natural surface 
trails 

Step 6. HIT ENTER to advance to the next bullet 
item. 

Step 7. HIT TAB to make the new item a sub-item of 
the first bullet 

Step 8. Type Approximately 1.5 miles 
Step 9. HIT ENTER 
Step 10. If not in view, CLICK on the HOME tab to review the home ribbon 
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Step 11. In the Paragraph Group, CLICK DECREASE.  This will make the bullet 
align with the first bullet typed. 

 
Step 12. Type 9 a.m. every Saturday 
Step 13. HIT ENTER to advance to the next bullet 
Step 14. HIT TAB to make the new item a sub-item of the second bullet.  
Step 15. Type Bring binoculars and a field guide 
Step 16. HIT ENTER to advance to the next bullet 
Step 17. HIT TAB to make the new item a sub-item of the binoculars statement 
Step 18. Type Extra supplies will be available 
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EMPHASIZE IMPORTANT POINTS 

Emphasis is used to enhance areas of the slide that are important to the reader.  In this case, we are 
emphasizing the fact the bird walks are every Saturday.  Follow these directions to implement emphasis:  

Step 19. HIGHLIGHT the words every Saturday 
Step 20. CLICK BOLD 
Step 21. INCREASE the FONT SIZE to 28 

SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 
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ADD A COMPARISON SLIDE 

Step 1. CLICK on the HOME tab to review the home 
ribbon 

Step 2. In the Slides group, CLICK NEW SLIDE.  
PowerPoint will reveal multiple slide options.   

Step 3. CLICK the COMPARISON option. 
Step 4. Type the TITLE: Afternoon Insect 

Identification 
Step 5. Heading for List 1 Type: Grasshoppers 
Step 6. HIT ENTER 
Step 7. Type (also known as locusts). DO NOT hit 

enter 
Step 8. Click in the heading option for List 2 Type: 

Dragonflies 
Step 9. HIT ENTER 
Step 10. Type (often mistaken for damselflies). DO NOT hit enter. 

SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

 

ADD A TITLE ONLY SLIDE 
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Step 1. CLICK on the HOME tab to review the home ribbon 
Step 2. In the Slides group, CLICK NEW SLIDE.  

PowerPoint will reveal multiple slide options.   
Step 3. CLICK the TITLE ONLY option. 
Step 4. Type the title: Twilight Firefly Hikes. DO NOT 

hit enter. 

SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply 
holding down the CRTL key and taping the S key.  This is a good habit 
and keeps you from losing your work. 
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CHANGE THE THEME AND VARIANT 

A theme provides consistency in design and color throughout the 
entire presentation by setting the color scheme, font set, and layout 
of a presentation.  Change the theme of the existing presentation 
by following these steps: 

Step 1. CLICK on the DESIGN tab to review the 
design ribbon 

Step 2. CLICK the MORE button on the bottom right 
of the themes group 

Step 3. CLICK the MAIN EVENT theme 
Step 4. In the Variants group, CLICK the GREEN 

VARIANT 
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MOVE TO ANOTHER SLIDE IN NORMAL VIEW 

PowerPoint has several presentation views.  For this activity, you should be in Normal presentation view. 

Step 5. CLICK on the VIEW tab to review the view ribbon 
Step 6. In the presentation views group, CLICK NORMAL 

Step 7. In the normal view CLICK on the FIRST TITLE SLIDE on the top left panel  

 

SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 
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INSERT PICTURES 

The files you need for the remainder of this activity are in your UNIT-06 Student Files.  

Step 1. CLICK on SLIDE 1 to bring it into view. 
Step 2. CLICK on the INSERT tab to display the Insert ribbon 
Step 3. CLICK on PICTURES located in the images group 
Step 4. SCROLL through the folders on your computer until you find the CIS-AGB 210 

UNITS 
Step 5. OPEN the folder. NAVIGATE to the UNIT-06 folder 
Step 6. OPEN the folder  
Step 7. OPEN on the UNIT-06 Student Files 
Step 8. CLICK on the Autumn Leaves.jpg.  This will activate the insert icon. 
Step 9. CLICK INSERT 

Step 10. CLICK on SLIDE 2 to bring it into view. 
Step 11. CLICK on the INSERT tab to display the Insert ribbon 
Step 12. CLICK on PICTURES located in the images group. Because you have already 

opened the folder, your view shows the UNIT 06 Student files folder.  
Step 13. SCROLL through the images until you find the image called Owl.jpg 
Step 14. CLICK on the Owl.jpg image 
Step 15. CLICK INSERT 
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INSERT PICTURES WITH PLACEHOLDER 

Step 16. CLICK on SLIDE 3 to bring it into view. This slide has two content placeholders.   
Step 17. CLICK on the PICTURES icon under the Grasshoppers reference

 
Step 18. SCROLL through the images until you find Grasshopper.jpg 
Step 19. CLICK on the Grasshopper.jpg image to insert into the presentation. 
Step 20. CLICK INSERT 
Step 21. CLICK on the PICTURES icon under the Dragon Flies reference 
Step 22. SCROLL through the images until you find Dragonfly.jpg 
Step 23. CLICK on the Dragonfly.jpg image to insert into the presentation. 
Step 24. CLICK INSERT 

INSERT PICTURE WITHOUT A CONTENT PLACEHOLDER 

Step 25. CLICK on SLIDE 4 to bring it into view. This slide has two content placeholders.   
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Step 26. CLICK on the INSERT tab to display the Insert ribbon 
Step 27. CLICK on PICTURES located in the images group 
Step 28. CLICK on the Firefly.png image to insert into the presentation 
Step 29. CLICK INSERT 

 

SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

 

RESIZE THE PICTURES 



  

~ 129 ~ 

 

Slides 1, 2 and 4 have pictures that need adjusting.  The instructions below address each of the issues 
for the slide in question. 

SLIDE 1 

On this slide, you are going to adjust the size of the picture 
and angle of the picture.  Follow these steps: 

Step 1. CLICK on the IMAGE 
Step 2. With the image selected, CLICK the 

PICTURE TOOLS/FORMAT menu 
Step 3. Use the sizing handles in the bottom right 

corner of the image to adjust the size to 
approximately 3.46” high x 6.34” 
wide.  

Step 4. CLICK the ROTATION HANDLE to 
rotate the image in alignment. Align the 
image the same direction as the title. 

SLIDE 2 

Step 5. The Owl is too large for the slide.  We are going to resize 
the image using only the height adjustment.  Place your 
cursor on the bottom center handle.  CLICK and DRAG 
the BOTTOM HANDLE UP.  

Step 6. ADJUST the IMAGE to fit in ABOVE THE GREEN 
LINE 

Step 7. CLICK the MIDDLE of the IMAGE.  You will see a 
four-pronged arrow (looks like a compass). 

Step 8. DRAG the IMAGE TO THE RIGHT away from the 
text 
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SLIDE 4 

Step 9. ADJUST the SIZE OF 
FIREFLY to fit on the 
slide.  Use the following 
illustration as your guide: 

SAVE YOUR UPDATES 
Since the file is already saved you can now 
save your updates by simply holding down 
the CRTL key and taping the S key.  This 
is a good habit and keeps you from losing 
your work. 
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COPY A SLIDE 
Sometimes it is necessary to make a copy of an entire slide.  The process is simple just follow these 
steps: 

Step 1. In the left-hand panel of the normal view, 
CLICK on SLIDE 1 to select the side. 

Step 2. RIGHT-CLICK your mouse to reveal the 
shortcut menu 

Step 3. CLICK COPY 
Step 4. CLICK BELOW SLIDE 4.  The paste 

options button will appear. 

 
Step 5. CLICK the first option, USE DESTINATION THEME.  You should have a 

duplicate of slide 1 in the slide 5 position 
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CHANGE THE TITLE OF SLIDE 1 

The format of slides 1 and 5 are now identical; however, the titles should be unique on each page.  In the 
next steps, you will change the titles for slide 5: 

Step 6. With the normal view open, CLICK SLIDE 5 
Step 7. In the right viewing pane, CLICK the TITLE 
Step 8. HIGHLIGHT the word AUTUMN 

Step 9. Type Register for.  Notice how the word Autumn is automatically replaced with the 
new information.   

Step 10. CLICK on the word FAMILY 
Step 11. DOUBLE-CLICK the FORMAT PAINTER.  The double-click turns the painter on 

until you click on it again.  
Step 12. CLICK anywhere in the word REGISTER 
Step 13. CLICK anywhere in the word FOR 
Step 14.  CLICK on the FORMAT PAINTER to turn if off.  
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Step 15. CLICK on the SUBTITLE in SLIDE 5 
Step 16. You are going to change the entire contents of the current subtitle. TRIPLE-CLICK 

the SUBTITLE to select it. If you have trouble with the triple-click, you can highlight 
the text by clicking and dragging your mouse over the current subtitle. 

Step 17. Type Call 816-555-8928 Today  

 

SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

 

ADD A TRANSITION BETWEEN SLIDES 
The slide transitions add interest to your presentation and help make it look more professional.  There are 
many transition styles available. For this presentation, we will be using the Wind Transition.   

Step 1. With your u06a1 Tall Oaks presentation open, CLICK on the TRANSITIONS tab to 
reveal the transitions ribbon 

Step 2. CLICK on the MORE option  

Step 3. In the Exciting section CLICK WIND 
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Step 4. In the Timing group, choose these options: 
a. CLICK APPLY TO ALL.  This will apply the wind transition to all the slides in 

the presentation. 
b. DURATION: 3:00 

 

Step 5. Test your slide show CLICK on the SLIDE SHOW tab to reveal the Slide Show 
ribbon. 

Step 6. In the Start Slide Show group, CLICK FROM BEGINNING 

Step 7. HIT ENTER.  This will advance you to the next slide.  You can also click your mouse 
to get the same result.  
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Step 8. Finish previewing all the slides until you reach the end of the show. You will see a blank 
screen to signify the show is complete.  CLICK on the BLANK screen to return to 
your document. 

SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

SUBMIT ASSIGNMENT: 

u06a1 Tall Oaks 
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ON YOUR OWN ACTIVITY 

The images for this activity are in the UNIT 06 Student Files

 

Step 1. OPEN a NEW document using the QUOTABLE THEME 

Step 2. TITLE: History Museum 

Step 3. SUB TITLE: Popular Exhibits 
Step 4. HIT ENTER 

Step 5. Type Your Name 

Step 6. SAVE your file AS: u06a2 History Museum 
Step 7. FONT EFFECTS AND SIZES 

a. TITLE: ITALIC, DARK BLUE (Standard Colors) 
b. SUB TITLE: 32 POINT (you may need to expand the size of the subtitle box 

to increase the font size effectively) 
c. YOUR NAME: 24 POINT 

Step 8. SLIDE 1: TITLE SLIDE 
a. PICTURE 1: Museum Icon.png 
b. PICTURE 2: Girls in Museum.png 

Step 9. SLIDE 2: COMPARISON LAYOUT 

a. TITLE: Tyrannosaurus (T. rex) 

b. SIDE 1: Found in western North America 
i. PICTURE: T-rex Skeleton.jpg 

c. SIDE 2: 50-60 bone-crunching teeth 
i. PICTURE: T-rex 3D.jpg 

Step 10. SLIDE 3: SECTION HEADER LAYOUT 
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a. TITLE: Ancient Egyptian Sarcophagus 
b. FONT COLOR: Dark Blue (Standard Colors) 
c. TEXT ALIGNMENT: RIGHT ALIGN 
d. SUB TITLE: Stone carved burial container contains 

mummified body  
e. PICTURE: Pharaoh.jpg 

Step 11. SLIDE 4: TWO CONTENT LAYOUT 

a. TITLE: Antiques 
b. FONT COLOR: Dark Blue (Standard Colors) 
c. LEFT PICTURE: Car.jpg 
d. RIGHT PICTURE: Typewriter.jpg 
e. SIZE: Both Images should be 3.42” HIGH by 5.67” WIDE 
f. ALIGNMENT: IMAGES ARE IN ALIGNMENT BY TOP EDGE 

Step 12. SLIDE TRANSITIONS: Gallery 
a. APPLY TO ALL 
b. DURATION: 2.25 SECONDS 

SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

SUBMIT ASSIGNMENT: 
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 u06a2 History Museum  

UNIT 07 DOWNLOADING THEMES AND EDITING SLIDES 

Whether reading a document or viewing a PowerPoint presentation, people relate better to photographs, 
artwork, graphics, and a variety of typefaces.  Researchers have known for decades that documents with 
visual elements are more effective than text only documents.   

PowerPoint displays many themes that are varied and appealing.  They can give you and excellent start 
at designing a presentation; however, you may have a specific topic and design concept.  There are 
hundreds of pre-designed themes and templates available online.  The following steps help to establish 
and understanding of how to find a theme that meets your needs: 

Step 1. OPEN POWERPOINT.  
Step 2. In the SEARCH area type BASKETBALL 

Step 3. HIT ENTER.  The basketball theme will show in the result 
Step 4. CLICK on the BASKETBALL presentation theme 
Step 5. CLICK CREATE.  You will be routed to the basketball theme in the normal view. 

 
Step 6. CLICK SLIDE 3 
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Step 7. HOLD DOWN SHIFT key down and CLICK SLIDE 7. You should have slides 3 
through 7 selected.  

Step 8. RIGHT-CLICK any of the four slides.  
Step 9. CLICK DELETE SLIDE. The four slides will be 

removed. 
Step 10. HIT F12 to open the SAVE AS menu 
Step 11. NAVIGATE TO YOUR UNIT 07 FOLDER 
Step 12. Enter the FILE NAME: 

u07a1 Basketball 
Camp 

Step 13. CLICK SAVE 

 

CREATE SLIDES 
In UNIT 06 you learned how the title slide introduces the audience to the presentation.  The title slide also 
catches the readers attention.  In this presentation, the title slide is using the text as an illustration that 
focuses on a topic (basketball). The images for this activity are in the UNIT 07 Student Files 

Step 1. SLIDE 1  
a. TITLE: Basketball Camp for Kids 

b. SUBTITLE: Gilbert Park District 
c. INSERT PICTURE: Backboard.png 

Step 2. SLIDE 2 
a. TITLE: Learn from pros and make acquaintances 

b. CAPTION: Classes meet weekday mornings throughout the 
summer 

c. CHANGE PICTURE 
i. CLICK PICTURE to select the current 

picture 
ii. RIGHT-CLICK to display shortcut menu 
iii. CLICK; CHANGE PICTURE; FROM 

FILE 
iv. SELECT: Teamwork.jpg 
v. CLICK INSERT 

Step 3. SLIDE 3 



  

~ 140 ~ 

 

a. TEXT: You will lern . . . (Learn is intentionally spelled wrong) 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

REVISE PICTURES 

SLIDE 1 

Step 1. CLICK on the BACKBOARD IMAGE to select it.  
Step 2. Use the sizing handles to adjust the size of the backboard. 

If you prefer to enter the size in the size group, use this 
setting:  
a. Height 5.25” 
b. Width 4.5” 

Step 3. CLICK the center of the BACKBOARD IMAGE. This 
will activate the cross hairs to move the image to the 
desired location.  WATCH CAREFULLY as you move the image, you will see a 
vertical and horizontal line appear to the right and bottom of the graphic.  This is a 
PowerPoint SMART GUIDE to illustrate the best image location for the graphic you 
have selected.  

Step 4. ALIGN the IMAGE using the SMART GUIDE to assure you are not too close to the 
edge of the slide.  

SLIDE 2 

Step 5. SELECT the teamwork PHOTO 
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Step 6. CLICK the PICTURE TOOLS button to display the Picture Tools Format tab 
Step 7. CLICK the CORRECTIONS option in the Adjust group. 
Step 8. Scroll down to display the last row of images.  SELECT  

a. Brightness: -20% Contrast: -40% (second picture in last 
brightness/contrast row) 

Step 9. With the picture selected, CLICK the MORE option in the 
PICTURE STYLES group 

Step 10. CLICK the BEVEL RECTANGLE 

Step 11. With the picture selected, CLICK the PICTURE BORDER option in the PICTURE 
STYLES group.  

Step 12. Select WEIGHT. Scroll down to 6 pt 
Step 13. CLICK on the 6 pt option.  There should now be a border around the picture. 

 
Step 14. Select the picture again to change the border color.  CLICK PICTURE BORDER 
Step 15. In the theme colors CLICK BLACK BACKGROUND 1 
Step 16. Select the picture to change the glow effects.  CLICK PICTURE EFFECTS 
Step 17. SELECT GLOW to reveal the glow variations available 
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Step 18. CLICK GLOW: 18 point; Brown, Accent color 3 

Step 19. Select the picture to change the bevel effects.  CLICK 
PICTURE EFFECTS 

Step 20. SELECT BEVEL to reveal the bevel variations available 
Step 21. CLICK BEVEL: Angle 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

WORKING WITH SHAPES 

SLIDE 3 

Step 1. In the normal view, DISPLAY SLIDE 3.  
Step 2. CLICK the HOME tab to display the home ribbon 
Step 3. In the drawing group, CLICK the MORE option next to the 

shapes displayed.  
Step 4. In the basic shapes group, CLICK the OVAL shape. 
Step 5. Press and HOLD SHIFT key DRAG until the image is 

approximately the following dimensions (check the drawing tools 
for size dimensions) 
a. HEIGHT 2.5” 
b. WIDTH 2.67” 
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Step 6. DRAG the image until the VERTICAL SMART GUIDE is DISPLAYED 
Step 7. With the oval image selected, you still have access to the drawing tools. CLICK the 

MORE option on the INSERT SHAPES GROUP 
Step 8. In the BLOCK ARROWS group choose CURVED LEFT 
Step 9. CLICK and DRAG to insert the curved arrow into the demonstration.

 
Step 10. CLICK the INSERT SHAPES GROUP again 
Step 11. In the BASIC SHAPE group CLICK 

PENTAGON 
Step 12. CLICK and DRAG your mouse to create a 

PENTAGON SHAPE 

SAVE YOUR UPDATES 
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Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

APPLY A SHAPE STYLE 

This activity demonstrates how PowerPoint provides the means for you to apply shape styles to the arrow 
and pentagon that will coordinate with the oval style.  A light style color in the arrow shape will help join 
darker colors in the oval and pentagon.  Eventually you will add text to the shape but for now, we are 
concentrating on using the coordinating theme colors.  Notice that all the styles applied are in the group 
marked Black, Dark 1.  For this activity you will use three theme colored effects (fill, outline and subtle).  

Step 1. CLICK the HOME tab to reveal the home ribbon band 

OVAL SHAPE 

Step 2. With Slide 3 in normal view, CLICK on the OVAL shape 
Step 3. In the drawing group, CLICK the QUICK STYLES  
Step 4. In the theme styles group, CLICK COLORED FILL: Black, Dark 1 

ARROW SHAPE 

Step 5. With Slide 3 in normal view, CLICK on the ARROW shape 
Step 6. In the drawing group, CLICK the QUICK STYLES  
Step 7. In the theme styles group, CLICK COLORED OUTLINE: Black, Dark 1 

PENTAGON SHAPE 

Step 8. With Slide 3 in normal view, CLICK on the PENTAGON shape 
Step 9. In the drawing group, CLICK the QUICK STYLES  
Step 10. CLICK SUBTLE EFFECT: Black, Dark 1 

 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

ADD TEXT AND FORMAT CONTENT 
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The default theme font is Franklin Gothic Medium. To draw more attention to the text in the shapes 
created in Slide 3, the plan is to change the font to Century Schoolbook.  To change a font, you must 
select the text and then choose the desired font.  Follow these steps to complete the text each of the 
shapes:  

OVAL SHAPE 

Step 1. DOUBLE-CLICK the OVAL SHAPE in slide 3.  Your 
cursor should be blinking in the center of the shape.  It is now 
ready to type the text.  

Step 2. Type Ball handling skills 
Step 3. HIGHLIGHT the TEXT 
Step 4. RIGHT-CLICK to DISPLAY the SHORTCUT MENU 
Step 5. SELECT CENTURY SCHOOLBOOK from the list of 

FONTS 
Step 6. FONT  

a. SIZE = 24 pts 
b. COLOR = ORANGE (standard colors row) 

PENTAGON SHAPE 

Step 7. DOUBLE-CLICK the PENTAGON SHAPE in slide 3.  Your cursor should be 
blinking in the center of the shape.  It is now ready to type the text.  

Step 8. Type Offensive moves 
Step 9. CLICK the TEXT in the OVAL SHAPE 
Step 10. DOUBLE-CLICK your FORMAT PAINTER.  This will turn on the painter until you 

click on it again.  
Step 11. Notice that your cursor turns into a paint brush. CLICK the TEXT inside the 

PENTAGON.  
Step 12. Use the FORMAT PAINTER to change all the text in the Pentagon 

Step 13. CLICK the FORMAT PAINTER again to turn it off.  
Step 14. With the PENTAGON selected. CLICK COPY 
Step 15. CLICK AWAY from the PENTAGON to deselect it. 
Step 16. CLICK PASTE 
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Step 17. CHOOSE the USE DESTINATION THEME option

 
Step 18. There are now two pentagon shapes.  MOVE the NEW SHAPE to the LEFT of the 

original shape.  When you are moving the shape, watch for the SMART GUIDES. 
Step 19. The SMART GUIDES help you align the TWO SHAPES DIRECTLY ACROSS 

from each other.  
Step 20. Change the text in the new pentagon to Defensive mindset 

ARROW SHAPE 

Step 21. SELECT the ARROW SHAPE 
Step 22. CLICK COPY 
Step 23. CLICK PASTE 
Step 24. CLICK PASTE again. This process will produce two new arrows to work with.   

Step 25. CLICK on each of the new ARROWS 
Step 26. DRAG one BETWEEN the PENTAGON SHAPES 
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Step 27. DRAG the other BETWEEN the PENTAGON and OVAL

 
Step 28. CLICK on each ARROW to ROTATE the ARROW 

After you have finished rotating and sizing the arrows, slide 3 should look 
like the image below: 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

FORMATTING SLIDE BACKGROUNDS 

A unique slide background can generate audience interest.  Every slide can have the same background, 
or different backgrounds can be used.  The change in backgrounds is considered a fill, which may be the 
content to makeup a shape, line or character. Solid fill is one color used throughout the entire slide, 
Gradient fill is one color shade gradually progressing to another shade.  Picture or texture fill uses a 
specific file or an image that stimulates a material, such as cork, granite, marble, or canvas. Pattern fill 
adds designs, such as dots or dashes, which repeat in rows across the slide (Freund, et al., 2017).  

Fills can be adjusted by using features such as transparency, which allows you to see through the 
background.  Another feature is to set custom colors that are unique to your company or organization. 
Offset is another background feature that allows the user to move the background away from the slide 
borders in various distances by percentage.  Tiling repeats the background image many times both 
vertically and horizontally.   
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SLIDE 2 

Step 1. With Slide 2 displayed, CLICK the DESIGN tab to 
view the design ribbon  

Step 2. In the Customize Group, CLICK FORMAT 
BACKGROUND 

Step 3. CLICK PICTURE OR TEXTURE FILL 
Step 4. CLICK the TEXTURE OPTION 
Step 5. CLICK the BROWN MARBLE texture 
Step 6. CLICK the TRANSPARENCY slider 
Step 7. DRAG to RIGHT until 15% is displayed in the 

TRANSPARENCY BOX 

SLIDE 3 

Step 8. Display Slide 3. CLICK the DESIGN tab to view the design ribbon  
Step 9. In the Customize Group, CLICK FORMAT BACKGROUND 
Step 10. CLICK GRADIENT FILL 
Step 11. CLICK the PRESET GRADIENTS button 
Step 12. CLICK BOTTOM SPOTLIGHT – ACCENT 3 
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SLIDE 4 

Step 13. Display Slide 4. CLICK the DESIGN tab to view the design ribbon  
Step 14. In the Customize Group, CLICK FORMAT BACKGROUND 
Step 15. CLICK PICTURE OR TEXTURE FILE 
Step 16. CLICK FILE.  
Step 17. Navigate to your UNIT 07 STUDENT FILES 
Step 18. CLICK the image called Basketball Boy 
Step 19. CLICK INSERT.  The background of the slide will change to the Basketball boy 

image.  

Step 20. CLICK the TRANSPARENCY slider 
Step 21. DRAG until the Transparency is set to 30% 
Step 22. CLICK the INSERT tab to show the Insert ribbon 
Step 23. In the Text group, CLICK WORDART 
Step 24. CLICK Fill-Red, Accent color 2; Outline: Red Accent color 2  

Step 25. Type Register Today! 
Step 26. With the WordArt still selected, CLICK the TEXT 

EFFECTS option in the WordArt Styles group.  
Step 27. POINT to TRANSFORM to display the various types of 

transformations available. 
Step 28. CLICK on the CHEVRON UP option 
Step 29. DRAG the LOWER RIGHT HANDLE of the 

WORDART to resize the letters.  
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Step 30. MOVE the WORDART under the basketball hoop 

Step 31. SELECT the WORDART TEXT 
Step 32. In the WordArt Styles group, SELECT the TEXT FILL option 
Step 33. CLICK the TEXTURE option 
Step 34. CLICK on MEDIUM WOOD 
Step 35. In the Word Styles group, CLICK on the TEXT 

OUTLINE 
Step 36. CLICK on WEIGHT 6 PTS.  
Step 37. CLICK on TEXT OUTLINE again 
Step 38. CLICK on BLACK BACKGROUND 1 (first option 

in the theme colors)

 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

SYNONYMS, NOTES AND SPELL CHECK 

A synonym is simply a word that means the same as the given word. It 
comes from the Greek “syn” and “onym,” which mean “together” and “name,” 
respectively. When speaking or writing, one of the best ways to expand your 
vocabulary and to avoid using the same words repeatedly is to use a 
thesaurus to find synonyms (similar meaning words).   

In this project, you want to replace the word acquaintances, on Slide 2.  The 
following steps location the appropriate synonym and replace the word: 

Step 1. Display Slide 2. CLICK on the word Acquaintances 
Step 2. RIGHT-CLICK to view the shortcut menu 
Step 3. SCROLL down to SYNONYMS 
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Step 4. CLICK on the replacement Friends 

ADD NOTES 

There is no need to memorize your entire presentation speech.  Speaker or speech notes are powerful 
tools that you can use to help you when giving presentations. You can add notes per slide, and you can 
outline the main points you want to say about each slide. You don’t have to write an entire novel in the 
notes section; key talking points will do. 

Speaker notes allow you to give smooth presentations while also making sure you don’t miss out on any 
important points. Follow these steps to add notes to your presentation: 

CLICK SLIDE 2 

Step 5. CLICK the NOTES pane 
Step 6. CLICK the ADD NOTES area 

that appears 
Step 7. Type Every morning begins with a group session that covers the 

day’s agenda. The coaches then separate the campers into groups to 
cover fundamental skills. Each morning ends with a contest 
designed to be fun and competitive.  

CLICK SLIDE 3 

Step 8. CLICK the ADD NOTES area that appears 
Step 9. Type Campers will gain confidence while learning sportsmanship and 

strategies. 

CLICK SLIDE 4 

Step 10. CLICK the ADD NOTES area that appears 
Step 11. Type Space is limited.  Every camper will receive a t-shirt, snacks and 

water. Parents are encouraged to attend the awards ceremony at the 
end of the camp session.  

CHECK SPELLING 
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Although a spell checker is a handy tool for general use, it will never fully take the place of educating 
yourself properly and polishing your writing skills. Word and PowerPoint have a very large (but not 
infinite) list of words to which they compare each “word” you type. If a match is not found, it tells you that 
the word is misspelled. Follow these steps to correct the spelling in the Basketball Camp presentation: 

Step 12. CLICK the REVIEW tab to reveal the review ribbon 
Step 13. In the proofing group, CLICK SPELLING 
Step 14. The alternative appears to correct the word “lern” spelled wrong in slide 3.  CLICK 

LEARN 

Step 15. CLICK CHANGE 
Step 16. Fix any typing mistakes you may have made.  

When the spell check is complete, you will 
receive a notice. CLICK OK 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 
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HEADER AND FOOTER OPTIONS 

Although PowerPoint presentations are usually displayed on a screen, they are just like other documents 
in in the Microsoft Office suite such as Word, Excel, and Publisher.  Just like those other applications, you 
can add custom headers and footers to a PowerPoint presentation to display a variety of important 
information. In this exercise, you will add a slide number to each of the slides you have created by 
following these steps: 

Step 1. CLICK on the INSERT tab to display the insert ribbon 
Step 2. In the text group, CLICK the HEADER and FOOTER option 
Step 3. Notice you can add many items such as the date, your name and additional information 

for the pages that contain notes.  
Step 4. CHECK SLIDE NUMBER 

a. CLICK the NOTES and 
HANDOUTS tab 

b. CHECK the FOOTER 
option 

c. ADD YOUR NAME to the 
footer 

d. CLICK on the APPLY TO ALL option 

PRINT PREVIEW 

To see the header/footer changes that were made to your presentation, it is necessary to use the print 
preview. Change the following settings: 

Step 5. With the presentation open, CLICK on the FILE tab 
Step 6. CLICK on the PRINT option 
Step 7. Set the PRINT SETTINGS 

a. Print All Slides 
b. Notes Pages 
c. Print One Sided 
d. Collated 
e. No Staples 
f. Portrait Orientation 
g. Color 

Once you have set the print settings, 
you can use the next page option at 
the bottom of the view to see the notes 
you have entered.  Notice your name appears in the left side of the footer and the slide number 
on the right side of the footer.  

Step 8. CLICK the BACK ARROW at the top left of the screen to return to the document.  

SAVE YOUR UPDATES 
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Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

SLIDE TRANSITIONS 

The final enhancement you will make to this presentation is to change the slide transitions from Fade to 
Orbit for all the slides.  You will then increase the slide duration.  Follow these steps: 

Step 1. With the presentation open, CLICK on the TRANSITIONS tab to display the 
transitions ribbon 

Step 2. In the transition to this slide group, CLICK the MORE option 
Step 3. In the dynamic content, CLICK the ORBIT option 
Step 4. In the timing group, CLICK on the APPLY TO ALL option 
Step 5. In the timing group, CHANGE DURATION to 2:00 

SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

SUBMIT ASSIGNMENT: 

u07a1 Basketball Camp 
 
ON YOUR OWN ACTIVITY 

The images for this activity are in the UNIT 07 Student Files 

Step 1. Open PowerPoint search for NATURE in the online templates and themes 
Step 2. CLICK on RAINBOW PRESENTATION 
Step 3. CLICK CREATE 
Step 4. DELETE the following SLIDES 

a. Slides 12 and 13 
b. Slides 6 through 10 
c. Slides 3 and 4 

Step 5. DUPLICATE SLIDE 2 
Step 6. MOVE SLIDE 4 to the END of the presentation 
Step 7. CLICK F12 
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Step 8. Navigate to your Unit 07 folder 
Step 9. SAVE your file AS: u07a2 About Rainbows 

SLIDE 1 

Step 10. TITLE: Follow Every Rainbow 
 WORDART: Fill-White, Outline- Accent 1, Shadow 
 FONT: 72 PTS 
 FILL: Red (standard colors) 
 OUTLINE: Purple (standard colors) 
 WEIGHT:  3 pt.  
 TEXT EFFECTS TRANSFORM: Arch Up 

Step 11. SUBTITLE: Type By Your Name 
Step 12. PICTURE: UNIT 07 Student files\Rainbow1.png

 

SLIDE 2 

Step 13. TITLE: Seven Colors 
 FONT: 40 PTS 
 COLOR: Black, Text 2 

Step 14. BULLETS 
 Red  
 Orange 
 Yellow 
 Green  
 Blue 
 Indigo 
 Violet 

Step 15. CHANGE the COLOR of each BULLETED ITEM to the color it represents. Use the 
Standard colors.  

Step 16. PICTURE: UNIT 07 Student files\Rainbow2.png 
Step 17. INSERT basic shape: CLOUD 

 STYLE: Light 1, Outline, Colored Fill – Light Blue, Accent 2 
 ADD TEXT: Always appear in this order 
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SLIDE 3 

Step 18. TITLE: Rainbow Formation 
 FONT: 40 PTS 
 COLOR: Red 
 EFFECT: Bold 

Step 19. BULLETS Dark Blue (standard colors) 
 Must be raining 
 Must be sunny 

• Your back must be to the sun  
 Sunlight passes through small droplets of water 
 Curved because raindrops’ surface is curved 

Step 20. PICTURE: UNIT 07 Student files\Rainbow3.png 
 Brightness +20% Contrast +40%

 

SLIDE 4 

Step 21. TITLE: How We See a Rainbow 
 FONT: 40 PTS 
 COLOR: Red 
 EFFECT: Bold 

Step 22. INSERT basic shape: SUN 
 FILL: Yellow (Standard Colors) 
 GRADIENT Dark Variations: Linear Diagonal – Top Left to Bottom Right 

Step 23. INSERT basic shape: OVAL 
 SIZE: 3” x 3” 
 FILL: Light Blue, Accent 2 (theme color) 
 TEXT: Raindrops 
 FONT: 24 pts 

Step 24. INSERT Text Box 
 TEXT: Red 
 COLOR: RED (standard color) 
 FONT: 24 pts 
 EFFECT: Bold 
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Step 25. COPY Text Box 
Step 26. PASTE and change attributes 

 TEXT: Violet 
 COLOR: Purple (standard color) 

Step 27. INSERT LINE ARROW 
 DIRECTION: SUN to RAINDROP 
 SHAPE OUTLINE COLOR: YELLOW 
 WEIGHT: 6 pt 

Step 28. COPY LINE ARROW 
Step 29. PASTE TWICE (you will have three arrows total) 
Step 30. FLIP the two new arrows HORIZONTAL 
Step 31. ARROW 2  

 SHAPE OUTLINE COLOR: RED 
Step 32. ARROW 3 

 SHAPE OUTLINE COLOR: 
PURPLE 

Step 33. ALIGN the ENDS of arrows 2 and 3 with tip of 
arrow 1 

Step 34. PICTURE: UNIT 07 Student files\People.png 

SLIDE 5 

Step 35. TITLE: It’s Sunny and Raining 
 FONT: 40 PTS 
 COLOR: Red 
 EFFECT: Bold 

Step 36. CAPTION: Let’s look for a rainbow 
 FONT: 24 PTS 
 COLOR: Violet 
 EFFECT: Bold 

Step 37. PICTURE BORDER: Violet 

ALL SLIDES 

Step 38. TRANSITION: ORIGAMI 
Step 39. DURATION: 2.5 seconds 
Step 40. APPLY TO ALL 
Step 41. Preview Your Show 



  

~ 158 ~ 

 

 

SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

SUBMIT ASSIGNMENT: 

 u07a2 About Rainbows  
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UNIT 08 REUSING A PRESENTATION AND ADDING MEDIA AND ANNIMATION 

At times. you will need to revise a PowerPoint presentation.  The changes may include inserting and 
adding effects to photos, altering the colors of photos and illustrations, and updating visual elements 
displayed on a slide.  Applying a different theme, changing fonts, and substituting graphical elements can 
give a slide show an entirely new look.  Adding media including sounds, video, and music can enhance a 
presentation and help audience members retain the information being presented.  Adding animation can 
reinforce important points and enliven a presentation (Freund, et al., 2017).  

INSERT AND CHANGE A BACKGROUND PHOTO 
The files needed for this activity are in the UNIT 08 Student Files. 

Step 1. Run PowerPoint CLICK OPEN OTHER PRESENTATIONS 
Step 2. BROWSE to the UNIT-08 folder OPEN UNIT 08 

Student Files  
Step 3. CLICK on SPOKES 
Step 4. CLICK on OPEN 
Step 5. CLICK on ENABLE EDITING (If it appears) 
Step 6. CLICK on SLIDE 1 
Step 7. CLICK on the DESIGN tab to display the design ribbon 
Step 8. In the customize group, CLICK FORMAT BACKGROUND 
Step 9. CLICK PICTURE or TEXTURE FILL 
Step 10. CLICK FILE 
Step 11. OPEN the UNIT 08 Student Files 
Step 12. CLICK on the HIDDEN BIKE.JPG 
Step 13. In the format background task pane, CLICK PICTURE 
Step 14. CLICK on PICTURE COLOR SATURATION PRESETS 
Step 15. CLICK on 400% to change the color saturation on 

the image.  
Step 16. SELECT SLIDE TITLE 
Step 17. RIGHT-ALIGN the TEXT 
Step 18. CLICK on the SUBTITLE PLACE HOLDER 
Step 19. CLICK DELETE 
Step 20. MOVE THE TITLE HIGHER ON THE PAGE 
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Step 21. HIT F12 on your keyboard 
Step 22. SAVE AS option appears 
Step 23. Navigate to the UNIT-08 folder on your 

computer.  Save using u08a1 SPOKES 
as the file name.  

UNGROUP AN ILLUSTRATION 
 

Step 1. OPEN SLIDE 2 
Step 2. CLICK the BIKER CLIP 
Step 3. CLICK the Picture Tools FORMAT tab to open the format ribbon 
Step 4. In the arrange group, CLICK GROUP 
Step 5. CLICK UNGROUP 
Step 6. PowerPoint will display a message regarding converting the picture to a drawing object.  

CLICK YES 

Step 7. CLICK UNGROUP after you have confirmed 
converting the drawing object. 

Step 8. CLICK AWAY from the biker image to 
deselect it.  Each section of the biker is now 
separate and can be changed individually. 

 

CHANGE THE BIKER’S SHIRT AND WHEEL HUB 
COLORS 

Step 9. CLICK the BIKER’S SHIRT to select it.  
Step 10. CLICK the FORMAT tab to display the Format ribbon 
Step 11. In the drawing group, CLICK the SHAPE FILL option 
Step 12. SELECT YELLOW on the standard colors group. 
Step 13. CLICK the REAR WHEEL HUB 
Step 14. CLICK the SHAPE FILL option 
Step 15. SELECT YELLOW from the standard 

colors group. 
Step 16. REPEAT the PROCESS for the FRONT 

WHEEL HUB 

DELETE THE BACKGROUND 
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Step 17. CLICK the BLUE BACKGROUND behind the biker 
Step 18. CLICK your DELETE key.  This will remove the background.  

REMOVE THE SWEAT DROPLETS 

Step 19. CLICK on one of the SWEAT DROPLETS 
Step 20. HOLD DOWN your SHIFT key 
Step 21. CLICK on the remaining SWEAT 

DROPLETS. If you change your view to 
400%, it will be easier to select the droplets 
successfully (VIEW tab ZOOM 400%) 

Step 22. CLICK your DELETE key. 

SELECT THE IMAGE TO GROUP 

Step 23. This first part of the next step is important.  You should 
CLICK the BOTTOM LEFT corner of the image and 
DRAW A BOX all around the ENTIRE IMAGE.  
This selects all the images that now make up this one 
image. 

Step 24. CLICK the FORMAT tab to display the format ribbon. 
Step 25. In the Arrange group, CLICK GROUP 
Step 26. CLICK GROUP from the drop-down box that appears.  
Step 27. RIGHT-CLICK the BIKE RIDER 
Step 28. CLICK COPY 
Step 29. CLICK SLIDE 1 
Step 30. CLICK PASTE 

SAVE YOUR UPDATES 
Since the file is already saved you can now save your 
updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you 
from losing your work. 
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ADD MEDIA TO SLIDES 
A video file can be produced with a camera and editing software.  Sound files can come from the Internet, 
files stored on your computer, or an audio track on a CD.  To hear the sounds, you need a sound card 
and speakers or headphones on your system.  

Once an audio or video clip is inserted into a slide, you can specify options that affect how the file is 
displayed and played.  Follow the steps below to edit a video 
presentation in PowerPoint: 

SLIDE 3 

Step 1. With the u08a1 Spokes demonstration open in 
normal view, CLICK on SLIDE 3 to bring it 
into view.  

Step 2. CLICK on the IMAGE 
Step 3. In the Format Picture Task pane, CLICK 

EFFECTS 
Step 4. CLICK ARTISTIC EFFECTS 
Step 5. OPEN the ARTISTIC EFFECTS MENU 
Step 6. CLICK on CEMENT. This will change the look of the image that will be behind the 

video. 
Step 7. CLICK on the INSERT tab to display the insert ribbon. 
Step 8. CLICK on the VIDEO option location in the media group 
Step 9. CLICK on VIDEO ON MY PC 
Step 10. NAVIGATE to the UNIT-08 folder containing the UNIT 08 Student Files. When 

you open the folder, you may note that there are two videos called Mountain Bike video.  
This is because I found in previous lessons that Mac computers will not read .wmv files.  I 
have changed the original video to .mp4.  A Windows based PC will read both file 
formats.  

Step 11. CLICK on MOUNTAIN BIKE VIDEO.  This will insert the video into Slide 3.  
Step 12. CLICK on the PLAY button to view the video you just inserted. Notice that the bicycle 

does not appear in the video until a few seconds after it starts.  The next step is to trim 
the video. 

Step 13. With the video selected, CLICK the PLAYBACK tab to reveal the playback ribbon. 
Step 14. CLICK on the TRIM VIDEO option in the editing group 
Step 15. SLIDE or DRAG the green marker to the right to change the start time.  
Step 16. START TIME should be approximately 00:05.991 
Step 17. SLIDE or DRAG the red marker to the left to establish the end time. 
Step 18. END TIME should be approximately 00:29.100 
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Step 19. CLICK OK to confirm the change 
Step 20. In the Video Options group, CLICK the START drop-down menu 
Step 21. By default, the menu says In Click Sequence, CLICK to change this to 

AUTOMATICALLY. 
Step 22. CLICK the VOLUME button and change the volume to MEDIUM 

SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

 
CHANGE THE VIDEO VIEW 
Resizing a video clip is very similar to the process used for resizing a picture.   

Step 1. With the u081a Spokes PowerPoint demonstration open in normal view, CLICK 
SLIDE 3 

Step 2. CLICK on the VIDEO to select it. 
Step 3. CLICK the FORMAT option to display the Format ribbon 
Step 4. Resize the VIDEO IMAGE to 5.5” by 9.78”. 
Step 5. With the video still selected, CLICK to expand the VIDEO STYLES menu 
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Step 6. In the Intense group, CLICK REFLECTED PERSPECTIVE RIGHT

 
Step 7. With the video selected, CLICK VIDEO BORDER 
Step 8. Change the LINE WEIGHT to 2 ¼ points 
Step 9. Change the COLOR to YELLOW from the standard colors 

SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 
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ADD ANIMATION TO SLIDES 

Step 1. In the u08a1 Spokes demonstration, DISPLAY SLIDE 2 
Step 2. CLICK on the ANIMATIONS tab to display the Animations ribbon 
Step 3. CLICK on the MAN ON THE BIKE 
Step 4. CLICK on the FLY IN entrance to select an entrance for the man on the bike.  
Step 5. CLICK on the EFFECT OPTIONS 
Step 6. CLICK on the FROM LEFT option.  Notice that you have a demonstration of the 

animation every time you click on a new effect.   

ADD EMPHASIS 

Step 7. With the Man on the Bike selected, CLICK ADD 
ANIMATION on the advanced animation group.  

Step 8. In the Emphasis group CLICK TEETER 

ADD EXIT EFFECT 

Step 9. With the Man on the Bike selected, CLICK ADD 
ANIMATION 

Step 10. In the Exit group, CLICK FLY OUT 
Step 11. CLICK on the EFFECT OPTIONS 
Step 12. CLICK on the TO RIGHT option 

The Man on the Bike should enter from the left, teeter in the middle and exit right.  
Notice that PowerPoint has numbered the animation effects.   
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Step 13. CLICK on the ANIMATION PANE.  This will display the animations you have just 
created.  It also contains additional options you can create with the animations. 

SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

 

MODIFY EFFECTS AND TIMINGS 
To create a dramatic effect, you can change the timing.  The default setting is to start each animation with 
a click, but you can change this setting so that the entrance effect is delayed until a specified number of 
seconds has passed.  

Step 1. With Slide 2 open, CLICK on the ANIMATIONS PANE to view the animations 
created.  

Step 2. SELECT the FIRST ANIMATION (This is an 
entrance effect. It has a green star next to it).  Using 
the timing group, change the effects using the 
following settings: 
a. START: After Previous 
b. DURATION: 2.00 
c. DELAY: 3.00 

Step 3. SELECT the SECOND ANIMATION (This is an emphasis effect. It has a gold star 
next to it).  Notice that after you choose the After Previous option, the number changes.  
This is because the animations are 
linked to each other. Use the timing 
group, to change the effects with of the 
following settings: 
a. START: After Previous 
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b. DURATION: 2.00 
Step 4. SELECT the THIRD ANIMATION (This is an exit effect.  It has a red star next to it.  

Use the timing group, to change the effects with the following settings: 
a. START: After Previous 
b. DURATION: 1.00 

ANIMATE A CONTENT PLACEHOLDER 

Step 5. With SLIDE 2 open, DOUBLE-CLICK the CONTENT 
PLACEHOLER for the bulleted items 

Step 6. CLICK the MORE option in the ANIMATION group 
Step 7. CLICK the FADE entrance effect 

a. START: With Previous 
b. DURATION: 2.00 

Step 8. CLICK on ADD ANIMATION in the advanced animation group 
Step 9. CLICK the MORE option in the ANIMATION group 
Step 10. CLICK the FONT COLOR emphasis effect 
Step 11. In the animation pane, CLICK on the ANIMATION (In the last 

place on the list but numbered 1).  This will activate the effect 
options for the placeholder animation.  

Step 12. In the animation group, CLICK on UNDERLINE 
a. START: With Previous 

SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 
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CHANGE THE THEME AND VARIANT 
To call attention to the material in the bulleted list, on Slide 2 we are going to change the theme of the 
one slide. 

Step 1. Open Slide 2 in normal view, CLICK the DESIGN tab to display the design ribbon 
Step 2. CLICK the MORE option to display the themes 
Step 3. RIGHT-CLICK on RETROSPECT 
Step 4. In the drop-down menu CLICK Apply to Selected Slides 

Step 5. In the list of variants, RIGHT-CLICK the GREEN VARIANT 
Step 6. In the drop-down menu CLICK Apply to Selected Slides 

CHANGE THE THEME COLORS 

Every theme has at least 10 standard colors: two for texts; two for 
backgrounds; and six for accents.  

Step 7. In the VARIANT group, CLICK the MORE 
option 

Step 8. CLICK the COLORS option 
Step 9. CLICK the GREEN color option 

SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

 

ADD AN AUDIO FILE 
If you have a digital recorder or smart phone, you can record sounds to insert into your presentation.  The 
following steps show how to insert and audio clip into slide 1: 
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Step 1. In the normal view of your presentation, 
CLICK on SLIDE 1 to bring it into view 

Step 2. CLICK on the INSERT tab to bring the 
insert ribbon into view 

Step 3. In the media group, CLICK the AUDIO 
option 

Step 4. CLICK AUDIO ON MY PC 
Step 5. Navigate to the Unit 08 Student Files 

folder 
Step 6. CLICK on Peddling Sounds 
Step 7. CLICK INSERT 
Step 8. DRAG the SOUND ICON to lower left corner of the slide 
Step 9. DRAG the Bike Rider under the title and adjust the size 
Step 10. CLICK the AUDIO ICON 
Step 11. CLICK the PLAYBACK tab to bring the playback ribbon into view 
Step 12. In the Audio Options group CHANGE the AUDIO OPTIONS 

a. START: Automatically 
b. LOOP UNTIL STOPPED 
c. HIDE DURING SHOW 

PREVIEW THE SLIDE SHOW 

Step 13. CLICK the SLIDE SHOW option to display the slide show ribbon 
Step 14. In the Start Slide Show group, CLICK FROM BEGINNING 

If you are satisfied with your show, save the file and submit the assignment. 

ASSIGNMENT TO SUBMIT: 

u8a1 Spokes 
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ON YOUR OWN ACTIVITY 

The images, videos and sound files for this activity are in the UNIT 08 Student Files 

Step 2. Run PowerPoint CLICK OPEN OTHER PRESENTATIONS 
Step 3. BROWSE to the UNIT-08 folder OPEN 

UNIT 08 Student Files  
Step 4. CLICK on Lab 3-2 Hummingbirds 
Step 5. CLICK on OPEN 
Step 6. CLICK on ENABLE EDITING (If it 

appears) 
Step 7. HIT F12 on your keyboard 
Step 8. SAVE AS option appears 
Step 9. Navigate to the UNIT-08 folder on your computer.   

a. SAVE using u08a2 Hummingbirds as the file name.  
Step 10. CHANGE the AUDIO FILE  

a. HIGH VOLUME 
b. PLAY ACROSS SLIDES 
c. LOOP UNTIL STOPPED 
d. REWIND AFTER PLAYING 
e. HIDE DURING SHOW 

Step 11. CUT the Humming Bird from SLIDE 2  
Step 12. PASTE the Humming Bird to SLIDE 1 

SLIDE 1 

Step 13. HUMMING BIRD 
a. PLACEMENT: At the bottom right corner next to the feeder 
b. SIZE: 1.7” X 1.87” 
c. ENTRANCE: Fly In  
d. EFFECT: From Top-Right 
e. START TIMING: After Previous 
f. DURATION 2.50 

Step 14. TITLE TEXT 
a. SIZE: 72 pts 
b. EMPHASIS: Bold 
c. COLOR: Red 
d. DECREASE TEXT PLACEHOLDER 

SIZE: 1.65 X 7.62 
e. POSITION: Top of red rectangle 
f. ENTRANCE: Fly in 
g. EFFECT: From Top 
h. START TIMING: After Previous 
i. DURATION: 02.50 

Step 15. RED RECTANGLE 
a. SHAPE FILL: Lime, Accent 1 
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b. SIZE: 1.7 X 6.96 
Step 16. PARAGRAPH 1, 2, 3 Make sure each line is formatted individually.  The lines should 

enter come in one after another. The format is for each line separately.  
a. FONT: 28 pts 
b. EMPHASIS: Bold 
c. ENTRANCE: Appear 
d. START TIMING: After Previous 
e. DURATION: 2.50 

SLIDE 2 

Step 17. VIDEO 
a. MOVE TO: Center of right section 
b. SIZE: 5.84 X 8.2 
c. FORMAT: Beveled Oval 
d. STYLE: Black 
e. BORDER COLOR: Red 
f. BORDER WEIGHT: 3 pt.  
g. TRIM END TIME: 00:17.88 
h. VOLUME: High 
i. START VIDEO: Automatically 

Step 18. TITLE 
a. ENTRANCE: Float 
b. DIRECTION: Down 
c. START TIMING: With Previous 
d. DURATION: 03.00 

SLIDE 3 

Step 19. TITLE 
a. ENTRANCE: Shape 
b. START TIMING: With Previous 
c. DURATION: 3:00 

Step 20. HUMMINGBIRD AND FLOWERS 
a. UNGROUP 
b. FLOWERS FILL COLOR: Red 
c. GREEN LEAVES: Delete (Keep the 

stems) 
d. REGROUP 
e. CHANGE SIZE: 3.14 X 4.85 
f. MOVE FLOWERS: Refer to 

illustration 
Step 21. FLOWER PICTURE 

a. STYLE: Reflected Bevel, White 
b. CHANGE SIZE: 3.1 X 4.17 
c. MOVE: Right side of slide 
d. ENTRANCE: Zoom 
e. START TIMING: On Click 
f. DURATION: 2:00 
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SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

 

ASSIGNMENT TO SUBMIT: 

u8a2 Hummingbirds 
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UNIT 9 - MICROSOFT EXCEL 

Excel is a powerful spreadsheet app that allows users to organize data, complete calculations, make decisions, graph 
data, develop professional-looking reports, publish organized data to the web, and access real-time data from 
websites.  The four major parts of Excel are: 

• WORKBOOKS AND WORKSHEETS – A workbook is like a notebook.  Inside the workbook 
are sheets, each of which is called a worksheet.  Thus, a workbook is a collection of worksheets.  Work 
sheets allow users to enter, calculate, manipulate, and analyze data, such as numbers and text. The terms 
worksheet and spreadsheet are interchangeable. 

• CHARTS – Excel can draw a variety of charts, such as column charts and pie charts.  

• TABLES– Tables organize and store data within worksheets.  For example, once a user enters data into a 
worksheet, an Excel table can sort the data, search for specific data and select data that satisfies defined 
criteria.  

• WEB SUPPORT— Web support allows users to save Excel worksheets or parts of a worksheet in a 
format that a user can view in a browser, so that a user can view and manipulate the worksheet using a 
browser.  Excel web support also provides access to real-time data, such as stock quotes, using web queries.  

Microsoft Office Applications are set with similar features.  The following is a view of the Excel features.  If you 
have used any of the office applications, you may note the similarities: 

 

Step 2. Click New (Choose Blank Workbook) – The next screen you see will contain a 
blank workbook.  This screen contains the following components: 

 

 

  

F. Title Bar  
G. Help Button 
H. Maximize Button 
I. Close Button 
J. Blank Workbook 
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COLUMNS, ROWS AND CELLS 

Every calculation created in Excel references a cell within a worksheet.  The Cell is a reference point of the spot 
where the column and row meet.   

 

OPEN THE EXCEL LESSON FILE 

Your UNIT 09 Student Lesson files contain a startup workbook.  Follow these instructions to access the correct 
file: 

Step 1. OPEN a blank EXCEL WORKBOOK on your computer.  
Step 2. CLICK FILE then choose OPEN 

Step 3. BROWSE to the UNIT 09 Student Lesson Files on the your computer. Click on the 
filename (in this case, Lesson 1a-Excel.xlsx) 

Step 4. CLICK OPEN 
Step 5. If the workbook has opened in Protected view, CLICK on the ENABLE EDITING option.  
Step 6. CLICK the PAGE LAYOUT tab to view the Page Layout ribbon 

Step 7. CLICK the THEMES 
MORE options ARROW  

Step 8. CLICK the OFFICE theme to select it for this document.  
 

SAVE THE WORKBOOK WITH A DIFFERENT NAME 

Step 9. Tap the F12 key on your keyboard to open the Save as dialog box 
Step 10. Select the UNIT-09 folder on your computer 
Step 11. Change the file name to u09a1 Paradise Lakes Resort in the File name area 
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Step 12. Click Save to save the file and close the Save As dialog box 

 

ENTER DATA 

Step 1. CLICK cell A1 and type Paradise Lakes 
Resort 

Step 2. HIT the ENTER key on your keyboard 
Step 3. CLICK cell A10, type Total, and  
Step 4. HIT the ENTER key on your keyboard 
Step 5. Type the values shown to the right in cells 

G5:H9. Pay close attention to the column and 
row numbers where you are entering the data 

USE THE FILL HANDLE TO COMPLETE A SERIES 

Figure 2: Fill Handle 
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Step 6. CLICK cell B4 
Step 7. POINT to the FILL HANDLE (small, black square in the lower right corner) until the Fill 

pointer (thin, black plus sign) appears 
Step 8. CLICK and DRAG the POINTER to reach cell H4 
Step 9. RELEASE the POINTER button. You should see the names of the week fill in automatically.  

This is one of the many auto-fill options available in Excel.  You will be using this feature later in 
the assignments.  To learn more regarding these features, you may be interested in some of the 
online resources and demonstrations available for Excel.   

EDIT WORSHEET DATA 

Step 10. DOUBLE-CLICK cell A4 to start edit mode 
Step 11. Click to position the insertion point and DELETE the “i” in “Categories”(You are creating 

a deliberate spelling error). 
Step 12. TAP ENTER to accept the edit 
Step 13. CLICK A9 and type Aparel with the error (You will correct this later). 
Step 14. PRESS ENTER to replace the entry. 

INDENT AND ALIGN TEXT 

Step 15. SELECT cells A5:A9 this can be done by with 
a click and a drag of your mouse.  Another 
method would be to click on cell A5; hold down 
your shift key; and hit the right arrow on your 
keyboard until you reach cell A9. 

Step 16. CLICK the INCREASE INDENT button 
twice (Home tab, Alignment group) 

Step 17. SELECT cells B4:H4 using the keystroke 
method or the mouse method. 

Step 18. CLICK the CENTER button (Home tab, 
Alignment group)  

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and taping 
the S key.  This is a good habit and keeps you from losing your work. 

 

CUT AND PASTE DATA 

Step 1. SELECT cells B4:H4 
Step 2. CLICK the CUT button (Home tab, Clipboard group) 
Step 3. CLICK I4 (Column I row 4) 
Step 4. Click the Paste button (Home tab, Clipboard group) 
Step 5. Select cells I4:O4 
Step 6. Point to any boarder of the selected range to display a four-pointed arrow with a white arrow 

Figure 3: Increase Indent Button 
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Step 7. Drag the range to start in cell B4 and release the pointer button 
Step 8. Click cell A1 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and taping 
the S key.  This is a good habit and keeps you from losing your work. 

 

CHANGE THE WIDTH OF COLUMNS B THROUGH I 

Step 1. POINT to the COLUMN B heading to display a down-
pointing arrow 

Step 2. CLICK and DRAG to reach COLUMN I. 

Step 3. CLICK the FORMAT button (Home tab, Cells group). 
Step 4. SELECT COLUMN WIDTH from the menu 
Step 5. ENTER 14 in the Column Width dialog box. 
Step 6. CLICK OK to set the row height for both rows. 

 

CHANGE THE ROW HEIGHT (ROWS 4 AND 10): 

Step 7. RIGHT-CLICK the ROW 4 HEADING 
Step 8. Press CTRL and click the ROW 10 HEADING. Two 

rows are selected 
Step 9. RIGHT-CLICK the ROW 4 heading 
Step 10. Choose ROW HEIGHT from the menu. 
Step 11. ENTER 24 as the new height. 
Step 12. CLICK OK to set the row height for both rows.  

  

 

Figure 4: Column Width 
Option (Home Tab, 

  

Figure 5: Changing Row 
Height (select rows first) 
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CENTER TITLES ACROSS A SELECTION 

Step 13. SELECT cells A1:I2 
Step 14. CLICK the ALIGNMENT launcher (Home tab, Alignment group) 
Step 15. CLICK the HORIZONTAL drop-down arrow and choose Center 

Across Selection. 
Step 16. CLICK OK. 

SAVE YOUR UPDATES 
Since the file is already saved you can now save your updates by simply holding down the 
CRTL key and taping the S key.  This is a good habit and keeps you from losing your 
work. 

 

TOTAL USING AUTOSUM: 

If you need to sum a column or row of number, let Excel do the 
math for you.  AutoSum is a powerful feature that can save you 
time if you need to add up cells or columns of data quickly. It is 
often faster than creating a formula by hand, especially when you 
have a large amount of data to add up. 

When you click AutoSum, Excel automatically enters a formula 
(that users the SUM function) to sum the numbers. 

Step 1. CLICK the HOME tab to open the home ribbon 
Step 2. CLICK Cell B10 (we will be inserting the formula 

into this cell). 
Step 3. In the Editing group, CLICK the AutoSum Button 

(Home Tab, Editing Group) 
Step 4. HIT ENTER  

COPY USING THE FILL HANDLE 

Instead of entering data manually on a worksheet, you can use the Auto Fill feature to fill cells with data that follows 
a pattern or that is based on data in other cells.  To quickly fill in several types of 
data series, you can select cells and drag the fill handle 

Step 5. CLICK cell B10 
Step 6. POINT to the FILL HANDLE. The fill handle appears as a 

solid square on the bottom right corner of the cell.  When 
you hover your mouse of the handle, your mouse turns 
into a solid plus.  This signifies that you have selected 
the option to fill the current cell across a column or row 
of cells.  

Step 7. CLICK and DRAG the fill pointer to H10 

AutoSum Button (Home Tab, Editing Group) 

Figure 6: Center Across a 
Selection 

Solid plus sign will appear in this corner 

Fill Handle to Copy Formula 
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Step 8. RELEASE your MOUSE and you will see how the formula or text has been filled using the fill 
handle.  

CALCULATE SALES CATEGORY TOTALS 

Step 9. CLICK cell I4 
Step 10. Type the word Total in the cell 
Step 11. CLICK ENTER 
Step 12. This should put you in cell I5.  If you have navigated away from the cell, CLICK cell I5 
Step 13. DOUBLE-CLICK the AutoSum button (Home tab, Editing Group to accept and complete the 

formula) 

COPY A FUNCTION USING THE FILL HANDLE 

Step 14. CLICK Cell I5 
Step 15. POINT to the FILL HANDLE.  
Step 16. CLICK and DRAG the FILL POINTER to cell I10.  
Step 17. RELEASE your MOUSE and you will see how the formula or text has been filled using the fill 

handle.  

 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and taping 
the S key.  This is a good habit and keeps you from losing your work. 

 

APPLY CELL STYLES 

To apply several formats in one step, and to make sure that cells have consistent formatting, you can use a cell style. 
A cell style is a defined set of formatting characteristics, such as fonts and font sizes, number formats, cell borders, 
and cell shading. To prevent anyone from making changes to specific cells, you can also use a cell style that locks 
cells. 
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Step 1. CLICK cell A1 
Step 2. CLICK the HOME tab to display the home ribbon 
Step 3. In the styles group, CLICK the MORE (bottom right 

corner of the group) button to open the Cell Styles gallery. 

Step 4. CLICK TITLE in the Titles and Headings group 
Step 5. CLICK cell A2 
Step 6. CLICK the CELL STYLES button or the MORE button 
Step 7. SELECT the option for Heading 4 in the Titles and headings group. 
Step 8. SELECT A4:I4.  Sometimes selecting a range of cells is difficult for new users.  If you are having 

difficulty try the alternate method 
 ALTERNATE METHOD: CLICK A4 hold down your SHIFT KEY and HIT the 

RIGHT ARROW button on your keyboard until you have selected through I4 
Step 9. CLICK the CELL STYLES button or the MORE button 
Step 10. SELECT the option for Heading 3 in the Titles and headings group 
Step 11. SELECT cells A10:I10  
Step 12. CLICK the CELL STYLES button or the MORE button 
Step 13. SELECT the Total option in the Titles and Headings group. 

SELECT A SPLIT RANGE OF CELLS 

Step 14. SELECT A4:A10 
Step 15. Press CTRL 
Step 16. SELECT cells B4:I4 to add them to the selection  
Step 17. CLICK the CELL STYLES button or the MORE button 
Step 18. SELECT 20% Accent1 in the Themed Cells Styles category 
Step 19. CLICK cell A1 to deselect cells and view the styles.  

SET COLUMN WIDTH 

Styles Group 
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Step 20. Select Column A: 
 CLICK on the column heading A 
 RIGHT-CLICK your mouse on the letter A to view the shortcut menu 
 CLICK on COLUMN WIDTH 
 SET the width to 30 
 CLICK OK 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and taping 
the S key.  This is a good habit and keeps you from losing your work. 
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APPLY NUMBER FORMATS AND ALIGN THE TEXT 

Step 1. CLICK the HOME tab to display the home ribbon 
Step 2. SELECT cells B5:I9  

 In the number group, CLICK the Comma Style button 
and leave cells B5:I9 selected. 

 In the number group, CLICK the Decrease Decimal 
button TWO TIMES while cells B5:I99 are selected. 

Step 3. SELECT cells B10:I10 
 In the number group, CLICK the Accounting Style 

dollar sign. You may see a series of # symbols in the cells. 
This means the cell is not wide enough for the numbers. 

 In the number group, CLICK the Decrease Decimal 
button TWO TIMES. 

Step 4. SELECT cells B4:I4 
 In the align group, CLICK the Align Right button. Not 

all labels are visible with this alignment setting.  
Step 5. SELECT cell A10. 
Step 6. In the font group, CLICK the B(BOLD) 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and taping 
the S key.  This is a good habit and keeps you from losing your work. 

  

1. Accounting Style 
2. Percent 
3. Comma Style 
4. Increase Decimal 
5. Decrease Decimal 

Number Formats 
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ADD BORDERS 

Step 1. CLICK the HOME tab to display the 
home ribbon  

Step 2. SELECT A5:I9 
Step 3. In the font group, CLICK the 

BORDER button arrow  
Step 4. SELECT the MORE BORDERS 

option (bottom item on the list). 
Step 5. In the LINE STYLE section 

• CLICK the 6th line in the left 
column.  

• CLICK the DOWN ARROW 
for the COLOR selection. 

• CLICK Light Grey, 
Background 2, darker 10% 

Step 6. CLICK inside the Border box to create light grey lines in the areas that don’t already have 
them.  KEEP THE EXISTING TOP AND BOTTOM LINES.  

Step 7. CLICK OK 
Step 8. CLICK your HOME key on your keyboard.  Notice the worksheet now has grey interior lines. 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 
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CHANGE THE THEME AND APPLY FONT ATTRIBUTES 

Step 1. CLICK on the PAGE LAYOUT tab to display the page layout ribbon 
Step 2. CLICK the THEMES button  
Step 3. CLICK on Facet from the theme gallery 
Step 4. SELECT cell A4 

 CLICK the HOME tab to display the home ribbon 
 CLICK the FONT drop-down list  
 CLICK Candra in the Fonts section 
 CLICK the Font Size drop-down list select 16 pt. 
 CLICK the Bold button from the font group  

Step 5. SELECT cells A5:I10 
 Click the Font Size drop-down list and choose 12 pt.   

 

 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

 

ADDING A CLUSTERED CYLINDER CHART TO THE WORKSHEET 

Excel spreadsheets are all about numbers.  But tons of numbers are often not the most effective way to 
communicate.  That’s where charts come in handy.  Charts can display numeric data in a graphical format, making it 
easy to understand large quantities of data and the relationships among data.  

Step 1. CLICK on the INSERT tab to display the insert ribbon 

Step 2. SELECT Range to be charted – A4:H9 
Step 3. In the charts group, CLICK the Recommended Charts 
Step 4. CLICK on the All Charts tab to display the Column gallery 
Step 5. CLICK the 3-D Clustered Column chart type (third option) of the column group 
Step 6. CLICK OK 

Apply Theme 
(Page Layout tab, Theme Group) 

Work Sheet After Theme & Font Changes 
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Step 7. When you click over the chart with your mouse, it will look like a four-pronged arrow. CLICK and 
DRAG the CHART to the desired location on the worksheet. 

Step 8. CLICK and DRAG the SIZING HANDLES to resize the chart. 
Step 9. The CHART SIZE should cover cells B12:H32 

Notice that because we selected the days of the week and the revenue categories, the labels appear in the chart 
legend.  

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 
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FORMAT THE CHART TITLE AND LEGEND 

To format the chart, it needs to be selected.  In your worksheet, make sure you have the chart selected by clicking on 
it.  You will see handles like the image handles you saw in MS Word. We are going to change the chart title.  

Step 1. CLICK on the CHART TITLE and type Paradise Lake 
Resort. You can type this directly into the box to replace the 
words Chart Title or type in the formula bar and hit enter. 

Step 2. RIGHT-CLICK the TITLE 
Step 3. CLICK on the Format Chart Title option at the bottom of 

the short-cut menu that appears. You should see a menu appear to 
the side of your excel sheet.  This menu contains additional 
information to format various elements of the chart.   

Step 4. CLICK Text Options  
Step 5. CLICK Text Effects  

 TEXT FILL: Solid Fill 
• COLOR: Dark Green, Accent 2, Lighter 80% 

 TEXT OUTLINE: Solid Line 
• COLOR: Brown, Accent 6, Darker 50% 
• WIDTH: 1.25 pt 
• COMPOUND TYPE: Double 
• DASH TYPE: Solid 
• CAP TYPE: Round 
• JOIN TYPE: Round 

Step 6. CLICK on the LEGEND. Notice that the menu 
to the right changes to the say “Format Legend”  

Step 7. CLICK on the Legend Options 
 POSITION: Left 
 Show the legend without overlapping the 

chart: Checked 
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Experiment – use the menus to explore the different options available for creating the chart.  Each area has unique 
components that can be used for various chart styles depending on the desired results.   

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 

CHANGING THE WORKSHEET NAME 

Naming sheets can be a very useful tool to identify the contents of the sheet in the workbook.  The sheet tabs can 
also be colored to help identify easily when multiple sheets are used.  Note: when you are changing the color of a 
sheet tab, the new color appears to be white until you select a different sheet in the workbook.   

Step 1. DOUBLE-CLICK the SHEET TAB you wish to change (Sheet 1) in the lower-left corner of the 
window 

Step 2. Type the new worksheet name Cass Lake  
Step 3.  HIT the ENTER key 
Step 4. RIGHT-CLICK the SHEET TAB you just renamed to 

display a shortcut menu 
Step 5. SELECT the TAB COLOR option on the shortcut menu to 

display the color gallery.  
 COLOR: Red, Accent 5, Darker 25% 
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Step 6. CLICK on A DIFFERENT SHEET tab in the workbook in order to view the new color tab you 
have just created. 

ADD FOOTER INFORMATION 

Excel 2019 lets you create customer headers and footers. Most of the time, the stock headers and footers available 
on Excel’s Header button’s and Footer button’s drop-down menus are sufficient for your report-printing needs. 
Occasionally, however, you may want to insert information not available in these list boxes or in an arrangement 
that Excel doesn’t offer in the ready-made headers and footers. 

For those times, you need to use the command buttons that appear in the Header & Footer Elements group of the 
Design tab on the Header & Footer Tools contextual tab in Excel 2019. These command buttons enable you to blend 
your own information with that generated by Excel into different sections of the custom header or footer you’re 
creating. 

In Excel 2019, the command buttons in the Header & Footer Elements group include 

• Page Number: Click this button to insert the &[Page] code that puts in the current page number. 
• Number of Pages: Click this button to insert the &[Pages] code that puts in the total number of pages. 
• Current Date: Click this button to insert the &[Date] code that puts in the current date. 
• Current Time: Click this button to insert the &[Time] code that puts in the current time. 
• File Path: Click this button to insert the &[Path]&[File] codes that put in the directory path along with the 

name of the workbook file. 
• File Name: Click this button to insert the &[File] code that puts in the name of the workbook file. 
• Sheet Name: Click this button to insert the &[Tab] code that puts in the name of the worksheet as shown 

on the sheet tab. 
• Picture: Click this button to insert the &[Picture] code that inserts the image that you select from the Insert 

Picture dialog box that enables you to select a local image (using the From File option) or download one 
from an online source (using the Bing Image Search, OneDrive, or Facebook and Flickr options). 

• Format Picture: Click this button to apply the formatting that you choose from the Format Picture dialog 
box to the &[Picture] code that you enter with the Insert Picture button without adding any code of its own. 

To use these command buttons in the Header & Footer Elements group to create a custom header or footer, 
follow these steps: 

Step 1. Put your worksheet into Page Layout view using one of the following methods:  
• STATUS BAR METHOD: CLICK the PAGE LAYOUT VIEW button on the Status bar  
• RIBBON TAB METHOD: CLICK on the VIEW tab to display the view ribbon 

o In the Workbooks Views Group, CLICK on the PAGE LAYOUT View  
• KEYSTROKE METHOD: ALT+WP.  

Step 2. In Page Layout view, the text CLICK to Add Header appears centered in the top margin. 
Step 3. CLICK inside the RIGHT SECTION of the HEADER.  The Header & Footer Tools will appear 

in the ribbon.  
Step 4. Type Your Name 
Step 5. HIT ENTER to move your cursor below your name 
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Step 6. CLICK on the CURRENT DATE option in the headers and footers elements group.   

 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

 

SPELL CHECK YOUR DOCUMENT 

Step 1. Hold down your CTRL key and TAP the HOME button on your keyboard.  This will automatically 
take you to cell A1 of the document.  

Step 2. CLICK the REVIEW tab to display the review ribbon 

Step 3. In the proofing group, CLICK the SPELLING option 
Step 4. Choose the appropriate spelling for the misspelled words in the work sheet. 
Step 5. Click Change Repeat until you have finished with the worksheet and Spell check is complete 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

ASSIGNMENT TO SUBMIT: 

u09a1 Paradise Lakes Resort 
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ON YOUR OWN ACTIVITY 

Your UNIT 09 Student Lesson files contain a startup workbook.  Follow these instructions to access the correct 
file: 

OPEN THE EXCEL LESSON FILE 

Step 1. Run Excel CLICK the FILE tab 
Step 2. CLICK OPEN  
Step 3. BROWSE to the UNIT-09 folder OPEN the UNIT 09 Student Files  
Step 4. CLICK on Lesson 1b-Excel 
Step 5. CLICK OPEN 
Step 6. CLICK F12 
Step 7. SAVE the file AS u09a2 Sable River Foundation 

COLUMN WIDTHS AND ROW HEIGHTS 

Step 8. COLUMNS A, B, C, D, E, F, G, H width: 15 
Step 9. ROWS 3 and 9 height: 30 

CELL STYLES AND THEME 

Step 10. Cells A1:H1 
 HORIZONTAL ALIGNMENT: CENTER ACROSS SELECTION 
 CELL STYLE: TITLE 

Step 11. Cells A2:H2 
 HORIZONTAL ALIGNMENT: CENTER ACROSS SELECTION 
 CELL STYLE: HEADING 1 

Step 12. Cells A3:H3 
 CELL STYLE: HEADING 2 

Step 13. Cells A9:H9  
 CELL STYLE: TOTAL 

Step 14. Cells A4:A8 and A3:H3 
 CELL STYLE: 20%-Accent 1 

Step 15. Change the Theme to ION 
Step 16. ROW 3  

 FONT: BOLD 
 ALIGNMENT: RIGHT 

Step 17. CELLS H4:H8 
 FONT: BOLD 

NUMBER FORMATS 

Step 18. HIGHLIGHT Cells B4:G8 > Home Ribbon Band >Number >Comma Style 
Step 19. HIGHLIGHT Cells B9:H9 > Home Ribbon Band >Number >Accounting  
Step 20. HIGHLIGHT Cells H4:H8 > Home Ribbon Band >Number >Accounting  
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TOTAL USING AUTOSUM: 

Step 21. Place your cursor in CELL H4 
Step 22. HIT the AutoSum button  
Step 23. HIT ENTER 
Step 24. Place your cursor in CELL B9 
Step 25. HIT the AutoSum button 
Step 26. HIT ENTER 

COPY USING THE FILL HANDLE 

Step 27. Place your curser in CELL H4 
Step 28. Hover over the bottom right corner of the cell with your mouse until the mouse pointer turns to a 

solid plus sign.  Then CLICK and DRAG your mouse DOWN TO CELL H8.  This will 
initiate the auto fill option. 

Step 29. Place your curser in CELL B9 
Step 30. Use the AutoFill to H9.  This will fill the formulas for the totals across the bottom of the page.  

ADD A 3-D CLUSTERED COLUMN CHART TO THE WORKSHEET 

Step 31. SELECT RANGE to be charted – A3:G8 
Step 32. CLICK the Recommended Charts> All Charts to display the Column gallery 
Step 33. CLICK the 3-D Clustered Column chart type (third option) of the column group to add the 

selected chart to the middle of the worksheet in a rectangle. 
Step 34. DRAG the CHART BORDER to CELL B11 
Step 35. DRAG the SIZING HANDLES to resize the chart into B11:H31 

Step 36. Type Sable River Foundation as the chart title 

Step 37. MOVE the LEGEND to the RIGHT of the chart 

CHANGE THE WORKSHEET NAME 

Step 38. DOUBLE-CLICK the sheet tab you wish to change (Sheet 1) in the lower-left corner of the 
window 

Step 39. Type the new worksheet name, Lifetime Fundraising Company. 
Step 40. HIT the ENTER key 

Step 41. Change the sheet tab color to Purple Accent 6, Darker 25% 

HEADER AND FOOTER 

Step 42. Add YOUR NAME to the RIGHT PANEL of the header 
Step 43. INSERT the DATE code below your name 

PAGE LAYOUT 

Step 44. CLICK the PAGE LAYOUT option.  
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Step 45. Set the PAGE SETUP to print Landscape 
Step 46. OPEN the Page Setup dialog box 
Step 47. CLICK the FIT TO: 1 option 
Step 48. Check your spelling and fix any errors

 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

ASSIGNMENT TO SUBMIT: 

u09a2 Sable River Foundation 
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UNIT 10 - RELATIVE, ABSOLUTE, AND MIXED CELL REFERENCES 

Spreadsheets provide important tools to business managers and owners. They can be used 
for inventory purposes or for calculating prices and other types of record-keeping. 
Spreadsheets have several built-in tools that can be used for various types of calculations. 
One of these tools is the absolute formula or absolute reference formula. 

There are three types of references that can be used in Excel and Google spreadsheets. 
They are easily identified by the presence or absence of dollar signs ($) within the cell 
reference: 

 

• RELATIVE CELL REFERENCES contain no dollar signs - as shown in the 
formula in row 2: = A2 + A4; 

• ABSOLUTE CELL REFERENCES have dollar signs attached to each letter or 
number in a reference - as shown in the formula in row 4: =$A$2+$A$4; 

• MIXED CELL REFERENCES have dollar signs attached to either the letter or 
the number in a reference but not both - as shown in the formula in row 5: 
=$A2+A$4. 

The general purpose of an absolute formula in Microsoft Excel or most other common 
spreadsheet programs is to provide a fixed reference point by which various calculations 
can be performed. This is done by simply putting a "$" in front of the cell value you want 
to use as the fixed reference point. For instance, a formula containing the cell reference 



  

~ 194 ~ 

 

"$A$5" differs from one that reads "A5." The "$" designation indicates that any other 
formulas containing that reference point back to that specific cell and its value, when you 
copy the cell. If the reference is "A5," it is a relative formula, and the spreadsheet will 
automatically adjust the formula using its default programming. 

OPEN AND SAVE THE LESSON FILE 

Your UNIT 10 Student Lesson files contain a startup workbook.  Follow these instructions to access the correct 
file: 

Step 1. OPEN a blank EXCEL WORKBOOK on your computer.  
Step 2. CLICK FILE then choose OPEN 

Step 3. BROWSE to the UNIT 10 Student Lesson Files on your computer. Click on the filename 
(in this case, Lesson 2-Excel.xlsx) 

Step 4. CLICK OPEN 
Step 5. If the workbook has opened in Protected view, CLICK on the ENABLE EDITING option.  
Step 6. CLICK the PAGE LAYOUT tab to view the Page Layout ribbon 

Step 7. CLICK the THEMES 
MORE options ARROW  

Step 8. CLICK the OFFICE theme to select it for this document.  
 

SAVE THE WORKBOOK WITH A DIFFERENT NAME 

Step 9. Tap the F12 key on your keyboard to open the Save as dialog box 
Step 10. Select the UNIT-10 folder on your computer 
Step 11. Change the file name to u10a1 Mobile Masses in the File name area 
Step 12. CLICK SAVE to save the file and close the Save As dialog box 

FORMAT AS TABLE 

Clicking the Format as Table command button opens its rather extensive Table Styles 
gallery with the formatting thumbnails divided into three sections — Light, Medium, and 
Dark — each of which describes the intensity of the colors used by its various formats. 
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As soon as you click one of the table formatting thumbnails in this Table Styles gallery, 
Excel makes its best guess as to the cell range of the data table to apply it to (indicated by 
the marquee around its perimeter).  

Step 1. CLICK the HOME tab to display the home ribbon 
Step 2. SELECT the table to be formatted CELLS A3:J13 
Step 3. In the styles group, CLICK the FORMAT AS TABLE option 
Step 4. In the Medium group, CLICK the option for BLUE, TABLE 

STYLE MEDIUM 6 a dialog box will popup asking if you table has 
headers.  

Step 5. CLICK the check box for MY TABLE HAS HEADERS 
Step 6. CLICK OK 

The table will appear with arrows pointing down next to each 
column heading.  These are called filters.  We won’t be using 
them for this exercise.  Follow these steps to turning the filters 
off:  

Step 7. CLICK the DATA tab to display the Data Ribbon 
Step 8. In the Sort & Filter group, you will notice the 

highlighted filter icon.  CLICK on FILTER to 
turn the filter off.   

Step 9. CLICK on ROW 3 to select it 
Step 10. CLICK on the HOME tab to reveal the Home 

Ribbon 
Step 11. In the Alignment Group, CLICK on the WRAP TEXT option 
Step 12. CLICK on COLUMNS D and E 
Step 13. In the Cells Group, CLICK on the FORMAT option 
Step 14. CLICK on COLUMN WIDTH 
Step 15. ENTER the number 10 for the new column width 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 

  



  

~ 196 ~ 

 

TEXT ALIGNMENT, SIZE AND STYLE 

Step 1. CLICK on the HOME TAB to activate the home ribbon band 

SELECT CELLS A1:J2 

Step 2. In the alignment group, CLICK the ALIGNMENT 
DIALOG BOX icon to open the dialog box. 

Step 3. In the Text alignment group, CLICK on the 
HORIZONTAL options 

Step 4. CLICK on CENTER ACROSS SELECTION 
Step 5. In the STYLES group, CLICK on the MORE 

option  
Step 6. CLICK on TITLE to choose the title style 
Step 7. CLICK on CELL A2 
Step 8. CHANGE the FONT SIZE to 14 

SELECT CELLS A13:J13  

Step 9. In the STYLES group, CLICK on the MORE option  
Step 10. CLICK on TOTAL to choose the total style 
Step 11. CLICK ROW 13 to select the entire row 
Step 12. Change the ROW HEIGHT to 20 

SELECT CELLS A14:A21 

Step 13. Increase INDENT ONCE 
Step 14. FONT: BOLD 
Step 15. SIZE: 14 
Step 16. CLICK COLUMN A to select the entire 

column 
Step 17. Change the COLUMN WIDTH to 25 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work. 
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CREATE CONDITIONS FOR ABSOLUTE REFERENCES 

Step 1. CLICK Cell B19  
 Type 30%  
 HIT ENTER 

Step 2. CLICK Cell B20 
 Type 24.32  
 HIT ENTER 

Step 3. CLICK Cell B21  
 Type 13%  
 HIT ENTER 

THE MATH BASICS OF EXCEL 

The backbone of Excel is its ability to perform calculations. There are two ways to set up 
calculations in Excel: using formulas or using functions. Formulas are mathematical 
expressions that you build yourself. You need to follow proper math principles to obtain 
the expected answer. Building the formula is simply a matter of combining the proper cell 
addresses with the correct operators in the right order. This module will explore how to 
build, edit, and copy formulas.  

ARITHMETIC OPERATORS 
 
+   Plus Sign - Adds values 
-  Minus Sign - Subtracts values 
*  Asterisk - Multiplies values 
/  Forward slash - Divides values 
%   Percent sign - Finds the percentage of a value 
^   Caret - Exponentiation - Finds the exponential value 
 
COMPARISON OPERATORS 
=   Equals sign - Equates values 
>   Greater than sign - Indicates that one value is greater than the other 
<   Less than sign - Indicates that one value is less than the other 
>=  Greater than or equal to - Indicates that one value is greater than or equal to the other 
<=  Less than or equal to - Indicates that one value is less than or equal to the other 
<>   Not Equal - Indicates that values are not equal 
  
Text concatenation allows you to combine text from different cells into a single piece of text. The operator is 
the &sign. 
The reference operators combine a range of cells to use together in an operation. The reference operators are: 
 
:   Colon - A Range operator that produces a reference to all the cells between the references on either side of the colon 
,    Comma - A Union operator that combines multiple range references 
<space> - An intersection operator that returns a reference to the cells common to the ranges in the formula 
 

SAVE YOUR UPDATES 
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Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 

FORMULA 1: GROSS PAY = HOURLY PAY RATE * HOURS WORKED 

To start this formula, you will be clicking on the blank cell representing gross 
pay for the employee. Because we used the table feature in Excel, the 
formulas automatically contain the names of the cells that you click on.  DO 
NOT TYPE THE CELL REFERENCES! Follow these steps to complete 
the formula: 

Step 1. CLICK on CELL F4 (this cell represents the Gross Pay) 
 TAP = on your keyboard to start the formula 
 CLICK on CELL D4 
 TAP * on your keyboard to enter the multiplication 

symbol 
 CLICK on CELL E4 
 HIT your ENTER key 

FORMULA 2: FEDERAL TAX PAID = FEDERAL TAX * (GRO SS PAY-DEPENDENTS *  PER DEPENDENT )  

This formula is complicated in that it refers to the table at the bottom of the spreadsheet representing the absolute 
conditions. Because we used the table feature in Excel, the formulas automatically contain the names of the cells 
that you click on.  DO NOT TYPE THE CELL REFERENCES! Follow these steps to complete the formula: 

Step 2. CLICK on CELL G4 (this cell represents the Federal Tax Paid) 
 TAP = on your keyboard to start the formula 
 CLICK on B19 (cell represents the Federal Tax percentage) 
 HIT your F4 FUNCTION KEY,  to make the cell reference absolute 
 TAP * and type ( on your keyboard 
 CLICK on F4 (cell representing gross pay) 
 TAP – on your keyboard number pad 
 CLICK on C4 (cell represents the number of dependents) 
 TAP * on your keyboard number pad 
 CLICK on B20 (cell represents amount allowed per dependent) 
 HIT your F4 FUNCTION KEY to make the reference absolute 
 TAP ) on your keyboard 
 HIT your ENTER key to complete the formula 

FORMULA 3: STATE TAX PAID = STATE TAX * GROSS PAY 

Step 3. CLICK on CELL H4 (this cell represents the State Tax Paid) 
 TAP = on your keyboard to start the formula 
 CLICK on B21 (cell amount representing the State Tax percentage) 
 HIT your F4 FUNCTION KEY, to make the cell reference absolute 

IMPORTANT NOTICE! 

When you finish the formula in the 
first cell of the column, the 
formulas for the entire column are 
entered automatically.  This is 
because the table feature was 
applied.   

Excel assumes all the items in the 
column should have the same 
formula.  
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 TAP * on your keyboard 
 CLICK on F4 (cell representing gross pay) 
 HIT your ENTER key to complete the formula 

FORMULA 4: NET PAY = GROSS PAY – (FEDERAL TAX PAID + STATE TAX PAID) 

Step 4. CLICK on CELL I4 (this cell represents the Net Pay) 
 TAP = on your keyboard to start the formula 
 CLICK on F4 (the cell on this row representing the Gross Pay) 
 TAP – on your keyboard to signify subtraction 
 Type ( on your keyboard to start a formula enclosed in parenthesis 
 CLICK on G4 (the cell on this row representing the Federal Tax Paid) 
 TAP + on your keyboard to signify addition 
 CLICK on H4 (the cell on this row representing the State Tax Paid) 
 Type ) on your keyboard 
 HIT your ENTER key to complete the formula 

FORMULA 5: TAX % =(FEDERAL TAX PAID + STATE TAX PAID)/GROSS PAY 

Step 5. CLICK on CELL J4 (the cell represents the Tax %) 
 TAP = on your keyboard to start the formula 
 Type ( on your keyboard to start a formula enclosed in parenthesis 
 CLICK on G4 (the cell representing the Federal Tax Paid) 
 TAP + on your keyboard to signify addition 
 CLICK on H4 (the cell representing the State Tax Paid) 
 Type ) on your keyboard to close the parenthesis 
 TAP / on your keyboard to signify division 
 CLICK on F4 (the cell representing the Gross Pay) 
 HIT your ENTER key to complete the formula 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 

 

SUM, AVERAGE, MAXIMIMUM AND MINIMUM 

The AVERAGE, MAX (for maximum), and MIN (for minimum) functions in Excel 2019 are the most 
commonly used of the statistical functions because they are of use to both the average number cruncher 
as well as the dedicated statistician. All three functions follow the same syntax as the good old SUM 
function. 

CALCULATE THE SUM 
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Step 1. CLICK on the HOME TAB to display the home ribbon 
Step 2. CLICK in cell D13  

 In the editing group, CLICK the AutoSum Button 
 HIT ENTER 

CALCULATE THE AVERAGE 

The AVERAGE function computes the arithmetic mean of the values in this range 
by summing them and then dividing them by the number of values in the range. 
This AVERAGE function is equivalent to the following formula: 

Step 3. CLICK on the HOME TAB to display the home ribbon 
Step 4. CLICK in cell D14  

 In the editing group, CLICK the MORE option 
next to AutoSum 

 CLICK on the Average option 
 Notice that the default selection includes the sum 

you just calculated. Be careful to adjust the range to 
calculate the average correctly.  CLICK D4 and 
highlight down to D12.  You should now have 
dancing ants around the range of D4:D12 

 HIT the ENTER key 

CALCULATE THE MAXIMUM (HIGHEST) 

The Excel MAX function returns the largest numeric value in a range of values. The MAX function ignores 
empty cells, the logical values TRUE and FALSE, and text values. 

Step 5. CLICK on the HOME TAB to display the home ribbon 
Step 6. CLICK in cell D15  

 In the editing group, CLICK the MORE option next to 
AutoSum 

 CLICK on the Max option 
 Notice that the default selection includes the sum and the 

average you just calculated. Be careful to adjust the range to 
calculate the maximum correctly.  CLICK D4 and 
highlight down to D12.  You should now have dancing ants 
around the range of D4:D12 

 HIT the ENTER key 

CALCULATE THE MINIMUM (LOWEST) 

The MIN Excel function is used to find out the minimum value from a given set of data/ array.  It returns 
the minimum value from a given set of numeric values. It will count numbers but ignore empty cells, text, 
the logical values TRUE and false, ant text values.  It can be used to calculate the minimum salary of the 
employee, the minimum time/score lowest expense or revenue amount, etc.  



  

~ 201 ~ 

 

Step 7. CLICK on the HOME TAB to display the home ribbon 
Step 8. CLICK in cell D16  

 In the editing group, CLICK the MORE option next to AutoSum 
 CLICK on the Min option 
 Notice that the default selection includes the sum, 

average, and maximum you just calculated. Be careful to 
adjust the range to calculate the maximum correctly.  
CLICK D4 and highlight down to D12.  You should 
now have dancing ants around the range of D4:D12 

 HIT the ENTER key 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 

 

COPY FORMULAS AND FORMAT NUMBERS 

The AutoFill (or fill) handle looks like this — + — and appears only when you position the mouse on the 
lower-right corner of the active cell (or the last cell, when you’ve selected a block of cells). If you drag a 
cell selection with the white-cross mouse pointer rather than the AutoFill handle, Excel simply extends the 
cell selection to those cells you drag through. If you drag a cell selection with the arrowhead pointer, 
Excel moves the cell selection. 

Step 1. SELECT CELLS D13:D16 

Step 2. Hover over the bottom right corner of the cell with your mouse until the mouse pointer turns to a solid 
plus sign.  Then CLICK and DRAG your mouse ACCROSS to CELLS J13:J16.  This will 
initiate the auto fill option.  

Step 3. RELEASE your MOUSE button to view the formulas in the cells.  

FORMAT DATES  

In Excel, a date is the number of days since 01/01/1900 (which is the first date in Excel). A number is a 
date in Excel; the software uses a very simple approach to manage dates: imagine a line number from 1 
to 2,958,465: number 1 is January 01 1900 and number 2,958,465 is December 31 9999. This serial 
number system (1 to 2,958,465) is called the Excel Date-Time Code. 

Step 4. CLICK the HOME TAB to reveal the home ribbon 
Step 5. SELECT Cells B4:B12 
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 In the number group, CLICK to OPEN the number 
DIALOG BOX 

 In the Category area, CLICK the DATE option 
 Scroll through the different date options.  These are all 

different formats that can be used for the date.  In the TYPE 
box choose 14-Mar-12.  This is just an example of the 
format.  The actual dates represented by the numbers will 
appear.  

 

NUMBERS SHOWING SIMILAR FORMATS 

When you are working with accounting principles, it is best to have your 
decimals align in the columns.  This next exercise will help format 
consistency in the Hours Worked and Hourly Pay Rate columns.  

Step 6. CLICK the HOME TAB to reveal the home ribbon 
Step 7. SELECT Cells D4:E16 

 In the number group, CLICK to OPEN the number 
DIALOG BOX 

 In the Category area, CLICK the NUMBER option 
 DECIMAL PLACES: 2 
 NEGATIVE NUMBERS: (1234.10)  
 CLICK OK 

ACCOUNTING FORMAT RULES 

Although word processing and spreadsheet programs provide a specific accounting number format, 
practices vary by company. Sometimes the power of company culture and habit overpowers the 
convenience of software standards. Because of this, many companies maintain a standard for accounting 
number formatting that's slightly different than the software default. Mismatched number formats can look 
unprofessional, so compare notes with staff and managers before choosing a format. These are some 
common formatting rules to follow: 

• DESCRIPTIONS - All amounts, including totals, should have a description 
• FIRST ROW - Amounts at the top of each column should have dollar signs 
• TOTALS - Totals should be double-underscored and have dollar signs. 

Even though many of the amounts on the spreadsheet represent currency, it is not standard practice to 
use dollar signs on every entry.  The dollar signs are reserved for the first row of 
currency and the totals.  

FORMATTING COMMA STYLE 

Step 8. CLICK the HOME TAB to reveal the home ribbon 
Step 9. SELECT Cells F5:I12 

 In the number group, CLICK to COMMA STYLE  

Dialog Box 
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ACCOUNTING STYLE FORMAT 

Step 10. CLICK the HOME TAB to reveal the home ribbon 
Step 11. SELECT Cells E4:I4 

 In the number group, CLICK on the Accounting Style 
icon, (the DOLLAR SIGN). 

Step 12. SELECT Cells E13:I16 
 In the number group, CLICK on the Accounting Style 

icon, (the DOLLAR SIGN). 
 If your formatting shows a series of hash marks #######, it means the column needs to be 

wider for the content of the cell.  Adjust your column width where necessary.  

PERCENTAGES 

Currently the numbers in column J are displayed in decimal fraction form.  They should be displayed as 
percentages.  These are the steps to completing that process: 

Step 13. CLICK the HOME TAB to reveal the home ribbon 
Step 14. SELECT Cells J4:J16 

 In the number group, CLICK on the PERCENT SYMBOL icon  

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 

EDIT THE WORKSHEET 

The formula in J13 is not necessary.  Follow these directions to edit the contents of the cell. 

Step 1. CLICK on CELL J13 
 TAP your DELETE key on your keyboard 

CONDITIONAL FORMATTING 
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Step 2. CLICK the HOME TAB to reveal the home ribbon 
Step 3. SELECT CELLS D4:D12 

 In the Styles group, CLICK on CONDITIONAL 
FORMATTING 

 CLICK on HIGHLIGHT CELLS RULES 
 CLICK the GREATER THAN. . . option 
 Type 65 as the number 
 In the with drop-down menu CLICK CUSTOM 

FORMAT… 
 CLICK on the tab for FILL 
 CLICK on the LIGHT GOLD (Gold Accent 4, Lighter 80%) 

on the color theme pallet  
 CLICK on the tab for FONT 
 CLICK on the DARK ORANGE (Orange Accent 2, Darker 50%) on the color theme 

pallet 
 CLICK OK to end the custom color menu 
 CLICK OK to confirm your custom format 
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CHANGE THE THEME 

Since this spreadsheet is made of entirely theme colors and fonts, you can easily change the look of the 
sheet by changing the document theme.  Follow these steps: 

Step 4. CLICK the PAGE LAYOUT TAB to reveal the page layout ribbon 
Step 5. In the themes group, CLICK on SLICE as the new theme

 

FLASH FILL 

Flash fill is a feature that was introduced in Excel 2013.  Earlier versions of the program do not have the 
feature available.  It is a very useful feature in that Excel recognizes patterns in the data and 
automatically fills or formats the remaining cells.  For example, if column A contains a list of 10 phone 
numbers without parentheses around the area code or dashes after the prefix, Flash Fill can help create 
formatted phone numbers with relative ease.  To illustrate this feature in the Mobile Masses worksheet, 
follow these steps: 

Step 6. CLICK on the HOME TAB to reveal the home ribbon 
Step 7. CLICK in K3.  Because the table we are using, is using the table feature, when you type 

a word in K3 it will automatically become a header for the row. 
 Type the word Email in the cell 

Step 8. CLICK in K4.  The idea here is to start a series that Excel will 
recognize.  We are going to assume that each of the employees on 
the list have a company email address.  The domain for this email is 
@mmass.com.  Excel is to find the pattern in the employee name 
that generates an email address using the employee 
firstname@mmass.com 
 Type Emily@mmass.com 
 TAP your ENTER key 
 RIGHT-CLICK on K4 
 In the shortcut menu that appears, CLICK on REMOVE 

HYPERLINK 
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 With K4 selected, CLICK the FILL option in the editing group.  This will reveal a 
drop-down menu.   

 CLICK on FLASH FILL at the bottom of the menu.  The 
email address for each employee should automatically fill with 
the first name of the employee and the domain name for the 
email address.  

ADJUST COLUMN WIDTH 

Whenever you add information such an email address to a column the width of the 
column will vary depending on the longest entry in the column.  There are several 
ways to expand columns.  On way is to simply double click the separator between the 
columns.  In this case it would be a double-click between the K and the L column 
letters.  There is a menu driven option as well.  This is how to change the column 
using the menu option. 

Step 9. CLICK on the HOME TAB to reveal the home ribbon 
Step 10. CLICK on the COLUMN K heading 
Step 11. In the cells group, CLICK on the FORMAT option to reveal the 

format drop-down menu 
Step 12. CLICK on the AutoFit Column Width option 

 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 

COPY A CHART TO A WORKSHEET 

Excel charts can exist in two states: as an embedded object in a worksheet, floating above the worksheet grid, or, in 
a worksheet all by themselves. In this lesson, we'll look at how to move charts from one state to another. 

Normally, when you choose a chart type on the ribbon, Excel creates an embedded chart, which floats over the 
worksheet grid below. 
 
But if you're short on space, or, if you'd just rather have the chart in its own worksheet, you can easily do so. Follow 
these instructions: 
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Step 1. CLICK on the INSERT TAB to display the insert ribbon band.  
Step 2. SELECT cells A3:A12 
Step 3. Hold down your CTRL key.  This will enable you to select a split 

range.  SELECT cells I3:I12 
 In the Charts group, CLICK on the RECOMMENDED 

CHARTS option 
 CLICK on the ALL CHARTS tab 
 CLICK on PIE to display the pie chart options 
 CLICK on the 3-D PIE option (second on the list) 
 CLICK on the OK button 

Step 4. The chart appears embedded into the worksheet.  With the chart still selected, CLICK on the Chart 
Tools DESIGN tab. 
 In the Location group, CLICK on the MOVE CHART option 
 CLICK on the NEW SHEET option 
 Type Employee Net Pay for the sheet tab name 
 CLICK on the OK button  

Step 5. CLICK on the CENTER of the CHART to select the categories 
 CLICK the PLUS SIGN in the right top corner of the chart 
 CLICK the option called DATA LABELS  
 CLICK on the MORE options for Data Labels 
 CLICK on the OUTSIDE END option the 

have the labels appear on the outside of the chart.  

IMPORTANT NOTES:  

 SHEET NAME – The new chart appears on a separate sheet called 
Employee Net Pay. 

 CHART TITLE –The chart title came in automatically.  This is because when we choose the second range in 
step 3 it included the header row with the title representing the data charted.   
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 LEGEND – The legend of the chart appears at the bottom because the range you selected in step 2 included the 
employee names.  

 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 

WORKSHEET NAME, POSITION AND PRINT SETTINGS 

Step 1. DOUBLE-CLICK the SHEET TAB you wish to change (Sheet 1) in the lower-left corner of 
the window 

Step 2. Type the new worksheet name Biweekly Payroll Report 
Step 3. TAP the ENTER key 
Step 4. RIGHT-CLICK the SHEET TAB you just renamed (Biweekly Payroll Report) to display a 

shortcut menu 
 POINT to TAB COLOR on the shortcut menu to display the color gallery.  
 CLICK the DESIRED COLOR to change the color of the tab.  

Step 5. RIGHT-CLICK the SHEET TAB for the sheet containing the chart (Employee Net Pay) 
 POINT to TAB COLOR on the shortcut menu to display the color gallery.  
 CLICK the DESIRED COLOR (different from the Biweekly Payroll Report) to change 

the color of the tab.  
 CLICK and DRAG on the SHEET TAB to the right side of the Biweekly Payroll 

Report.  This will put the chart after the report in the workbook.  
Step 6. CLICK on a BLANK WORKSHEET TAB (Sheet 2 or 3) to select.  You should see both 

newly colored sheet tabs in their selected colors.

 

GROUP THE WORKSHEETS 
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You can quickly perform tasks on multiple worksheets at the same time by grouping worksheets together. If you 
group a set of worksheets, any changes you make on one worksheet are made in all the other worksheets in the 
group in the exact same location on the worksheets. If you want to create, for example, standard tables or 
calculations on a large number of worksheets, grouping can save you a lot of time. This works best if the worksheets 
already have identical data structures. 

Step 7. CLICK on the SHEET TAB for the Biweekly Payroll Report 
Step 8. Hold down your CTRL key CLICK on the SHEET TAB for the Employee Net Pay

 
Step 9. CREATE the FOOTER with both sheets selected 

HEADER/FOOTER OPTIONS 

Step 7. Put your worksheet into Page Layout view using one of the following methods:  
• STATUS BAR METHOD: CLICK the PAGE LAYOUT VIEW button on the Status bar  
• RIBBON TAB METHOD: CLICK on the VIEW tab to display the view ribbon 

o In the Workbooks Views Group, CLICK on the PAGE LAYOUT View  
• KEYSTROKE METHOD: ALT+WP.  

Step 8. In Page Layout view, the text CLICK to Add Footer appears centered in the bottom margin. 
Step 9. CLICK inside the RIGHT SECTION of the FOOTER.  The Header & Footer Tools will appear 

in the ribbon.  
Step 10. Type Your Name 
Step 11. HIT ENTER to move your cursor below your name 
Step 12. CLICK the DESIGN TAB to display the Design Ribbon for the Header & Footer Tools 
Step 13. In the Header & Footer Elements Group, CLICK on the SHEET NAME option.  This will display 

the sheet tab below your name on both sheets. 

PAGE LAYOUT 

With the sheets still grouped, change the page layout print settings by following these directions: 

Step 14. CLICK the PAGE LAYOUT tab to select the Page Layout ribbon 
Step 15. In the Page Setup, CLICK the ORIENTATION option 
Step 16. CLICK on LANDSCAPE 
Step 17. In the Scale to Fit group, the settings should be WIDTH: 1 page, HEIGHT: 1 page 
Step 18. CLICK on the FILE tab to display the file options 
Step 19. CLICK on PRINT to view the print settings for the sheets 
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NOTICE: Because both sheets are in the print view you have the option to advance onto the next sheet in the view.  

UNGROUP SELECTED WORKSHEETS 

It is important that after you have grouped worksheets they are ungrouped.   

Step 20. KEYSTROKE METHOD: Press and hold the CTRL key and CLICK the worksheet tabs 
you want to ungroup.  

Step 21. SHORTCUT MENU: RIGHT-CLICK the GROUPED SHEETS 
 CLICK the UNGROUP option 

CHECK YOUR CHART 

Pull a print preview for the chart.  If it does not have a footer, the option did not work properly.  Follow 
these steps to complete the process: 

Step 1. Click the Chart sheet to make it in an active view.   
Step 2. CLICK the PAGE LAYOUT tab to select the Page Layout ribbon 
Step 3. CLICK the Dialog box for the PAGE SETUP 

 
Step 4. In the Header/Footer option, CLICK CUSTOM FOOTER 
Step 5. Type Your Name 
Step 6. HIT ENTER to move your cursor below your name 
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Step 7. CLICK on the SHEET TAB option.  Excel will insert the correct code 

 
Step 8. CLICK OK to confirm your selection 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL 
key and taping the S key.  This is a good habit and keeps you from losing your work. 

ASSIGNMENT TO SUBMIT: 

U10a1 Mobile Masses 

ON YOUR OWN ACTIVITY 

Step 1. Run Excel and create a NEW BLANK WORKBOOK.   
Step 2. Worksheet Title - Enter the worksheet title, Kattie’s Kicks, in cell A1 and the worksheet subtitle, 

First Quarter Review Analysis in cell A2.  
Step 3. Change the Theme – Change the Theme of the document to Facet 
Step 4. Beginning in row 4, enter the region data shown in the following table: 

 North South East  West 
Sneakers 72714.58 77627.29 76607.31 49008.32 
Shoes 45052.23 69165.66 76243.41 84844.01 
Sandals 77630.94 78684.24 56601.25 72716.68 
Accessories 65423.73 77690.69 58383.67 54433.07 
Miscellaneous 55666.92 78618.97 47317.09 68594.40 

Step 5. SAVE AS – u10a2 Kattie Kicks 
Step 6. Enter Labels – F4 and A10 Enter the word Total 
Step 7. AutoSum – Using the auto sum feature, create totals for each region, product, and company grand 

total 
 HINT- The sums will appear in Column F and Row 10 

Step 8. Title – Format the worksheet title with the Title cell style. Center the title across columns A through 
F. 

Step 9. Subtitle – Format the worksheet subtitle to 16-point Calibri Light, and change the font color to Blue-
Gray, Text 2.  Center the subtitle across columns A through F. 
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Step 10. Heading 3 – Use cell styles to format the range A4:F4 with the Heading 3 cell style 
Step 11. Accent 1 -- The range B4:F4 with the Accent1 Cell style 
Step 12. A10 = SUM – In the range B10:E10 format Total cell style 
Step 13. A11 = AVERAGE -In the range B11:E11, use the Average function to calculate the average of each 

column  
Step 14. A12 = MAXIMUM – In the range B12:E12, use the Maximum function to calculate the maximum of 

each column 
Step 15. A13 = MINIMUM – In the range B13:E13, use the Minimum function to calculate the minimum of 

each column. 
Step 16. Center – Center the column titles in row 4. 
Step 17. Accounting Style – Apply the accounting number format to the ranges B5:F5,  B10:F10 and 

B11:B13 
Step 18. Comma Style – Apply the comma style format to the range B6:F9. Adjust any column widths to the 

widest text entry in each column.  
Step 19. 3-D Pie Chart – Select the ranges B4:E4 and B10:E10 and then insert a 3-D pie chart.  

HINT- use your control key to separate a split range of cells. 

Step 20. Move the Chart – Move the chart to a new worksheet.  
HINT – Right-click a blank area of the chart and choose the move chart option 

Step 21. Add Data Labels to the Chart – Specify the labels should be on the outside end of the chart 
Step 22. Rename Sheet – Name the new chart worksheet Revenue Analysis Chart.  Color the sheet tab Red 

Accent 5 
Step 23. Chart Title – Change the chart title to First Quarter Revenue Analysis. 
Step 24. Rename Sheet1 – Rename the Sheet1 tab, First Quarter, and apply the Dark Green color to the sheet 

tab. 
Step 25. Add a Header – In the header of both sheets, type your name and include the sheet tab name.  

SAVE YOUR UPDATES 
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Since the file is already saved you can now save your updates by simply holding down the CRTL 
key and taping the S key.  This is a good habit and keeps you from losing your work. 

ASSIGNMENT TO SUBMIT:   U10a2 Katie Kicks 
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UNIT 11 –LARGE WORKSHEETS, CHARTING AND WHAT IF ANALYSIS 

With large worksheets, that extend beyond the size of a window, it is best to leave titles left-aligned.  This 
allows the user to easily find the worksheet title when necessary.  The following steps enter the 
worksheet titles and change the workbook theme to Savon. 

Step 1. Run Excel and create a blank workbook in the Excel Window. 
Step 2. Select CELL A1 

• Type Kaitlyn’s Ice Cream Shoppe as the worksheet title 
Step 3. Select CELL A2 

• Type Six-Month Financial Projection as the worksheet subtitle 
• PRESS ENTER 

Step 4. CLICK the PAGE LAYOUT TAB to display the theme options 
Step 5. APPLY the SAVON theme to the file 
Step 6. SAVE AS u11a1 Kaitlyn Financial Projection 

ROTATE TEXT IN A CELL 
The design of this worksheet specifies projections for six months sales.  Rotating text is one way of 
making columns visually distinct.  Use these steps to setup the columns for the worksheet: 

Step 1. CLICK CELL B3 
• Type January 
• HIT ENTER 
• CLICK back on CELL B3 
• CLICK the HOME TAB to display the 

home ribbon band 
• In the Alignment group, OPEN the 

DIALOG box 
• CLICK the ALIGNMENT tab 
• In the ORIENTATION group, CLICK 60 

for the number of degrees to rotate the text 
• CLICK OK 
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USE THE FILL HANDLE TO CREATE A SERIES 

The Auto Fill option can be used for a series of data.  If you use the fill handle to create a series of non-
sequential numbers or months, you mush enter the first item in the series in once cell and second item in 
the series in an adjacent cell, and then select both cells and drag the fill handle through the destination 
area.    

If the fill handle is dragged up or to the left, Excel will decrement the series rather tan increment the 
series.  Words such as January or Monday Excel automatically assumes to fill the sequence.  For this 
exercise, we are going to use the auto fill to complete the series of months.  Follow these steps: 

Step 1. CLICK in CELL B3 to select the cell 
Step 2. MOVE your MOUSE to the lower right corner of the cell until you pointer turns into a 

solid plus sign.   
Step 3. DRAG the fill handle across to column G (C3:G3) 
Step 4. RELEASE your MOUSE to create a month name series in the selected range and 

copy the format to the selected range.  

Step 5. CLICK to select CELL H3 
• Type Total as the column heading 
• HIT ENTER 

Step 6. CLICK to select CELL I3 
• Type Chart as the column heading 
• HIT ENTER 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 

INCREASE COLUMN WIDTHS 
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Step 1. Move the pointer to the boundary between column heading A and column heading B so 
that the pointer changes to a split double arrow in preparation of adjusting the column 
widths. DRAG the POINTER to the RIGHT until the ScreenTip displays the desired 
column width, Width: 38.00 (309 pixels) 

Step 2. RELEASE the MOUSE button to change the width of the column 
Step 3. CLICK column B to select the column DRAG through column heading G to select the 

range of columns that will be changed 
• Move the pointer to the boundary between column headings B and C in 

preparation of resizing column B 
• DRAG the POINTER to the right until the ScreenTip displays the desired width, 

Width: 14.50 (121 pixels) in this case.  
• RELEASE your MOUSE to confirm the expansion of the columns B:G 

Step 4. If necessary, scroll the worksheet so that column H is visible  
• EXPAND the COLUMN to 18 (149 pixels) 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 

ENTER AND INDENT ROW TITLES 
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Step 1. Enter the following information in column A for 
each of the designated rows: 
• CELL A4 – Revenue 
• CELL A5 – Cost of Goods Sold 
• CELL A6 – Gross Margin 
• CELL A8 – Expenses 
• CELL A9 – Bonus  
• CELL A10 – Commission 
• CELL A11 – Site Rental 
• CELL A12 – Marketing 
• CELL A13 – Equipment Repair and Maintenance 
• CELL A14 – Total Expenses 
• CELL A16 – Operating Income 

INDENT THE ROW TITLES 

Excel allows you to indent text in cells.  The following steps enter the row titles in column A and indent 
several of the row titles to create a visual hierarchy.  You can create a hierarchy by indenting some of t 
hero titles, like in an outline or table of contents.  

Step 2. CLICK the HOME TAB to view the home ribbon band 
Step 3. SELECT CELL A5 
Step 4. HOLD down your CTRL key and SELECT CELLS A9:A13.  This selects a split 

range of cells to be formatted.  
Step 5. In the alignment group, CLICK the INCREASE INDENT option TWICE 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 

COPY A RANGE OF CELLS TO A NONADJACENT DESTINATION AREA 
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The What-If Assumptions section should be placed in an area of the worksheet that is accessible yet 
does not impair the view of the main section of the worksheet.  In this case, the What-If Assumptions will 
be placed below the calculations in the worksheet.   

Step 6. CLICK on CELL A18 
• Type What-If Assumptions 

Step 7. SELECT the range A9:A13 
• CLICK the COPY button (home tab | 

clipboard group) 
• CLICK on CELL A19 
• CLICK the PASTE button to copy the values 

and formats of the last items placed in the 
clipboard.  

INSERT A ROW 

Step 8. RIGHT-CLICK the heading for ROW 20 
Step 9. CLICK on the INSERT option in the short-cut menu that appears.  This will insert a 

new blank row above the Commission area.  
Step 10. CLICK the blank CELL A20 

• Type Sales Revenue for Bonus 
Step 11. RIGHT-CLICK the heading for ROW 19 
Step 12. CLICK on the INSERT option in the short-cut 

menu that appears.  This will insert a new blank 
row above the Bonus area.  

Step 13. CLICK the blank CELL A19 
• CLICK the INSERT OPTIONS button 
• In the menu that appears select FORMAT SAME AS BELOW.  This will make 

the cell using the same formatting with the indents as the bonus cell.   
• Type Margin 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 
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ENTER NUMBERS AND FORMAT SYMBOLS 

When a number is entered with a format symbol, Excel displays it with the assigned format.  Valid format 
symbols include the dollar sign ($), comma (,), and percent sign (%).  

If you enter a whole number, it appears without any decimal places. If you enter a number with one or 
more decimal places and a format symbol, Excel displays the number with two decimal places. 

Step 1. Enter the information shown in the illustration into your spreadsheet. Each amount should 
be in the appropriate cell B19 enter 78.75%; cell B20 enter 3,500.00; cell B21 enter 
65,000.00; cell B22 enter 25.00%; cell B23 enter 10.00%; cell B24 enter 5.00%; 

cell B25 enter 3.50%  

PROJECTED MONTHLY SALES 

Step 2. Enter the projected revenue for each month. CLICK the HOME TAB to display the 
home ribbon.  

Step 3. Enter the information shown in the illustration into your spreadsheet. Each amount should 
be in the appropriate cell B4 enter 55,000.00; cell C4 enter 62,500.00; cell D4 enter 
67,000.00; cell E4 enter 90,250.00; cell F4 enter 77,500.00; cell G4 enter 
74,750.00 

CALCULATE THE REVENUE TOTAL 

Step 4. CLICK on the HOME TAB to display the home ribbon band 
Step 5. CLICK cell H4 
Step 6. In the editing group, CLICK on the AutoSum option. Excel automatically selects the 

numbers in row 4 and places their cell reference into the formula 
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Step 7. TAP ENTER on your keyboard to confirm the selection

 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 

ENTER AND FORMAT THE SYSTEM DATE 

A simple way to create a date stamp is to use the NOW function to enter the system date tracked by your 
computer.  The NOW function is one of 24 date and time functions available in Excel.  When assigned to 
a cell, the NOW function returns a number that corresponds to the system date and time beginning with 
December 31, 1899.  

Step 8. SELECT cell H1 
Step 9. CLICK the INSERT FUNCTION button on the Excel toolbar. Notice how the function 

button has automatically inserted an equal sign into the formula bar and the cell.  
Step 10. In the dialog box that opens, SELECT the DATE & TIME category 
Step 11. Scroll through the function list for the NOW function CLICK to select the function 
Step 12. CLICK on the OK button to confirm your selection.  

Step 13. CLICK on OK a second time to confirm the Functions Arguments box that appears.  
Step 14. RIGHT-CLICK cell H1 to display a shortcut menu and mini toolbar. 
Step 15. CLICK the FORMAT CELL option to open the dialog box 
Step 16. If necessary, CLICK the NUMBER tab. 
Step 17. CLICK the DATE option in the Category list 
Step 18. Scroll down the TYPE list and then CLICK 3/14/2012 to display a sample of the data 

in a sample are in the dialog box 
Step 19. CLICK on the OK button to confirm your entry.  
Step 20. DOUBLE-CLICK the border between columns H and I to change the width of the 

column to best fit.  

SAVE YOUR UPDATES 
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Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 

ENTER FORMULAS CONTAINING ABSOLUTE CELL REFERENCES 

The calculations for each column (month) are the same, except for the reference to the projected monthly 
revenue in row 4, which varies according to the month (B4 for January, C4 for February, and so on).  
Thus, the formulas for January can be entered in column B and then copied to columns C through G.   

FORMULA 1: COST OF GOODS = Revenue * (1-Margin %) 

Step 1. CLICK cell B5 for the value representing the Cost of Goods Sold for January. 
• HIT = on your keyboard to start the formula 
• CLICK cell B4 (January Revenue)  
• HIT * on your keyboard 
• HIT (1- on your keyboard 
• CLICK cell B19.  This is one of the What-If Assumptions; therefore, it is an 

absolute value 
• HIT the F4 function key to make the formula absolute.  
• HIT ) to close the formula 
• HIT your ENTER key to confirm 

FORMULA 2: GROSS MARGIN = Revenue-Cost of Goods Sold 

Step 2. CLICK cell B6 for the value representing the Gross Margin for January. 
• HIT = on your keyboard to start the formula 
• CLICK cell B4 (January Revenue)  
• HIT - on your keyboard 
• CLICK cell B5 (January Cost of Goods Sold)  
• HIT your ENTER key to confirm 

FORMULA 3: BONUS = If(Revenue>=Sales Revenue for Bonus, Bonus, 0) 

IF Statement is one of the most popular instructions among the Decision-Making statements. IF 
Statement gives the desired intelligence to a program, so that it can take decisions based on a criterion 
and most importantly decide the program flow. 

According to Microsoft Excel, IF statement is defined as a function which “checks whether a condition is 
met, returns one value if True and another value if False”. 

In plain simple English IF function is an instruction that checks any condition, if the condition is found to 
be TRUE then it returns a predefined value however if the condition is False, it returns a different 
predefined value. 

The syntax of If Function in Excel is as follows: 

=IF (Logic_Test, Value_if_True, Value_if_False) 

• ‘Logic_Test’ refers to the expression that is to be evaluated. 
• ‘Value_if_True’ is the output of IF Statement if the ‘Logic_Test’ is TRUE. 
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• ‘Value_if_False’ is the output of IF Statement if the ‘Logic_Test’ is FALSE. 

The logical test for the IF function you will be creating in this 
sheet is looking to see if the Revenue is greater than or equal 
to the Sales Revenue for the Bonus.  If the result is true a 
bonus amount is applied.  If it is false, there is no bonus applied.   
Follow theses steps to build the formula:  

Step 3. CLICK on CELL B9 to start the formula 
• CLICK the INSERT FUNCTION  
• SELECT the LOGICAL category and 

find IF on the function list displayed 
• CLICK on the OK button 

Step 4. A functions argument box will appear. CLICK 
inside the LOGICAL TEST area.  Once you are inside the box, you can begin building 
the logical test argument. 
• CLICK cell B4 
• Type >= 
• CLICK cell B21.  Since this is one of the What-If Assumptions, it must be an 

absolute value 
• HIT the F4 function key.  The logical test is complete.  Now you need to finish the 

true portion. 
Step 5. CLICK inside the Value if true area.  

• CLICK cell B20. Since this is one of the 
What-If Assumptions, it must be an absolute 
value 

• HIT the F4 function key.  The true portion of 
the formula is complete. Now you need to 
finish the false portion.  

Step 6. CLICK inside the Value if false area.  
• HIT the 0 on the keyboard. With this you are simply confirming there is no bonus for 

revenue that is under the Sales Revenue for Bonus. 
Step 7. CLICK on the OK button to finish the formula. You may note that this first result is zero.  

That is because the logical test was false.  You will see a result develop when we copy 
these formulas to the other locations.   

FORMULA 4: COMMISSION = Revenue * Commission % 

Step 8. CLICK cell B10 (cell represents Commission for January) 
• HIT = to start the formula 
• CLICK cell B4 
• HIT * to begin the multiplication 
• CLICK cell B22 (cell representing the Commission %).  Since this is one of the 

What-If Assumptions, it must be an absolute value 
• HIT the F4 function key on your keyboard 
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• HIT your ENTER key to end the formula. 

FORMULA 5: SITE RENTAL = Revenue * Site Rental % 

Step 9. CLICK cell B11 (cell represents Site Rental for January) 
• HIT = to start the formula 
• CLICK cell B4 
• HIT * to begin the multiplication 
• CLICK cell B23 (cell representing the Site Rental %).  Since this is one of the 

What-If Assumptions, it must be an absolute value 
• HIT the F4 function key on your keyboard 
• HIT your ENTER key to end the formula. 

FORMULA 6: MARKETING = Revenue * Marketing % 

Step 10. CLICK cell B12 (cell represents Marketing for January) 
• HIT = to start the formula 
• CLICK cell B4 
• HIT * to begin the multiplication 
• CLICK cell B24 (cell representing the Marketing %).  Since this is one of the What-

If Assumptions, it must be an absolute value 
• HIT the F4 function key on your keyboard 
• HIT your ENTER key to end the formula. 

FORMULA 7: EQUIPMENT REPAIR AND MAINTENANCE = Revenue * Equipment Repair and 
Maintenance % 

Step 11. CLICK cell B13 (cell represents Equipment Repair and Maintenance for January) 
• HIT = to start the formula 
• CLICK cell B4 
• HIT * to begin the multiplication 
• CLICK cell B25 (cell representing the Equipment Repair and Maintenance %).  

Since this is one of the What-If Assumptions, it must be an absolute value 
• HIT the F4 function key on your keyboard 
• HIT your ENTER key to end the formula. 

FORMULA 8: TOTAL EXPENSES 

Step 12. CLICK cell B14 (cell represents Total Expenses for January) 
• In the editing group of the Home ribbon, CLICK on AutoSum.  Check to make 

sure the formula has selected cells B9:B13 
• HIT your ENTER key to end the formula 

FORMULA 9: OPERATING INCOME = Gross Margin – Total Expenses 

Step 13. CLICK cell B16 (cell represents Operating Income for January) 
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• HIT = to start the formula 
• CLICK cell B6 (Gross Margin) 
• HIT – to begin the subtraction 
• CLICK cell B14 (Total Expenses) 
• HIT your ENTER key to end the formula 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 

COMPLETE THE FORMULAS AND ADD A SPARKLINE CHART 
Sometimes you may want to condense a range of date into a small chart to show a trend or variation in 
the range, and the standard charts in Excel may be too large or extensive for your needs.  A Sparkline 
chart provides a simple way to show trends and variations in a range of data.  This next activity will 
include finishing the formulas in the worksheet and setting up a Sparkline chart to display the results from 
each row of data.   

COPY FORMULAS WITH ABSOLUTE CELL REFERENCES USING THE FILL HANDLE 

The following steps use the fill handle to copy the January formulas in column B to the other five months 
in columns C through G.  

Step 1. SELECT the RANGE B5:B16 
• POINT to the FILL HANDLE 

in the lower right corner of cell, 
B16 in this case, to display the 
crosshair pointer.  

• DRAG the FILL HANDLE to 
the right to copy the formulas 
from the source area, B5:B16 in 
this case, to the destination area, 
C5:G16 in this case, and 
display the calculated amounts.  
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• RELEASE your MOUSE the formula amounts will fill in using the absolute cell 
references created earlier.  

DETERMINE ROW TOTALS IN NONADJACENT CELLS 

The following steps determine the row totals in column H. To determine the row totals using the Sum 
button, select only the cells in column H containing numbers in adjacent cells to the left.  If totals are 
calculated on rows without data, Excel will place a zero 
in the row.  We avoid this problem by following these 
steps: 

Step 2. SELECT the RANGE H5:H6 
Step 3. PRESS the CTRL key and hold it 

down 
• SELECT the RANGE H9:H14 
• SELECT the CELL H16 
• CLICK the AutoSum BUTTON (Home Tab, Editing group).  The totals are 

automatically entered in column H.  
  

ADD SPARKLINE CHART TO THE WORKSHEET 

A sparkline chart is a good choice because it shows trends over the six-month period for each row of 
data. If necessary, scroll the worksheet so that both columns B and I and row 3 are visible on the screen. 

Step 4. SELECT cell I4 
Step 5. CLICK the INSERT TAB to display the insert 

ribbon 
• In the Sparklines group, CLICK the LINE 

option 
• CLICK INSIDE the DATA RANGE dialog 

box 
• SELECT the RANGE B4:G4 
• RELEASE the MOUSE button 
• HIT the ENTER button 
• CLICK on the OK option 
• CLICK the DESIGN option for the Sparkline Tools 
• In the style group, CLICK the MORE option to display the Sparkline gallery 
• Click Sparkline Style Dark Green, Sparkline Style, Accent 4, Darker 

25% 
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• CLICK on the fill handle in 
CELL I4  

• DRAG your MOUSE to I16. 
This copies the Sparkline chart 
throughout all the formulas on the 
sheet.  

 

CHANGE THE SPARKLINE TYPE 

In addition to the change in the Sparkline Chart style, 
you can also change the type of chart.   

Step 1. SELECT the range I4:I16 

• CLICK the SPARKLINE TOOLS design tab to make it the active tab. 
• CLICK the CONVERT TO COLUMN SPARKLINE button on the type group 

of the design tab.  

Step 2. CLICK cell I18 to move away from the Sparkline feature.  

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 

FORMAT THE WORKSHEET 
So far, the worksheet is uninteresting and needs some adjustments to the appearance.  This section 
completes the formatting process for this worksheet.  

Step 1. SELECT the RANGE B4:H4 to prepare for formatting. 
Step 2. HOLD DOWN the CTRL key.  Select the following cells: 

• B6:H6, B9:H9, B14:H14, and B16:H16 
• RELEASE the CTRL key 
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• On the HOME TAB click the number group to display the FORMAT CELLS 
DIALOG BOX 

• In the Category list CLICK on the 
CURRENCY option  

• Decimal Places: 2 
• Symbol: $ 
• Negative Numbers: (black) ($1,234.10) 
• CLICK on the OK button to confirm 

Step 3. SELECT the RANGE B5:H5 
Step 4. HOLD DOWN the CTRL key. 

• SELECT cells B10:H13 
• RELEASE the CTRL key 
• On the HOME TAB click the number group to display the FORMAT CELLS 

DIALOG BOX 
• In the category list, CLICK on CURRENCY 
• Decimal Places: 2 
• Symbol: NONE 
• Negative Numbers: (black) ($1,234.10) 
• CLICK the OK option to complete the number formats

 
FORMAT THE WORKSHEET TITLES 

Step 1. CLICK the HOME TAB to display the home ribbon 
Step 2. Hold down CTRL and HIT the HOME key.  This will take you to position A1 of the 

document. 
• CLICK the BOLD button in the font group 
• INCREASE the FONT to 28 pts 

Step 3. CLICK cell A2 
• INCREASE the FONT to 16 pts 

Step 4. SELECT the RANGE A1:I2 
• Change the FILL COLOR to Green, Accent 4.  This will add a background 

color the selected range. 
• Change the FONT COLOR to White, Background 1 
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Step 5. SELECT the RANGE A3:I3 
• APPLY the HEADING 2 style 

Step 6. SELECT the RANGE A6:H6 
• HOLD DOWN the CTRL key 
• SELECT A14:H14, 

A16:H16 
• APPLY the TOTAL cell style 

Step 7. SELECT A4 
• FILL the CELL Green, Accent 4 
• Change the FONT COLOR to White, Background 1 
• DOUBLE-CLICK the FORMAT PAINTER 

Step 8. CLICK cell A6 to format the shading and font color from A4 to A6 
Step 9. With the format painter still active, CLICK and DRAG through A16:H16 
Step 10. Apply CURRENCY style to B16:H16 

FORMAT THE WHAT-IF ASSUMPTIONS 

The following steps format the What-IF Assumptions table. 

Step 11. SELECT cell A18 
• Change the FONT size to 8 pts 
• BOLD and UNDERLINE the TEXT 

Step 12. SELECT the RANGE A19:B25 
• Change the FONT size to 8 pts 
• Change the FILL COLOR to Green, Accent 4.  This will add a background 

color the selected range. 
• Change the FONT COLOR to White, Background 1 
• CLICK AWAY from the RANGE to deselect it.   
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SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 
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ADDING A CLUSTERED COLUMN CHART TO THE WORKBOOK 

Charts can be either embedded in a worksheet or placed on a separate chart sheet.  The clustered 
column chart will reside on its own sheet because if placed on the worksheet, it would not be visible when 
the worksheet first opens and could be missed.  

Step 1. CLICK on the INSERT TAB to view the insert ribbon 
Step 2. SELECT the RANGE A3:G3 

• HOLD down your CTRL key 
• SELECT the RANGE 

A9:G13 

Step 3. In the charts group, CLICK the 
REOMMENDED CHARTS tab 
to activate the menu 

Step 4. CLICK the first CLUSTERED COLUMN RECOMMENDATION 
Step 5. CLICK OK 
Step 6. After Excel creates the chart, CLICK the MOVE CHART button in the location group 
Step 7. CLICK NEW SHEET 
Step 8. Type Expense Chart as the sheet name 
Step 9. CLICK OK 

ADD THE CHART TITLE 

Step 10. CLICK anywhere in the CHART TITLE to 
select it 

Step 11. Type Six-Month Projected Expenses as 
the title 

 
ADD DATA LABELS 

Step 12. CLICK the CHART ELEMENTS button to 
display the Chart Elements gallery 

Step 13. POINT to the DATA LABELS option  
• CLICK the MORE option in data labels to display the alternate menu that appears 

to the right of the option. 
• CLICK the OUTSIDE END option 
• CLICK the CHART ELEMENT button to close the gallery 
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APPLY CHART FILTERS 

The amounts for the bonus in January and February are zero. Whit some 
data you may find that certain data series or categories make it difficult to 
examine difference and patterns between other series or categories.  Excel 
allows you to easily filter data series and categories to allow more in-depth 
examinations of subsets of data. In this case, filters can be used to 
temporarily remove the compensation categories Bonus and Commission 
from the chart to allow a comparison across the non-compensation 
expenses.   

Step 14. CLICK the CHART FILTERS button on the chart to 
display the Chart Filters gallery 
• In the Series section, CLICK the BONUS and 

COMMISSION to remove the check marks 
• CLICK the APPLY option 

ADD AN AXIS TITLE TO THE CHART 

Step 15. CLICK anywhere in the CHART OUTSIDE area to 
select it 

Step 16. CLICK the CHART ELEMENTS button to display 
the Chart Elements gallery 
• POINT to the AXIS TITLES  
• CLICK on the ARROW to display the menu 

options 
• CLICK the PRIMARY VERTICAL option 
• CLICK the CHART ELEMENTS button to 

remove the Chart Elements gallery 

Step 17. SELECT the PLACEHOLDER TEXT in the 
VERTICAL AXIS title 

Step 18. RIGHT CLICK the VERTICAL AXES LABELS 
Step 19. In the NUMBER category select CURRENCY 

 

CHANGE THE CHART STYLE 

When creating charts, it is not unusual to change your mind on what type of chart should be shown.  
These are quick instructions on how to change the chart style: 

Step 20. With the chart selected, CLICK the DESIGN TAB (Chart Tools) 
Step 21. In the Chart Styles group, SELECT the MORE option to expand the menu 
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Step 22. CLICK on the STYLE 3 option to change the chart 

 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 

ORGANIZING THE WORKBOOK 
Once the content of the workbook is complete, you can address the organization of the workbook.  If the 
workbook has multiple worksheets, place the worksheet on top that you want the reader to see first.  The 
default sheet names in Excel are not descriptive.  Renaming the sheets with descriptive names helps the 
reader find information that he or she is looking for.  Modifying the sheet tabs using color further 
distinguishes multiple sheets from each other. 

Step 1. CHANGE the COLOR of the Expense Chart sheet tab to Green, Accent 4 
Step 2. DOUBLE-CLICK the sheet tab labeled SHEET 1 

• Type Six-Month Financial Projection as the new sheet tab name 
• HIT the ENTER key to confirm your change. 
• CHANGE the sheet tab color of the Six-Month Financial Projection sheet to 

Blue Accent 2 
Step 3. SELECT an empty cell in the worksheet to confirm your change 

REORDER THE SHEET TABS AND CHECK SPELLING 
Step 4. DRAG the Six-Month Financial Projection SHEET to the LEFT so that it 

precedes the Expense Chart sheet 
Step 5. With the Six-Month Financial Project sheet active, press CTRL and TAP the HOME 

(CTRL+HOME) key on your keyboard. This will automatically take your mouse to cell 
A1 of the worksheet. 
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Step 6. HOLD DOWN the CTRL key then CLICK the EXPENSE CHART sheet.  This 
groups the sheets and enables the edit features to work on multiple sheets at the same 
time.  

Step 7. DISPLAY the REVIEW TAB 
Step 8. CLICK the SPELLING option in the proofing group of the review ribbon band 
Step 9. Correct any errors and CLICK on the OK option to confirm 

PREVIEW THE WORKSHEET 
Step 10. With the Six-Month Financial Projection sheet selected, CLICK on FILE to 

open the Backstage view  
Step 11. CLICK the PRINT TAB in the Backstage view to display the Print gallery 
Step 12. CLICK the PORTRAIT ORIENTATION button  
Step 13. SELECT the LANDSCAPE ORIENTATION to confirm the new settings for both 

sheets 
Step 14. CLICK the NO SCALING option in the settings area 
Step 15. SELECT the FIT SHEET ON ONE PAGE option.  This will cause the worksheet to 

print on one page.  
Step 16. CLICK the PAGE SETUP option at the bottom of the preview screen 
Step 17. CLICK the tab labeled Header/Footer 

• CLICK on CUSTOM FOOTER . . .  
• Type your name in the right panel 
• Hit ENTER under your name to advance to the line under your name 
• CLICK on the option for the code to display the SHEET TAB 
• CLICK on OK 

Step 18. Follow the instructions for entering the footer on the chart using the chart sheet tab 
Step 19. CLICK the PRINT OPTION 
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Step 20. CHECK your SETTINGS 
a. Print Entire Workbook 
b. Landscape Orientation 
c. Fit sheet on One Page 

SAVE YOUR UPDATES 

Since the file is already saved you can now 
save your updates by simply holding down 
the CRTL key and taping the S key.  This 
is a good habit and keeps you from losing 
your work 

ASSIGNMENT IS READY TO SUBMIT: 
u11a1 Kaitlyn Financial Projection 

ON YOUR OWN ACTIVITY 

STARTING FROM SCRATCH 

Step 1. Select cell A8 – Type Modern Music Shops 
Step 2. Select cell A9—Type Six-Month Financial Projection 
Step 3. Page layout > Theme > Ion 
Step 4. File > Save as > u11a2 Modern Music Shops 

ROTATE TEXT AND USE FILL HANDLE TO CREATE A SERIES 

Step 5. Select cell B10 – Type July 
Step 6. Select B10 – Home Ribbon Band > Alignment > Orientation > 45 degrees > OK 
Step 7. Select B10 – Use fill handle to drag across C10:G10.  This will automatically fill the months. 

Click Fill Series  
Step 8. Select H10 – Type Total. Press right arrow to enter the column heading. 
Step 9. Select I10 – Type Chart. Press right arrow to enter the column heading. 

INCREASE COLUMN WIDTHS 

Step 10. Move the mouse pointer to the boundary between column heading A and column heading B.  
The pointer should change to a split double arrow.   

Step 11. Drag the mouse pointer to the right until the ScreenTip displays the desired column width for 
column A, Width: 36.88(300 pixels). 

Step 12. Release the mouse button to change the width of the column 
Step 13. Select Columns B-G – Move the mouse pointer to the boundary between column headings B 

and C. When the pointer changes to a split double arrow, resize the column to 14.71 (108 
pixels) 

Step 14. Select Columns H-I -- Move the mouse pointer to the boundary between column headings H 
and I. When the pointer changes to a split double arrow, resize the column to 16. (117 pixels) 

ENTER ROW TITLES 
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Step 15. Cell A11–  Revenue 
Step 16. Cell A12–  Cost of Goods Sold 
Step 17. Cell A13– Gross Margin 
Step 18. Cell A15 – Expenses 
Step 19. Cell A16 – Bonus 
Step 20. Cell A17 – Commission 
Step 21. Cell A18 – Marketing 
Step 22. Cell A19 – Research and Development 
Step 23. Cell A20– Support, General, and Administrative 
Step 24. Cell A21– Total Expenses 
Step 25. Cell A23 – Operating Income 
Step 26. Cell A1 –  What-If Assumptions 

INDENT TITLES 

Step 27. Cell A12 – Home Ribbon > Alignment > Increase Indent 
Step 28. Cells A16:A20 – Home Ribbon > Alignment > Increase Indent 

COPY RANGE OF CELLS TO A NONADJACENT DESTINATION AREA 

Step 29. Select A16:A20 – Home Ribbon > Clipboard > Copy 
Step 30. Select A2 – Home Ribbon > Clipboard > Paste 
Step 31. Press ESC to remove the dancing ants 

INSERT ROW 

Step 32. Right-click row heading 4 – Click Insert on the shortcut menu> Insert entire row>OK (your 
row will insert) 

Step 33. Select A4 – Type Margin for the new row title 
Step 34. Right-click row heading 7 – Click insert on the shortcut menu> Insert entire row>OK (your 

row will insert) 
Step 35. Select A7 – Type Sales Revenue for Bonus for the new title 

ENTER NUMBERS WITH FORMAT SYMBOLS 

Step 36. CELL B2 -- $200,000.00  
Step 37. CELL B3 – 5.75% 
Step 38. CELL B4 – 57.50% 
Step 39. CELL B5 – 15.00%  
Step 40. CELL B6 – 7.50% 
Step 41. CELL B7 -- $3,500,000.00  
Step 42. CELL B8 – 18.75% 

FREEZE COLUMN AND ROW TITLES 

Step 43. Scroll the worksheet to ensure that Excel displays row 1 as the first row and column A on the 
screen 

Step 44. Select Cell B13 – View Ribbon > Window > Freeze Panes  
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ENTER THE PROJECTED MONTHLY SALES 

Step 45. Cell B13 = 3113612.16 
Step 46. Cell C13 = 7962235.53 
Step 47. Cell D13 = 5112268.58 
Step 48. Cell E13 = 2924627.87 
Step 49. Cell F13 = 7630535.65 
Step 50. Cell G13 = 3424270.23 
Step 51. Cell H13 – Hit Sum Button 

ENTER AND FORMAT THE SYSTEM DATE 

Step 52. Select I11 – Insert function  
Step 53. Click the ‘Or Select a category’ box and then select Date & Time in the list to populate the 

‘Select a function’ list with data and time functions. 
Step 54. Scroll down in the ‘Select a function list’ and then click NOW >OK >OK 
Step 55. Right-click I11 – Click Format Cells >Number > Date > choose 3/14/2012 format > OK 
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ABSOLUTE VERSES RELATIVE ADDRESSING 

Step 56. Absolute Cells – Each time you place a formula that contains any one of the following cells: 
o B2, B3, B4, B5, B6, B8  

Step 57. Absolute = F4 function key  

FORMULAS 

The formulas DO NOT contain the cell references but the label that represents the cell.  All these 
formulas should be ENTERED and REFERENCED by the values COLUMN B.  Because this is 
an On Your Own Activity, you should beware that the labels are not values only the blank columns that 
represent the values (the values to click on are in column B) are calculated: 

• B14 (Cost of Goods Sold) = Revenue * (1 – Margin %) 
• B15 (Gross Margin) = Revenue – Cost of Goods Sold 
• B18 (Bonus) = IF (Revenue >=Sales Revenue for Bonus, Bonus, 0) 
• B19 (Commission) = Revenue * Commission % 
• B20 (Marketing) = Revenue * Marketing % 
• B21 (Research and Development) = Revenue * Research and Development % 
• B22 (Support, General, and Administrative) = Revenue * Support, General and Administrative % 
• B23 (Total Expenses) = Sum of July Expenses 
• B25 (Operating Income) = Gross Margin – Total Expenses 

COPY FORMULAS WITH ABSOLUTE CELL REFERENCES 

Step 58. Select Range B14:B25 – Point to Fill handle > Drag to C14:G25 

DETERMINE ROW TOTALS IN NONADJACENT CELLS 

Step 59. Select range H14:H15 > Hold down the control key 
Step 60. Select range H18:H23 and H25 
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Step 61. Click the Sum button 

UNFREEZE THE WORKSHEET TITLES AND SAVE 

Step 62. Press CTRL+HOME 
Step 63. Display the View ribbon > Window > Freeze Panes > Unfreeze Panes 
Step 64. Display Home ribbon > Quick Access Toolbar > Save 

SPARKLINE CHART 

Step 65. Select Cell I13 – Insert ribbon > Sparklines > Line > B13:G13 > OK 
Step 66. Select Cell I13 – Use fill handle to copy charts down to I25 

ASSIGN FORMATS TO NONADJACENT RANGES 

Step 67. Select B13:H13 > Hold Down Control Key 
• Select B15:H15 
• Select B18:H18 
• Select B23:H23 
• Select B25:H25 > Release Control Key 

Step 68. Home Ribbon > Number dialog box > Currency> Decimal 2 > Symbol $ > negative 
($1,234.10) black > OK 

Step 69. Select B14:H14 > Hold Down Control Key 
• Select B19:H22 > Release Control Key 

Step 70. Home Ribbon > Format > Number > Currency> Decimal 2 > Symbol none > negative 
(1,234.10) black > OK 

FORMAT WORKSHEET TITLES 

Step 71. Select Column A – Home Ribbon > Font > Bold 
Step 72. Select A10 – Home Ribbon > Font > 36 points 
Step 73. Select A11 – Home Ribbon > Font > 18 points 
Step 74. Select A10:I11 – Home Ribbon > Font > Fill Color  

• Choose Purple, Accent 6, Darker 25% (column 10, row 5) 
• Home Ribbion > Font > Font Color > White, Background 1 (column 1, row1 ) 

ASSIGN CELL STYLES TO NONADJACENT ROWS AND COLORS TO A 
CELL 

Step 75. Select A12:I12 – Home Ribbon > Styles > Heading 3 
Step 76. Select A15:I15 > Hold down control key 

• Select A23:I23,  
• Select A25:I25 > Release control key 
• FORMAT CELLS – TOTAL STYLE 

Step 77. Select A13  
• FILL COLOR - Purple, Accent 6, Darker 25% (column 10, row 5) 
• FONT COLOR -White, Background 1 (column 1, row1 ) 
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COPY A CELL’S FORMAT USING FORMAT PAINTER 

Step 78. Select A13 – This will be your source cell for the format > double-click the format painter 
(Home Ribbon > Clipboard). By double-clicking the format painter, it allows the format painter 
to stay active until you turn it off. 

Step 79. Click Cell A17 – This applies the format from A13 
Step 80. Drag through the range A25:I25 > ESC – The ESC key turns the format painter off. 

ADDING 3-D PIE CHART TO THE WORKBOOK 

Step 81. Select B25:G25 and non-adjacent cells (hold down your control key) B12:G12 
Step 82. While the cells are selected, Click Insert Ribbon > Charts > Pie > 3-D Pie 
Step 83. Move Chart (Chart must be selected) – Chart Tools > Design > Location > Move Chart > 

New Sheet 
Step 84. Name the Chart Sheet – Six-Month Projection 

INSERT A CHART TITLE AND DATA LABELS 

Step 85. SELECT the text in the CHART TITLE 
• Type Six-Month Financial Projection 
• CLICK the UNDERLINE option to underline the text of the title 

Step 86. In the Chart Elements, SELECT the Legend option 
• POSITION the legend to the Right of the chart 
• Check the option “Show the legend without overlapping the chart” 

Step 87. In the Chart Elements, SELECT the Data Labels option 
• POSITION Labels on the Outside End 
• CLICK the More Options button to reveal the Format Data Labels options 
• CHECK the Percentage option 
• UNCHECK the Value option.  You should have a percentage for each section of the 

chart. 
Step 88. MOVE the Six-Month Projection SHEET TAB to the right of Sheet 1 
Step 89. Rename Sheet 1 to Modern Music Shops  

CHANGE THE DESIGN  

Step 90. Using the design ribbon band, scroll through the different chart options.  To see how the chart 
changes and the different chart styles available.  Choose Style 8 

PRINT SETTINGS 

Step 91. ADD A FOOTER – In the right panel of the footer, type your name and the sheet tab code 
(both sheets should have your name and sheet name in the print preview) 

Step 92. The page setup settings should have the following settings: 
• Orientation: Landscape 
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• Scaling:  Fit to 1 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key 
and taping the S key.  This is a good habit and keeps you from losing your work 

ASSIGNMENT IS READY TO SUBMIT: 
u11a2 Modern Music Shops 

  



  

~ 241 ~ 

 

UNIT 12 –GROUP AND INDIVIDUAL EXCEL CREATION 

Now that your group has a product, service or idea, the next step is to develop spreadsheets, 
which substantiate your product, service or idea.  

TASK FOR EACH GROUP MEMBER: 

Create a spreadsheet that provides “financial” information for or about your company. Some 
examples of spreadsheets might include: 

• Cost for Service - you might have varying rates for services. 
For example - Monday/Wednesday/Friday service as 
compared to Tuesday/Thursday service. Or a two-day 
adventure compared to a week adventure.  The IF 
statement may incorporate a discount when two 
services are requested.  

• Inventory Summary - This report shows you the total 
quantity and value of all in-stock items. Use the filters to 
view stock by warehouse, by category, by product type, or a 
combination of these. Each item would be listed once to provide the total quantity and 
value for that item whether they were purchased at the same price or not. The overall total 
displayed at the bottom of the report is for the items displayed on screen only. You  may 
choose to incorporate an IF statement that notifies the warehouse when it is time to 
reorder the product.   

• Cost Benefit Analysis – A cost benefit analysis (also known as a benefit cost analysis) is a 
process by which organizations can analyze decisions, systems or projects, or determine a value 
for intangibles. The model is built by identifying the benefits of an action as well as the associated 
costs, and subtracting the costs from benefits. When completed, a cost benefit analysis will yield 
concrete results that can be used to develop reasonable conclusions around the feasibility and/or 
advisability of a decision or situation. 

• Profit and Loss Statement -- A profit and loss statement, also called an income statement, 
shows a business’s revenue, expenses, and net income over a specific period. It’s usually 
assessed quarterly and at the end of a business’s accounting year. Business owners use profit and 
loss statements to determine whether they should improve the bottom line by increasing revenues, 
cutting costs, or both. 

• Payroll Summary – These reports can be generated for individual employees or for all 
employees from a specific range of dates.  It can include gross pay, net pay, taxes, and 
other deductions.   

The spreadsheet created must be different than the assignments completed in Units 9, 10 
or 11. 

 
u12a1 INDIVIDUAL PROJECT REQUIREMENTS 

Once the team has decided the topic each member is going to complete for the company, the u12a1 
assignment completion is up to the class member that committed to the specific report he or she plans to 
create.  Each member will be completing two files and uploading them together in the u12a1 assignment 
area: 

1. Excel Workbook  
2. MS Word Block Style Letter  
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EXCEL WORKBOOK GUIDELINES 
For 100% assignment credit, your workbook must contain the following components: 
Worksheet: The data represented in your worksheet should represent your company and 
therefore have your company logo represented on the worksheet.  There are specific 
components that your worksheet should contain.  DO NOT use an online template or copy 
the activities from Units 9, 10 or 11.   

• HEADER – The header should contain your first and last name; at least one of the 
codes available (sheet tab, filename, date, page number).  

• FORMULA – The spreadsheet should have a basic formula using relative cell 
references i.e. =B10*F15 

• ABOSOLUTE REFERENCE – There should be at least 1 formula using an absolute cell 
reference i.e. =$C$2*F20.  The reference used should also have a logical significance.  

• BASIC FUNCTION – The user should create a spreadsheet with at least one of the 
basic functions created in the unit exercises i.e. =sum(E3:E20).  You may choose to use 
Avg, Max, or Min they are all acceptable.  

• IF STATEMENT – The if/then/else statement  
i.e. =if(c20<=A19,”Good Job”,”Need Help”  OR =if(c20<=A19,B17*.05,B18*.20) 

• Make sure numbers in the spreadsheet are formatted appropriately 
Chart: A picture speaks a thousand words, thus in addition to the spreadsheets; each member 
of the group is to create at least one chart for the spreadsheet they created. Keep in mind that if 
your data is weak, your graph is weak, so make sure it makes sense. Make sure that the data 
you charted would be useful to your company. 

• TITLE – Make sure to include a title (which includes your last name) 
• LEGEND – The legend in your graph to provide clarity to the reader.  
• LOCATION – Move the chart to a separate sheet from the worksheet.   
• SHEET TAB – Make sure you name the chart sheet tab. 

MS WORD LETTER GUIDELINES 

Write a block style letter to a potential investor, client, customer, sales person, vendor etc., 
which reflects what your spreadsheet or chart is displaying. One of the nice features of Microsoft 
Office is the easy linking of one application into another application.  

NOTE: The easiest way to link a chart or table from an Excel 
spreadsheet into your Word document is to use the copy and paste 
commands. 

Your letter should contain the following: 

• COMPANY LETTERHEAD – Use the company letterhead your group created in Unit 5. 
• BLOCK STYLE – Follow the tutorial guidelines from Unit 5 to format the correct block 

style letter format.   
• LINK EXCEL – Link either the chart or spreadsheet to your letter below your written text. 

Pay close attention to the note above.  The link is NOT a hyperlink.  It is an illustration 
from your spreadsheet.   

• CLOSE – Be sure to include a closing to your letter which includes your first and last 
name.  
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SUBMIT ASSIGNMENT FILES: 
1. U12a1 Excel – Your Name 

2. U12a1 Letter – Your Name 

u12e2 GROUP EXTRA CREDIT ACTIVITY 

Group Decision – As a group, you need to determine if you want to do the extra credit. If some of the 
members say no but others would like to participate, the participating members should follow the 
instructions below: 

Group Members that Decide Yes 

• Combine Your Work – Combine the worksheets each member created into one 
workbook. 

• Name Tabs -- Name each sheet tab with the name of the group member who designed 
the sheet. 

• Group Summary Sheet – The summary sheet combines data from each of the 
worksheets in the workbook to illustrate a summary of information regarding the 
information.  

• Save your Workbook – (Group x – Excel Project Extra Credit).  Save your workbook 
using inserting the group number in the “x” area of the given file name. Once the group 
agrees all is complete, the group leader will submit the file to the Canvas area marked for 
the extra credit u12e2 Group Name (please use your group name as a replacement for the 
words Group Name). This is the file you will submit for the extra credit grade. 

Group Submission 

Step 1. ONE GROUP MEMBER COMPILES THE WORK -- The member that 
submits the activity will do the following: 
a. DOWNLOAD SPREADSHEETS - Download each spreadsheet from the 

students involved. 
b. CREATE BLANK WORKBOOK – Save the blank workbook as u12e2 
c. COPY INFORMATION – Open each of the u12a1 files that you downloaded. 

Copy only the sheet that contains the data and formulas (DO NOT copy the 
chart). To copy the sheet, use these guidelines: 
• RIGHT-CLICK the sheet tab name 
• CLICK on the Move or Copy option 
• CLICK on the COPY option. This will make a sheet tab with the same 

name as the original and a (2) after the name. 
• DRAG the new sheet tab over to the u12e2 file you are creating, and 

you now have a copy of the sheet. 
d. RENAME the sheet with the student’s name. 

Step 2. REPEAT the process in STEP 1 for the next student until you have all the group 
members that are participating in the activity. 

Step 3. CREATE a SUMMARY SHEET – This is the sheet that you will combine your 
information in.  This is the sheet I will be grading.   
NOTE: I am looking for Excel codes that link the data from each 
sheet to the summary sheet you have created.  If you have any 
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questions regarding this process, make sure you watch the video 
demonstration.   

Step 4. GROUP APPROVAL – This is an important step before submission.  Make sure 
you have shared the potential submission with the group.  They may have 
something to add or revise.  It always helps to have a second set of eyes.   

SUBMIT FILE:  u12e2 Group Name  

 

GRADING 
You will be graded on originality (please do not duplicate textbook spreadsheets), 
clarity, accuracy and format of the spreadsheet and chart. Refer to the grading rubric 
on the following page for additional grading criteria. Refer to the rubric for the u12a1 
Excel Project for a complete outline of the grading criteria.  

WHAT HAPPENS IF A GROUP MEMBER DROPS THE CLASS? 
As is true in the “working world”, if you lose a team member the remaining members 
need to continue and complete the project. No new members will be added to your 
team.  
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UNIT 13 –MS ACCESS DATABASE MANAGEMENT SYSTEM 

Microsoft Access is a database management system (DBMS) from Microsoft that combines the relational 
Microsoft Jet Database Engine with a graphical user interface and software-development tools. It is a 
member of the Microsoft Office suite of applications, included in the Professional and higher editions or 
sold separately. 

Microsoft Access stores data in its own format based on the Access Jet Database Engine. It can also 
import or link directly to data stored in other applications and databases. 

Software developers, data architects and power users can use Microsoft Access to develop application 
software. Like other Microsoft Office applications, Access is supported by Visual Basic for Applications 
(VBA), an object-based programming language that can reference a variety of objects including DAO 
(Data Access Objects), ActiveX Data Objects, and many other ActiveX components. Visual objects used 
in forms and reports expose their methods and properties in the VBA programming environment, and 
VBA code modules may declare and call Windows operating system operations. 

Becoming familiar with the tables, forms, queries, and other objects in an Access database can make it 
easier to perform a wide variety of tasks, such as entering data into a form, adding or removing tables, 
finding and replacing data, and running queries. 

CREATING A DATABASE 

With the projects for the next chapter, you will be creating the database from scratch and adding to it in 
the next unit.  The name of the company database you are creating is PrattLast Associates. Follow 
these directions to create your database in MS Access: 

Step 1. Open MS Access (this program is not 
available on Mac computers) 

Step 2. CLICK on the BLANK DATABASE 
window that appears on the Access screen.  

Step 3. CLICK on the folder next to the File 
Name option 

Step 4. NAVIGATE to your UNIT 13 FOLDER 
for this class 

Step 5. In the dialog box, type PrattLast 
Associates 

Step 6. CLICK on the OK option to confirm the 
selection 

Step 7. CLICK on the CREATE option for the 
blank database 
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DETERMINE DATA TYPES FOR THE FIELDS 

Every table in Access is made up of fields. The properties of a field describe the characteristics and 
behavior of data added to that field. A field's data type is the most important property because it 
determines what kind of data the field can store. Data types can seem confusing for example, if a field's 
data type is Text, it can store data that consists of either text or numerical characters. But a field whose 
data type is Number can store only numerical data. So, you must know what properties are used with 
each data type. 

After you create a field and set its data type, you can set additional field properties. The field's data type 
determines which other properties that you can set. For example, you can control the size of a Text field 
by setting its Field Size property. 

For Number and Currency fields, the Field Size property is especially important, because it determines 
the range of field values. For example, a one-bit Number field can store only integers ranging from 0 to 
255. 

The Field Size property also determines how much disk space each Number field value requires. 
Depending on the field size, the number can use exactly 1, 2, 4, 8, 12, or 16 bytes. 

Step 1. In the blank database for PrattLast Associates, a table appeared to the left of the screen 
it is this table that we will be working with. The first step is to rename the table. RIGHT-
CLICK on TABLE 1 

Step 2. CLICK on the DESIGN VIEW option.  You will be prompted to name the table. 
Step 3. Type Account Manager as the new name of the table  

Step 4. CLICK on the OK option 
Step 5. RIGHT-CLICK the ACCOUNT MANAGER table. A short-cut menu 

appears. 
Step 6. CLICK on DESIGN VIEW. In Design view you have many options for the table.  

PRIMARY KEY 

Primary Keys are used as a form of an ID. It’s used to uniquely identify a record in a table.  A social 
security number or referenced number can be used as a primary key. This is due to the uniqueness or 
difference in values and with primary keys, it makes it easier for table containing related record in a 
database to be linked together.  This helps to the efficiency during retrieval and sorting out of record. 

Step 7. The primary key for this database is 
Account Manager.  Enter the information as 
follows: 
• FIELD NAME: Account Manager 
• DATA TYPE: Short Text 
• DESCRIPTION: Unique Identifier 

of Account Manager 



  

~ 247 ~ 

 

• GENERAL TAB FIELD SIZE: 2 
• GENERAL TAB CAPTION: AM # 

ADDITIONAL FIELDS TO ADD TO THE DATABASE 

Step 8. Field #2 
• FIELD NAME: Last Name 
• DATA TYPE: Short Text 
• GENERAL TAB FIELD SIZE: 15 

Step 9. Field #3 
• FIELD NAME: First Name 
• DATA TYPE: Short Text 
• GENERAL TAB FIELD SIZE: 15 

Step 10. Field #4 
• FIELD NAME: Street 
• DATA TYPE: Short Text 
• GENERAL TAB FIELD SIZE: 20 

Step 11. Field #5 
• FIELD NAME: City 
• DATA TYPE: Short Text 
• GENERAL TAB FIELD SIZE: 20 

Step 12. Field #6 
• FIELD NAME: State 
• DATA TYPE: Short Text 
• GENERAL TAB FIELD SIZE: 2 

Step 13. Field #7 
• FIELD NAME: Postal Code 
• DATA TYPE: Short Text 
• GENERAL TAB FIELD SIZE: 5 

Step 14. Field #8 
• FIELD NAME: Start Date 
• DATA TYPE: Date/Time 

Step 15. FIELD #9 
• FIELD NAME: Salary 
• DATA TYPE: Currency 

Step 16. FIELD #10 
• FIELD NAME: Bonus Rate 
• DATA TYPE: Number 
• GENERAL TAB FIELD SIZE: Single 
• GENERAL FORMAT: Fixed 
• DECIMAL PLACES: 2 

Step 17. In the DESIGN ribbon, CLICK on VIEW in 
the views group 
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Step 18. CLICK on DATASHEET VIEW 
Step 19. You will be prompted to save the table. CLICK on YES to save the design of the table 

just created.  

ENTER RECORDS INTO THE TABLE 

Step 1. Once you have the field names in place, you do not need to type the field names again.  
With your Account Manager table in Datasheet View, Add the following Records: 

Account Manager 

AM # Last 
Name 

First 
Name Street City State Postal 

Code Start Date Salary Bonus 
Rate 

42 Lu Peter 5624 Murray Ave Davidson IN 46007 8/3/2015 $36,750.00 0.09 
31 Rivera Haydee 325 Twiddy St. Avondale IL 60311 6/3/2013 $48,750.00 0.15 

NOTE: Access is designed to enter large amounts of data into a table.  If you hit enter or tab after each 
entry, it will automatically advance you to the next field to enter the next bit of information.   

Step 2. RIGHT-CLICK the TABLE TAB  
Step 3. CLICK the CLOSE option to close the table

 
Step 4. The program will ask if you want to save.  CLICK on the YES option to confirm the 

save. 
Step 5. CLICK the FILE option 
Step 6. CLICK the CLOSE option to close MS Access. Your document is automatically 

saved when you close the file.  The data you created was saved into the table.  It is 
important to realize that Access is not like many other programs.  Make sure you do not 
leave your Access files open.  Close the file whenever you are finished with the session 
on your computer.  

ADD RECORDS TO AN EXISTING TABLE 

Step 7. Open MS Access. Notice that on the left-hand panel you may see your recent file. 
Step 8. On the bottom left corner, CLICK on OPEN OTHER FILES 
Step 9. CLICK on the BROWSE option 
Step 10. NAVIGATE to your UNIT 13 folder for this class 
Step 11. CLICK on the PrattLast Associates file  
Step 12. CLICK OPEN 
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Step 13. When opening a new database, your computer may give a security warning.  If the 
database is one that you created or one that comes from a trusted source, you can open 
it.  CLICK on the ENABLE CONTENT button 

Step 14. DOUBLE-CLICK the ACCOUNT MANAGER TABLE. Notice that the table 
opens into view and the two records you already entered are showing.   

Step 15. CLICK your MOUSE into the EMPTY RECORD 

Step 16. Add the following new records to your table: 

Account Manager 
AM 

# 
Last 

Name 
First 

Name Street City State Postal 
Code Start Date Salary Bonus 

Rate 
58 Murowski Karen 168 Trusdale Dr. Carlton IL 60313 11/9/2016 $24,000.00 0.08 
35 Simson Mark 1467 Hartwell St. Walker IN 46004 5/19/2014 $40,500.00 0.12 

Step 17. RIGHT-CLICK the TABLE TAB 
Step 18. CLICK CLOSE to close the table but keep the database file open.  

PREVIEW AND PRINTING THE CONTENTS OF A TABLE 

By previewing the contents of the table in Print preview, you can make any necessary adjustment to the 
orientation or to the margins before printing the contents. 

Step 1. If the Navigation Pane is closed, OPEN the NAVIGATION PANE  
Step 2. CLICK the SHUTTER BAR to open 
Step 3. SELECT the ACCOUNT MANAGER table 
Step 4. CLICK on the FILE tab to access the Backstage View 
Step 5. CLICK on the PRINT option 
Step 6. The next menu has three options to choose from.  CLICK on the PRINT 

PREVIEW option 
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Step 7. The Print Preview contextual tab will open. In the page layout group, CLICK 
LANDSCAPE 

Step 8. In the Page Size group, CLICK on MARGINS 
Step 9. CLICK on NORMAL 
Step 10. You may practice printing from this menu if you prefer; however, at this time you do not 

need to print for the exercise.  If you are satisfied with the print settings, CLICK on 
CLOSE PRINT PREVIEW to close the view and return to the table.  

 

IMPORTING AND LINKING DATA 
Prior to importing from Excel it is necessary to eliminate all of the formatting in the file. This includes, but 
is not limited to, centering, bold, underlining, etc. Also, ensure that there are no spaces in front of the 
column headings. By eliminating the spaces, you prevent importing errors and column heading issues, so 
Access can recognize the headings. These are some important guidelines to consider before trying an 
import from Excel to Access: 

 Make sure the data is in the form of a list: a collection of rows and columns in which all the entries 
in a column represent the same type of data 

 Be sure there are no blank rows within the list.  If there are, remove them prior to importing or 
linking.  

 Be sure there are no blank columns within the list. If there are, remove them prior to importing or 
linking. 

 Determine whether the first row contains column headings that will make appropriate file names 
in the resulting table.  If not, you should consider adding such a row.  In general, the process is 
simpler if the first row in the worksheet contains appropriate column headings.  
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You import a spreadsheet by using the import spreadsheet wizard.  In the process, you will indicate that 
the first row in the worksheet contains the column headings.  In addition, you will indicate the primary key 
for the table.  If appropriate, you can choose not to include all the fields from the worksheet in the 
resulting table.   

Step 1. CLICK on the EXTERNAL DATA 
TAB to display the External Data Ribbon 

Step 2. In the Import and Link group, CLICK the 
NEW DATA SOURCE button 

Step 3. CLICK the FROM FILE  
Step 4. CLICK on EXCEL 
Step 5. BROWSE to your UNIT 13 Student 

Files folder 
Step 6. CLICK the ACCOUNT file 
Step 7. CLICK on OPEN 
Step 8. CLICK on Import the source data into a new table in the current 

database 
Step 9. CLICK on OK 

FIRST ROW CONTAINS COLUMN HEADINGS 

Step 10. In the next dialog box, it is import that you CHECK the option for First Row 
Contains Column Headings 
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Step 11. CLICK the NEXT button to view more available options. 
Step 12. CLICK the NEXT button again.  There is currently no need to specify additional 

information regarding field options.  
Step 13. CLICK on CHOOSE MY OWN PRIMARY KEY 
Step 14. Since the Account Number is the first available field, it immediately comes into view.   
Step 15. CLICK on the NEXT button 
Step 16. IMPORT TO TABLE: Type Account 
Step 17. CLICK on FINISH 
Step 18. CLICK on SAVE IMPORT STEPS 

SAVE AS: IMPORT-ACCOUNT 

Step 1. DESCRIPTION: Import data 
from Account workbook 
into Account Table 

Step 2. CLICK on SAVE IMPORT 
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MODIFY THE TABLE 

It is usually necessary to modify a table created during the import process. The same principles applied to 
the original document (in this case Excel) are not transferred during the import. Take the following steps 
to modify the new table: 

Step 1. RIGHT-CLICK the ACCOUNT TABLE 
Step 2. CLICK on DESIGN VIEW 
Step 3. SCROLL through EACH FIELD for the following settings: 

FIELD NAME: Account Number (Primary Key) 
• DATA TYPE: Short Text 
• FIELD SIZE: 5 
• NOTES: Account Number (two uppercase letters followed by 3-

digit number) 
• CAPTION: AC # 

FIELD NAME: Account Name 
• DATA TYPE: Short Text 
• FIELD SIZE: 30 

FIELD NAME: Street 
• DATA TYPE: Short Text 
• FIELD SIZE: 20 

FIELD NAME: City 
• DATA TYPE: Short Text 
• FIELD SIZE: 20 

FIELD NAME: State 
• DATA TYPE: Short Text 
• FIELD SIZE: 2 

FIELD NAME: Postal Code 
• DATA TYPE: Short Text 
• FIELD SIZE: 5 

FIELD NAME: Amount Paid 
• DATA TYPE: Currency 

FIELD NAME: Current Due 
• DATA TYPE: Currency 

FIELD NAME: Account Manager Number 
• DATA TYPE: Short Text 
• FIELD SIZE: 2 
• NOTES: Account Manager Number (number of account manager 

for account) 
• CAPTION: AM # 

Step 4. RIGHT-CLICK the ACCOUNT TAB 
Step 5. CLICK on CLOSE  
Step 6. CLICK on YES to save your changes 
Step 7. CLICK on YES again to confirm the change 

CREATE A QUERY 
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In a well-designed database, the data that you want to present through a form or report is usually located 
in multiple tables. A query can pull the information from various tables and assemble it for display in the 
form or report. A query can either be a request for data results from your database or for action on the 
data, or for both. A query can give you an answer to a simple question, perform calculations, combine 
data from different tables, add, change, or delete data from a database. Since queries are so versatile, 
there are many types of queries and you would create a type of query based on the task. 

SIMPLE QUERY WIZARD 

For this activity, we will use the Simple Query Wizard.  The Simple Query Wizard is the quickest and 
easiest way to create a query.  

Step 1. If the Navigation Pane is closed, click the Shutter Bar Open/Close to OPEN the 
Navigation Pane 

Step 2. SELECT the ACCOUNT TABLE 
Step 3. CLICK on the CREATE TAB to display the Create ribbon band 
Step 4. In the Queries group, CLICK the QUERY WIZARD 
Step 5. SELECT the SIMPLE QUERY WIZARD 
Step 6. CLICK on the OK button 
Step 7. On the left pane (Available Fields) you have all the fields in the table.  Our goal is to 

populate the right pane with the desired fields 
for this query. This is done by clicking on each 
of the desired fields and clicking on the > to 
copy the field to the Selected Fields pane.  
CLICK on each of the FOLLOWING 
FIELDS and CONFIRM the transfer with the 
> 
 Account Number 
 Account Name 
 Amount Paid 
 Current Due 
 Account Manager Number 

Step 8. CLICK the NEXT option 
Step 9. CLICK the DETAIL option. The Detail shows 

all the records and fields.  Summary only shows 
computations (for example, the total amount 
paid).  

Step 10. CLICK the NEXT option 
Step 11. NAME the QUERY Account Query 
Step 12. CLICK on FINISH and OPEN the query to 

view information 
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ADJUST THE VIEW 

When you query comes into view, you may not be able to see all 
the data.  You can easily expand the columns by following these 
directions: 

Step 1. CLICK the MARKER between the FIELD 
NAMES.  Your mouse turns into a horizontal 
arrow with a cross 

Step 2. DRAG your MOUSE to the RIGHT until you 
reach the desired location 

Step 3. RELEASE your MOUSE 

Step 4. RIGHT-CLICK the ACCOUNT QUERY TAB 
Step 5. CLICK the CLOSE option 
Step 6. When prompted to save CLICK the YES option 

USE A CRITERION IN A QUERY 
Query criteria help you zero in on specific items in an Access database. If an item matches all the criteria 
you enter, it appears in the query results. 

To add criteria to an Access query, open the query in Design view and identify the fields (columns) you 
want to specify criteria for. If the field is not in the design grid, double-click the field to add it to the design 
grid and then enter the criterion in the Criteria row for that field. If you’re not sure how to make this 
happen, see Introduction to queries. 

A query criterion is an expression that Access compares to query field values to determine whether to 
include the record that contains each value. For example, = "Chicago" is an expression that Access can 
compare to values in a text field in a query. If the value for that field in a given record is "Chicago", Access 
includes the record in the query results. 

For this exercise, we are going to build a criterion in the Account Query 
that includes only those accounts managed by account manager 35.  
Follow these steps: 

Step 1. RIGHT-CLICK the ACCOUNT QUERY 
Step 2. CLICK on the DESIGN VIEW option to open the 

query in design view 
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Step 3. CLICK the CRITERIA ROW in the Account Manager Number column 
Step 4. Type 35 as the criteria for the Account Manager Number 

Step 5. The design tab should be in view.  In the results group, CLICK on the RUN option

 
Step 6. RIGHT-CLICK the ACCOUNT QUERY TAB 
Step 7. CLICK on the CLOSE option to save and close the query 
Step 8. CLICK on the YES option 

CREATE A FORM 
A form in Access is a database object that you can use to create a user interface for a database 
application. A "bound" form is one that is directly connected to a data source such as a table or query, 
and can be used to enter, edit, or display data from that data source. Alternatively, you can create an 
"unbound" form that does not link directly to a data source, but which still contains command buttons, 
labels, or other controls that you need to operate 
your application. For this exercise we are going to 
make a form bound to the Account Table in the 
PrattLast Associates Database: 

Step 1. With the database open, CLICK 
the ACCOUNT TABLE 

Step 2. CLICK the CREATE TAB to 
open the Create Ribbon 

Step 3. In the Queries group, CLICK 
the FORM button 
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Step 4. The form opens in Layout View.  If you CLICK on the FORM VIEW button, you 
should notice that the Property Sheet is disabled.  The Property sheet is for form 
designer to organize and adjust the form appearance but is not usually used when data is 
input into the form.  

Step 5. RIGHT-CLICK the FORM TAB for 
ACCOUNT 

Step 6. CLICK on CLOSE 
Step 7. CLICK on YES to save changes 
Step 8. In the SAVE AS box that appears, type 

Account Form as the Form name 
Step 9. CLICK on OK 

After you have saved a form, you can use it at any time by right-clicking the form on the Navigation Pane 
and then clicking Open on the shortcut menu. In addition to viewing data in the form, you can also use it 
to enter or update data, a process that is very similar to updating data using a datasheet.  If you plan to 
use the form to enter or revise data, you must ensure you are viewing the form in Form view.  

CREATE A REPORT 
Reports offer a way to view, format, and summarize the information in your Microsoft Access database. 
For example, you can create a simple report of phone numbers for all your contacts, or a summary report 
on the total sales across different regions and time periods. 

The design of a report is divided into sections that you can view in the Design view. Understanding how 
each section works can helps you create better reports. For example, the section in which you choose to 
place a calculated control determines how Access calculates the results. The following list is a summary 
of the section types and their uses: 

 Report Header – Use the report header for information that might normally appear on a cover 
page, such as a logo, a title, or a date. When you place a calculated control that uses the Sum 
aggregate function in the report header, the sum calculated is for the entire report. The report 
header is printed before the page header. 

 Page Header – Use a page header to repeat the report title on every page. 
 Group Header – Use the group header to print the group name. For example, in a report that 

is grouped by product, use the group header to print the product name. When you place a 
calculated control that uses the Sum aggregate function in the group header, the sum is for the 
current group. You can have multiple group header sections on a report, depending on how many 
grouping levels you have added. For more information about creating group headers and footers, 
see the section Add grouping, sorting, or totals. 

 Detail – This is where you place the controls that make up the main body of the report. 
 Group Footer – Use a group footer to print summary information for a group. You can have 

multiple group footer sections on a report, depending on how many grouping levels you have 
added. 

 Page Footer – Use a page footer to print page numbers or per-page information. 
 Report Footer – Use the report footer to print report totals or other summary information for 

the entire report. 
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You will find that it is much easier to create meaningful reports when your database has well-designed 
table structure and relationships (Microsoft Office, 2019).  

Step 1. In the PrattLast Associates database, SELECT the ACCOUNT table 
Step 2. CLICK the CREATE TAB to activate the Create Ribbon 
Step 3. In the reports group, CLICK the REPORT button 
Step 4. CLICK the SAVE button on the Quick Access 

tool bar or CTRL + S 
Step 5. SAVE AS Account Financial Report 
Step 6. CLICK the OK button 

MODIFY THE REPORT 

Access has four different ways to view reports:  

 Report View – Shows the report on the screen 
 Print Preview – Shows the report as it will appear when printed 
 Layout View – Similar to report view but it also allows you to make changes to the report. 
 Design View – Allows you to make changes but does not show the actual report.  

The following steps use Layout view to make the modifications to the report.  Working in Layout view 
gives you all the tools you need to make the desired modifications.   

Step 7. RIGHT-CLICK the Account Financial Report in the Navigation Pane 
Step 8. CLICK on DESIGN VIEW on the shortcut menu 
Step 9. CLICK on the PAGE SETUP to display the Page Setup ribbon 
Step 10. In the Page Layout group, CLICK on LANDSCAPE 

REMOVE THE EXTRA SPACE AT THE END OF THE REPORT 

Step 11. CLICK on the LAST LINE in the report to select 
the border.  Your mouse turns into a horizontal 
arrow with a cross 

Step 12. DRAG the CROSS toward the LAST 
VISABLE FIELD on the report 

Step 13. RIGHT-CLICK the REPORT to view the short-
cut menu 
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Step 14. CLICK the PRINT PREVIEW option.  The report is currently taking up 2 pages.  
Some of the columns have extra space that can be removed.  This can be fixed.  

Step 15.  RIGHT-CLICK the Account Financial Report in the Navigation Pane 
Step 16. CLICK on DESIGN VIEW on the shortcut menu 
Step 17. CLICK on the STREET field represented in the Page header  
Step 18. HOLD down your SHIFT key 
Step 19. CLICK on the STREET field represented in the Detail 
Step 20. With both fields selected, hover your mouse to get a two-pronged arrow.  CLICK and 

DRAG to the left to reduce the size of the field. 
Step 21. STOP when the FIELD SIZE LINES UP with the number 5 on the ruler bar

 
Step 22. CLICK on the CITY field represented in the Page header  
Step 23. HOLD down your SHIFT key 
Step 24. CLICK on the CITY field represented in the Detail 
Step 25. With both fields selected, hover your mouse to get a two-pronged arrow.  CLICK and 

DRAG to the left to reduce the size of the field. 
Step 26. STOP when the FIELD SIZE LINES UP with the number 6.5 on the ruler bar 
Step 27. CLICK on the STATE field represented in the Page header  
Step 28. HOLD down your SHIFT key 
Step 29. CLICK on the STATE field represented in the Detail 
Step 30. With both fields selected, hover your mouse to get a two-pronged arrow.  CLICK and 

DRAG to the left to reduce the size of the field. 
Step 31. STOP when the FIELD SIZE LINES UP with the number 7 on the ruler bar 
Step 32. CLICK on the AM # field represented in the Page header  
Step 33. HOLD down your SHIFT key 
Step 34. CLICK on the AM # field represented in the Detail 
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Step 35. With both fields selected, hover your mouse to get a two-pronged arrow.  CLICK and 
DRAG to the left to reduce the size of the field. 

Step 36. STOP when the FIELD SIZE LINES UP with the number 10.5 on the ruler bar 
Step 37. CLICK on the LAST LINE in the report to select the border.  Your mouse turns into a 

horizontal arrow with a cross 
Step 38. DRAG the CROSS toward the LAST VISIBLE FIELD on the report.  In this case, 

your report should end at 10.5 
Step 39. RIGHT-CLICK the Account Financial Report 
Step 40. CLICK on the PRINT PREVIEW option to check your result.  Notice that the full 

report fits on one page; however, the page numbers need and date to be moved to a 
better location and the total amount is slightly cutoff.   

MOVING FIELDS TO A BETTER LOCATION 

Step 41. RIGHT-CLICK the Account Financial Report in the Navigation Pane 
Step 42. CLICK on DESIGN VIEW on the shortcut menu 
Step 43. In the report footer, CLICK on the SUM AMOUNT FIELD 
Step 44. Hover your mouse over the top center of 

the field.  Your mouse will turn into a double 
arrow.  CLICK and DRAG the arrow UP 
to enlarge the field 

Step 45. In the page footer section, select the codes 
for the page numbers and number of pages.  Once the fields are selected, you and 
NUDGE the PAGE NUMBERS to the RIGHT using your RIGHT ARROW on 
your keyboard. 
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Step 46. REPEAT HITTING the RIGHT ARROW until the page numbers line up with the 
10.5-inch marker on the ruler bar 

Step 47. RIGHT-CLICK the Account Financial Report in the Navigation Pane 
Step 48. CLICK on LAYOUT VIEW on the shortcut menu 
Step 49. CLICK in the HEADER to change the wording for the header 
Step 50. Type Account Financial Report 

Step 51. RIGHT-CLICK the Account Financial Report tab to activate the short-cut menu 
Step 52. CLICK the CLOSE option 
Step 53. CLICK the YES option to save the report 
Step 54. CLOSE the ACCESS PROGRAM.  It is important that your Access database is 

closed before you try to submit the assignment.  Close Access completely down. 

SUBMIT YOUR ASSIGNMENT IN THE u13a1 ASSIGNMENT AREA: 

PrattLast Associates 
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ON YOUR OWN ACTIVITY 

Step 1. CREATE a NEW DATABASE  
Step 2. BROWSE to UNIT 13 (Make sure you are Saving to your Unit 13 folder on your 

computer) 
Step 3. SAVE AS Museum Gift Shop  

IMPORT VENDOR TABLE 

Step 4. GET EXTERNAL DATA the new source is an EXCEL FILE called Lab 1-2 
Vendor Data (located in your UNIT 13 Student Files) 
• First Row –  Column Headings 
• Primary Key –  Vendor Code 
• Table Name – Vendor (there is no need to save these import steps) 

Step 5. OPEN the DESIGN VIEW of the VENDOR TABLE 

VENDOR: Field Settings 
• Vendor Code - SIZE: 2  CAPTION: VC 
• Vendor Name - SIZE: 25 
• Telephone Number - SIZE: 12 

Step 6. SAVE and CLOSE the TABLE 

IMPORT ITEM TABLE 

Step 7. GET EXTERNAL DATA the new source is an EXCEL FILE called Lab 1-2 
Item Data (located in your UNIT 13 Student Files) 
• First Row –  Column Headings 
• Primary Key –  Item Number 
• Table Name – Item (there is no need to save these import steps) 

Step 8. OPEN the DESIGN VIEW of the ITEM TABLE 

ITEM: Field Settings 
• Item Number - SIZE: 4  
• Description - SIZE: 28 
• On Hand – FIELD SIZE: Integer 
• Wholesale Cost - CAPTION: Wholesale 
• Retail Price - CAPTION: Retail 
• Vendor Code - SIZE: 2  CAPTION: VC (notice these settings are the same in both the 

vendor and item tables.  This is a very important step for future activities.) 
Step 9. SAVE and CLOSE the TABLE 
Step 10. OPEN the ITEM TABLE in DATASHEET VIEW 

• ADJUST the COLUMNS to fit the data.   
Step 11. SAVE and CLOSE the TABLE 
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CREATE A QUERY 

Step 12. CREATE a SIMPLE QUERY for the ITEM TABLE 
• FIELDS – Item Number, Description, Wholesale Cost, Retail Price, Vendor 

Code 
• NAME – Item Query 

FORM AND REPORT 

Step 13. CREATE a SIMPLE FORM for the ITEM TABLE 
• FORM NAME – Item 

Step 14. CREATE a REPORT for the ITEM TABLE 
• Adjust the form settings to fit portrait on one page. 
• HEADING TITLE – Item Status Report 
• REPORT FOOTER – DELETE the TOTALS 
• SAVE AS – Item Status Report 

Step 15. CLOSE the ACCESS PROGRAM.  It is important that your Access database is 
closed before you try to submit the assignment.  Close Access completely down. 

SUBMIT YOUR ASSIGNMENT IN THE u13a2 ASSIGNMENT AREA: 

Museum Gift Shop 
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UNIT 14 –QUERING A DATABASE 

One of the primary benefits of using a database management system such as Access is having 
the ability to find answers to questions related to data stored in the tables of the database.  
When you pose a question to Access, or any other database management system, the question 
is called a query A query is a request for data or information from a database table or 
combination of tables. The query database feature is equal in necessity to data storage 
capability. Many query languages have been developed for different database engines and 
purposes, but the SQL language used by MS Access is by far the most ubiquitous and well-
known. 

Prior to SQL Server 2017, if you wanted to run SQL Server on your Mac, you first had to create 
a virtual machine (using VirtualBox, Parallels Desktop, VMware Fusion, or Bootcamp), then 
install Windows onto that VM, then finally SQL Server. This is still a valid option depending on 
your requirements. To run Access on a Mac Computer you will need one of the 
applications listed for a virtual machine.  

For this exercise, we will be using the PrattLast database file from Unit 13.  Follow these 
directions to proceed: 

Step 1. OPEN MS Access 
Step 2. BROWSE to UNIT 13  
Step 3. CLICK on PrattLast Associates 
Step 4. If you are prompted to enable content, CLICK the ENABLE option. 
Step 5. CLICK on the FILE TAB to display the Backstage View 
Step 6. CLICK on the SAVE AS option  

Step 7. An option to Save Database As pops up CLICK on the Access Database 
option 

Step 8. CLICK on SAVE AS again.  This is giving you the opportunity to save this file in 
a new location.   

Step 9. NAVIGATE to your UNIT 14 folder. 
Step 10. CLICK on SAVE.  Because the database is now in a new folder, you will not 

loose your original company files created in UNIT 13. Access saves as you go 
along. If you plan to modify the structure of the database, saving various stages 
of the process is a good practice.  
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Step 11. CLICK on ENABLE content. You are ready to begin the UNIT 14 activities. 

CREATE A QUERY IN DESIGN VIEW 
Step 1. With the Unit 14 PrattLast Associates 

company file open, CLICK on the CREATE 
TAB to display the Create Ribbon 

Step 2. In the Queries group, CLICK the QUERY 
DESIGN button 

Step 3. The SHOW TABLE option should automatically 
pop up, CLICK on ACCOUNT. If the Show 
Table option is not showing, you may need to 
bring it to view.  In the Show/Hide group, CLICK 
on Table Names.  This will open the Show Table 
option 

Step 4. CLICK on the ADD option.   This adds the table to the blank query. 
Step 5. CLICK on the CLOSE option in the Show Table dialog box.  This will remove the 

dialog box from the screen. 

ADD FIELDS TO THE DESIGN OF THE QUERY 

Step 6. DOUBLE-CLICK the ACCOUNT NUMBER field in the field list to add the field to 
the query.   

Step 7. DOUBLE-CLICK the ACCOUNT NAME field in the field list to add the field to the 
query.  You may need to scroll down the table to see the additional fields.  

Step 8. DOUBLE-CLICK the AMOUNT PAID field in the field list to add the field to the 
query.   

Step 9. DOUBLE-CLICK the CURRENT DUE field in the field list to add the field to the 
query.   

ADD A CRITERIA 

Step 10. CLICK the CRITERIA option for the ACCOUNT 
NUMBER field 

Step 11. Type JM323 
Step 12. CLICK on the RUN option in the Results group of the 

Design Ribbon.   You should have one record showing.   
Step 13. RIGHT-CLICK the QUERY TAB 
Step 14. CLICK on CLOSE. You will be prompted to save 
Step 15. CLICK on YES to save 
Step 16. In the Query Name box, type m02q01.  You are using 

this name because we will be creating multiple queries 
using this format.  Each query is numbered.  This is the 
first of many.   

Step 17. CLICK on OK 
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USING SAVED QUERIES 
For the next query, we are going to try saving some steps to the creation 
process by coping the query you already created for the Account table.  Follow 
these steps: 

Step 1. RIGHT-CLICK the m02q01 query to reveal the short-cut 
menu 

Step 2. CLICK on COPY 
Step 3. RIGHT-CLICK inside the Navigation Pane 
Step 4. CLICK PASTE 
Step 5. Type the new Query Name: m02q02 
Step 6. CLICK OK 

EDIT THE QUERY WITH A WILDCARD 

Wildcards are special characters that can stand in for unknown characters in a text value and are handy 
for locating multiple items with similar, but not identical data. Wildcards can also help with getting 
databased on a specified pattern match. 

Access supports two sets of wildcard characters because it supports two standards for Structured Query 
Language (ANSI-89, ANSI-92). When running queries and find-and-replace operations against Access 
databases, ANSI-89 is used.  The following table illustrates the process and the wildcards that can be 

used:  

Step 7. RIGHT-CLICK the m02q02 
Step 8. CLICK on DESIGN VIEW 
Step 9. Under the Account Number field, REMOVE the CRITERIA 

Step 10. In the Account Name field, Type K* for 
the new criteria 

Step 11. In the results group, CLICK on the RUN 
option 

Step 12. RIGHT-CLICK the m02q02 QUERY TAB 
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Step 13. CLICK on the DESIGN VIEW option. Notice that Access changed the K* to Like “K*” 
this is essentially the same criteria.  There is no need to type the word Like in the 
statement.  Access confirms the correct code for the wildcard item you typed. 

Step 14. RIGHT-CLICK the m02q02 QUERY TAB 
Step 15. CLICK on CLOSE to SAVE and close the Query 

ADD A FIELD TO A QUERY 

For the next query, we are going to try saving some steps to the creation 
process by coping the query you already created for the Account table.  Follow 
these steps: 

Step 1. RIGHT-CLICK the m02q02 query to reveal the short-cut 
menu 

Step 2. CLICK on COPY 
Step 3. RIGHT-CLICK inside the Navigation Pane 
Step 4. CLICK PASTE 
Step 5. Type the new Query Name: m02q03 
Step 6. CLICK OK 
Step 7. RIGHT-CLICK the m02q03 
Step 8. CLICK on DESIGN VIEW 
Step 9. Under the Account Name field, REMOVE the CRITERIA 
Step 10. In the table, DOUBLE-CLICK the CITY FIELD 

Step 11. In the City field, Type Granger for the new criteria 
Step 12. In the results group, CLICK on the RUN option 

Step 13. The next plan is to set the query so that the city field 
does not show but is still in the criteria of the query. 
RIGHT-CLICK the m02q03 Query  

Step 14. CLICK on the DESIGN VIEW 
Step 15. UNCHECK the SHOW button for the CITY FIELD 
Step 16. In the results group, CLICK on the RUN option. Note 

that the result for the query is the same; however, the 
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City group is not showing.  This technique is often used for compiling reports and other 
data from a table.  

Step 17. RIGHT-CLICK the m02q03 QUERY TAB 
Step 18. CLICK on CLOSE to SAVE and close the Query 

CREATE A PARAMETER QUERY 

A parameter is a piece of information you supply to a query right as you run it. Parameters can be used 
by themselves or as part of a larger expression to form a criterion in the query. You can add parameters 
to any of the following types of queries: 

 Select 
 Crosstab 
 Append 
 Make-table 
 Update 

Creating a parameter is like adding a normal criterion to a query.  Follow these steps to setup the query: 

Step 1. RIGHT-CLICK the m02q03 query to reveal the short-cut menu 
Step 2. CLICK on COPY 
Step 3. RIGHT-CLICK inside the Navigation Pane 
Step 4. CLICK PASTE 
Step 5. Type the new Query Name: Account-City 
Step 6. CLICK OK 
Step 7. RIGHT-CLICK the Account-City QUERY 
Step 8. CLICK on DESIGN VIEW 
Step 9. CHANGE the CRITERIA for the CITY field to 

[Enter City]. The square brackets indicate that the 
text entered is not text that the value in the column 
must match.  Without the brackets, Access would 
search for records in which the city is Enter City 

Step 10. In the results group, CLICK on the RUN option. 
Step 11. When prompted to enter the City, ENTER Wells 

for the City name 
Step 12. CLICK on OK to confirm your choice 
Step 13. RIGHT-CLICK the Account-City QUERY TAB 
Step 14. CLICK on CLOSE to SAVE and close the Query

 

COMPARISON OPERATORS AND NUMBERS 
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USE A NUMBER IN A QUERY 

Step 1. RIGHT-CLICK the m02q03 query to reveal the short-cut menu 
Step 2. CLICK on DESIGN VIEW 
Step 3. DELETE the CRITERIA under the CITY FIELD 
Step 4. ADD the number 0 (zero) to the CURRENT DUE CRITERIA 
Step 5. In the results group, CLICK on the RUN option. 
Step 6. RIGHT-CLICK the m02q03 query to reveal the short-cut menu 
Step 7. CLICK on the CLOSE option 

Step 8. If prompted, CLICK YES to SAVE the m02q03 QUERY 
Step 9. RIGHT-CLICK the m02q03 query to reveal the short-cut menu 
Step 10. CLICK on DESIGN VIEW. Notice that when you open the query again, the Current 

Due is still zero and the City field is no longer on the list. The number 0 (zero) does not 
have any quotes around it.  This is because the criteria reference is a number rather than 
a text. 

Step 11. CLOSE and SAVE the m02q03 QUERY 

USE A COMPARISON OPERATOR 

Unless you specify otherwise, Access assumes that the criteria you enter involve equality (exact 
matches).  In the last query, for example, you were requesting those accounts whose current due amount 
is equal to 0 (zero).  In other situations, you might want to find a range of results; for example, you could 
request accounts whose current due is greater than $2,000.00.  If you want a query to return something 
other than an exact match, you must enter the appropriate comparison operator.   

The following steps use the greater than operator in a query to demonstrate the process: 

Step 1. With the Unit 14 PrattLast Associates company file open, CLICK on the CREATE 
TAB to display the Create Ribbon 

Step 2. In the Queries group, CLICK the QUERY DESIGN button 
Step 3. The SHOW TABLE option should automatically pop up, CLICK on ACCOUNT 

Manager. If the Show Table option is not showing, you may need to bring it to view.  In 
the Show/Hide group, CLICK on Table Names.  This will open the Show Table option 

Step 4. CLICK on the ADD option.   This adds the table to the blank query. 
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Step 5. CLICK on the CLOSE option in the Show Table dialog box.  This will remove the 
dialog box from the screen. 
• DOUBLE-CLICK the Account Manager field in the field list to add the field 

to the query.   
• DOUBLE-CLICK the Last Name field in the field list to add the field to the 

query.  You may need to scroll down the table to see the additional fields.  
• DOUBLE-CLICK the First Name field in the field list to add the field to the 

query.   
• DOUBLE-CLICK the Start Date field in the field list to add the field to the 

query.   
Step 6. START DATE CRITERIA: Type >1/01/2015 

 
Step 7. CLICK on the RUN option in the Results group of the Design Ribbon.   You should 

have one record showing.   
Step 8. RIGHT-CLICK the QUERY TAB 
Step 9. CLICK on CLOSE. You will be prompted to save 
Step 10. CLICK on YES to save 
Step 11. In the Query Name box, type m02q04.  You are using this name because we will be 

creating multiple queries using this format.  Each query is numbered.  This is the first of 
many.   

Step 12. CLICK on OK 

 

USING COMPOUND CRITERIA 

Step 1. RIGHT-CLICK the m02q03 query to reveal the short-cut menu 
Step 2. CLICK on COPY 
Step 3. RIGHT-CLICK inside the Navigation Pane 
Step 4. CLICK PASTE 
Step 5. Type the new Query Name: m02q05 
Step 6. CLICK OK 
Step 7. RIGHT-CLICK the m02q05 QUERY 
Step 8. CLICK on DESIGN VIEW  
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Step 9. REPLACE the CRITERIA under the Current Due field 
Step 10. Type the new criteria as  >2500  
Step 11. In the results group, CLICK on the RUN option. The result shows only those orders 

over $2,500. 

Step 12. RIGHT-CLICK the m02q05 QUERY TAB 
Step 13. CLICK on the CLOSE ALL option 
Step 14. When prompted to Save, CLICK YES.  This closes any open queries, so you can 

proceed to the next step. 

QUERIES – AND VS OR 

When writing queries in Access, it is important to know where to place the criteria for the queries, as 
placing the criteria in the wrong place can drastically change the outcome. Although there are many ways 
to write criteria in Access queries, our focus will be on the ‘AND’ and ‘OR’ expressions, and where to 
place these expressions in queries to get the proper outcomes. 

 AND – When using AND, it is important to understand that the outcome of the query will give 
fewer answers. This is because AND requires that all criteria are true, to be displayed. 

 OR – When using OR, more answers will populate, as OR only requires that any one of the 
criteria statements is true, to be displayed. 

QUERY 1:  BUILD AN AND CRITERIA IN AN EXISTING THE QUERY 

For this exercise, we are going to revise the m02q05 to include an AND criteria: 

Step 15. RIGHT-CLICK the m02q05 QUERY 
Step 16. CLICK on the DESIGN VIEW option 
Step 17. DOUBLE-CLICK the ACCOUNT MANAGER 

NUMBER field to include it in the query 
• In the CRITERIA ROW under Account 

Manager Number, Type 31 
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• In the results group, CLICK on the RUN option. 

Step 18. CLICK on the CLOSE ALL option 
Step 19. When prompted to Save, CLICK YES.  This closes any open queries, so you can 

proceed to the next step. 

QUERY 2: BUILD AN OR CRITERIA IN A NEW QUERY 

For this exercise, we are going to copy the m02q05 query to m02q06 then build an OR criterion: 

Step 20. RIGHT-CLICK the m02q05 query to reveal the short-cut menu 
Step 21. CLICK on COPY 
Step 22. RIGHT-CLICK inside the Navigation Pane 
Step 23. CLICK PASTE 
Step 24. Type the new Query Name: m02q06 
Step 25. CLICK OK 
Step 26. RIGHT-CLICK the new m02q06 Query to view the shortcut menu options 
Step 27. CLICK on DESIGN VIEW 
Step 28. DELETE the 31 in the Account Manager Number criteria row 

• Note there is a row below the criteria row labeled or: This is where you want to type 
the OR criteria.  CLICK on the OR ROW below the ACCOUNT MANAGER 
NUMBER 

• Type 31  

• In the results group, CLICK on the RUN option.  

Step 29. CLICK on the CLOSE ALL option 
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Step 30. When prompted to Save, CLICK YES.  This closes any open queries, so you can 
proceed to the next step. 

SORT ENTRIES AND OMIT DUPLICATES 
When sorting in a query, the tables in which the query is based on is not actually sorted or rearranged.  
The Database Management System determines the most efficient method of simply displaying the 
records in the requested order.  The sort in the query is generally used to view specific records in a 
unique form.  It does not alter or adjust the data table in any way.  

Step 1. With the Unit 14 PrattLast Associates company file open, CLICK on the CREATE 
TAB to display the Create Ribbon 

Step 2. In the Queries group, CLICK the QUERY DESIGN button 
Step 3. The SHOW TABLE option should automatically pop up, CLICK 

on ACCOUNT. If the Show Table option is not showing, you 
may need to bring it to view.  In the Show/Hide group, CLICK on 
Table Names.  This will open the Show Table option 

Step 4. CLICK on the ADD option.   This adds the table to the blank 
query. 

Step 5. CLICK on the CLOSE option in the Show Table dialog box.  
This will remove the dialog box from the screen. 

Step 6. ADD the CITY field to the query 
Step 7. CLICK the SORT ROW to display a menu of possible sort 

orders 
Step 8. CLICK the ASCENDING option to select the row order 
Step 9. In the results group, CLICK on the RUN option. 
Step 10. RIGHT-CLICK the QUERY TAB to view the shortcut menu 
Step 11. CLICK the DESIGN VIEW option 
Step 12. CLICK the SECOND FIELD (empty field to the right of City) to produce an insertion 

point 
Step 13. In the show/hide group of the Design Ribbon, CLICK on the PROPERTY SHEET 

option 
Step 14. By default, the Unique Values is set to No.  CLICK the option next to UNIQUE 

VALUES 
Step 15. CLICK the YES option to define the property for unique values 
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Step 16. In the results group, CLICK on the RUN option. Notice that all the duplicate entries for 
the City field have been removed and the sort is in ascending order.  

Step 17. RIGHT-CLICK the QUERY TAB to view the short-cut menu 
Step 18. CLICK on the CLOSE ALL option 
Step 19. When asked to save, CLICK on the YES option 
Step 20. Type m02q07 as the QUERY NAME 
Step 21. CLICK on the OK option 

SORT USING MULTIPLE KEYS 

When you sort the data in an Access table, query, form, or report, you can save the sort order with the 
object. If you sort the data in one of these objects and then save the object, the sort order that is in effect 
when you save the object is automatically saved with the object. You can specify whether the saved sort 
order will be in effect when the object is next opened. 

For queries and reports, you can also define a default sort order. The default sort order is applied to the 
data in the query or report when no other sort order is specified. 

There are two kinds of saved sort orders: 

 Last-applied    A last-applied sort order is the sort order that was in effect when the object was 
last saved. Tables, queries, forms, and reports can all have last-applied sort orders. 

 Default    A default sort order is built into the design of a query or a report. A default sort order is 
applied when no other sort order is specified. 

When sorting two or more fields of a query, the field in the first position is referred to as the major key 
because it is key that will be sorted first.  In the following exercise, you will set the Account Manager 
Number to be the major key in the query: 

Step 1. With the Unit 14 PrattLast Associates company file open, CLICK on the CREATE 
TAB to display the Create Ribbon 

Step 2. In the Queries group, CLICK the QUERY DESIGN button 
Step 3. The SHOW TABLE option should automatically pop up, CLICK on ACCOUNT. If the 

Show Table option is not showing, you may need to bring it to view.  In the Show/Hide 
group, CLICK on Table Names.  This will open the Show Table option 

Step 4. CLICK on the ADD option.   This adds the table to the blank query. 
Step 5. CLICK on the CLOSE option in the Show Table dialog box.  This will remove the 

dialog box from the screen. 
Step 6. ADD the Account Number field to the query (HINT: The fields can be added with a 

click and drag from the table into the field list) 
Step 7. ADD the Account Name field to the query 
Step 8. ADD the Account Manager Number field to the query 

• SORT: Ascending 
Step 9. ADD the Amount Paid field to the query 
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• SORT: Ascending 

Step 10. In the results group, CLICK on the RUN option. Notice that all the duplicate entries for 
the City field have been removed and the sort is in ascending order.  

Step 11. RIGHT-CLICK the QUERY TAB to view the short-cut menu 
Step 12. CLICK on the CLOSE ALL option 
Step 13. When asked to save, CLICK on the YES option 
Step 14. Type m02q08 as the QUERY NAME 
Step 15. CLICK on the OK option 
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CREATE A TOP-VALUE QUERY 

Step 1. RIGHT-CLICK the m02q08 query to reveal the 
short-cut menu 

Step 2. CLICK on COPY 
Step 3. RIGHT-CLICK inside the Navigation Pane 
Step 4. CLICK PASTE 
Step 5. Type the new Query Name: m02q09 
Step 6. CLICK OK 
Step 7. RIGHT-CLICK the m02q09 
Step 8. CLICK on DESIGN VIEW 
Step 9. In the Query Setup group, CLICK the RETURN 

drop-down menu 
Step 10. SELECT the number 5. The results should show the first 5 rows of data in the query.   
Step 11. CLICK on the RUN option 

Step 12. RIGHT-CLICK the QUERY TAB to view the short-cut menu 
Step 13. CLICK on the CLOSE ALL option 
Step 14. When asked to save, CLICK on the YES option 

JOINING TABLES 
A database is a collection of tables of data that allow logical relationships to each other. You use 
relationships to connect tables by fields that they have in common. A table can be part of any number of 
relationships, but each relationship always has exactly two tables. In a query, a relationship is 
represented by a Join. 

WHAT IS JOIN 

A join specifies how to combine records from two or more tables in a database. Conceptually, a join is 
very similar to a table relationship. In fact, joins are to queries what relationships are to tables. 

The following are the two basic types of joins  
• The inner join 
• The outer join 

Both of which can easily be created from a queries design view. 
INNER JOIN 
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Let us now understand Inner Join − 

• The most common type of join is an inner join which 
is also the default join type in Microsoft Access. 

• Inner Join will display only the rows or records where 
the joined fields from both tables are equal. 

• This join type looks at those common fields and the 
data contained within. It only displays the matches. 

 
OUTER JOIN 

Let us now understand what an Outer Join is − 

• An outer join displays all rows from one table and only 
those rows or records from the other table where the 
joined fields are equal. 

• In other words, an outer join shows all rows from one 
table and only the corresponding rows from the other 
table. 

 

JOIN THE TABLES 
When a query contains two tables with the same field name (in this case Account Manager Number), 
Access will automatically assume the tables are to be joined in the query.  The type of join is determined 
by the step taken in the creation process.  Follow these instructions to 
proceed: 

Step 1. CLICK the CREATE TAB to display the Create 
Ribbon 

Step 2. CLICK the QUERY DESIGN button in the queries 
group 

Step 3. The SHOW TABLE option should automatically pop up, 
CLICK on ACCOUNT. If the Show Table option is 
not showing, you may need to bring it to view.  In the 
Show/Hide group, CLICK on Table Names.  This will open the Show Table option 

Step 4. CLICK on the ADD option.   This adds the table to the blank query. 
Step 5. CLICK the ACCOUNT MANAGER table.   
Step 6. CLICK on the ADD option.  Both tables should be in view.  
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The names of the fields in the two tables differ; therefore, Access did not automatically insert the line from 
the Account Manager field to the Account Manager Number field. Follow these instructions to insert the 
line: 

Step 7. CLICK the ACCOUNT MANAGER FIELD 
name in  the ACCOUNT MANAGER TABLE 

Step 8. DRAG to the ACCOUNT MANAGER 
NUMBER FIELD in the ACCOUNT TABLE 

Step 9. RELEASE your MOUSE.  The two fields are now 
joined. 

To include fields from both tables, it is necessary to click on the field name from the appropriate table and 
drag it into the design grid.  Follow these steps: 

Step 10. From the ACCOUNT MANAGER table, include the following fields: 
• Account Manager 
• SORT: Ascending 

• Last Name 
• First Name 

Step 11. From  the ACCOUNT table, include these fields: 
• Account Number 

• SORT: Ascending 
• Account Name 

Step 12. CLICK on the RUN option 
Step 13. RIGHT-CLICK the QUERY TAB to view the 

short-cut menu 
Step 14. CLICK on the CLOSE ALL option 
Step 15. When asked to save, CLICK on the YES option 
Step 16. Type Manager-Account for the Query Name 
Step 17. CLICK on OK 

 

 

 

 

CHANGE THE JOIN PROPERTIES 
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The join we just created was an Inner Join.  Only the rows or records where both fields from both tables 
were equal were showing.  Therefore, the account manager, Peter 
Lu, did not appear in the results.  He currently does not have any 
accounts. In the next steps we will change the join to an Outer join.   

Step 1. With the PrattLast Associates database open, 
RIGHT-CLICK the Manager-Account query 
to display the shortcut menu. 

Step 2. CLICK on the DESIGN VIEW option 
Step 3. RIGHT-CLICK the JOIN LINE for the two tables 
Step 4. CLICK the OPTION 2 button to include all 

records 
Step 5. CLICK the OK button 

Step 6. CLICK on the RUN option 
Step 7. RIGHT-CLICK the QUERY TAB to view the short-cut menu 
Step 8. CLICK on the CLOSE ALL option 
Step 9. When asked to save, CLICK on the YES option 
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CREATE A REPORT FROM A QUERY 
You can use queries to create reports.  In this exercise we will use the Manager-Account query in the 
PrattLast Associates database to generate a report. 

Step 1. With the PrattLast Associates database open, 
CLICK the MANAGER-ACCOUNT 
QUERY to select it. 

Step 2. CLICK the CREATE TAB to view the Create 
Ribbon band 

Step 3. In the reports group, CLICK the REPORT 
WIZARD button 

Step 4. If prompted to save, CLICK on YES 
Step 5. CLICK the ADD ALL FIELDS button to add 

all of  the available fields to the selected fields 
box.  

Step 6. CLICK the NEXT button 
Step 7. CLICK the NEXT button to confirm there is no grouping 
Step 8. Because your query already sorts the data, you can CLICK NEXT for the sorting 

option.  
Step 9. CLICK the TABULAR option for the layout of the report 
Step 10. CLICK the PORTRAIT option for the orientation. 
Step 11. CLICK the NEXT option 
Step 12. Name the report Manager-Account Report  

Step 13. CLICK the FINISH option to preview the report 
Step 14. RIGHT-CLICK the REPORT TAB to view the short-cut menu 
Step 15. CLICK on the CLOSE ALL option 
Step 16. When asked to save, CLICK on the YES option 
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CREATE A FORM FOR A QUERY 
You can use a query to supply data to a form or report in Access. You can use a query when you create 
the form or report, or you can change an existing form or report by setting its Record Source property. 
When you set the Record Source property, you can either specify an existing query, or you can create a 
new query to use. 

If you use a query as the record source, you might not be able to edit the data. Before you use a query as 
your record source, you should consider whether you need to edit data. 

The following steps create a form, then save the form.  This enables the form to be available for future 
use. 

Step 1. With the PrattLast Associates database open, CLICK the MANAGER-ACCOUNT 
QUERY to select it. 

Step 2. CLICK the CREATE TAB to view the Create Ribbon band 
Step 3. In the forms group, CLICK the FORM button 
Step 4. RIGHT-CLICK the FORM TAB to view the short-cut menu 
Step 5. CLICK on the CLOSE ALL option 
Step 6. When asked to save, CLICK on the YES option 
Step 7. At the Save As dialog box type Manager-Account Form 
Step 8. CLICK on the OK button 

After you have saved a form, you can use it at any time by right-clicking the form in the Navigation Pane 
and then clicking Open on the shortcut menu.  If you plan to use the form to enter data, you must ensure 
you are viewing the form in Form view.  
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EXPORT DATA FROM ACCESS TO OTHER APPLICATIONS 
Access provides several ways to copy an object such as a table or form from one database to another. 
Copying and pasting an object is easiest, but exporting an object offers you more options. For example, 
you can export the table definition and the data in the table, or export just the table definition (a blank 
copy of the table). You can also save the details of the operation as an export specification for future use. 

You can export a table, query, form, report, macro, or module from one Access database to another. 
When you export an object, Access creates a copy of the object in the destination database. 

You export database objects when you need to do any of the following tasks: 

• Copy the structure of a table to another database as a shortcut to creating a new table. 
• Copy the design and layout of a form or report to another database as a quick way to create a 

new form or report. 
• Copy the latest version of a table or form to another database at regular intervals. To do this, you 

can create an export specification the first time you export the object, and then use the 
specification to repeat the operation later. 

Note that exporting an object to another database differs very little from opening a second database and 
then importing the object from the first. The two main differences between importing and exporting objects 
between Access databases are: 

• You can import multiple objects in a single operation, but you cannot export multiple objects in a 
single operation. If you want to export multiple objects to another database, it is easier to open 
the destination database and then perform an import operation from within that database. 

• In addition to database objects, you can import relationships between tables, plus any import and 
export specifications, and menu bars and toolbars. You can also import a query as a table. 
Exporting does not offer you these options. 

The following steps export the Manager-Account Query to an Excel File: 

Step 1. With the PrattLast Associates database open, CLICK the MANAGER-ACCOUNT 
QUERY to select it. 

Step 2. CLICK the EXTERNAL DATA TAB to display the External Data Ribbon 
Step 3. In the export group, CLICK the EXCEL option 
Step 4. CLICK the BROWSE button and then NAVIGATE to the UNIT 14 folder on your 

computer.  
Step 5. CONFIRM the file format is an EXCEL 

WORKBOOK 
• FILE NAME: Manager-Account Query 
• CLICK the SAVE option 
• CLICK the OK button to export the information 
• CLICK the SAVE EXPORT STEPS 
• SAVE AS: Export-Manager-Account Query 
• DESCRIPTION: Export Manager Account Query without formatting 
• CLICK the SAVE EXPORT option 

RESTRICT RECORDS IN A JOIN 
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Sometimes you will want to join tables, but you will not want to include all possible records.  For example, 
you would like to create a repot showing only those accounts whose amount paid is greater than 
$20,000.00.  In this case you would relate the tables and include fields just as you did before.  You will 
also include criteria.  To include only those accounts whose amount paid is more than $20,000, you will 
include >20000 as a criterion for the Amount Paid Field 

Step 1. With the PrattLast Associates database open, CLICK the MANAGER-ACCOUNT 
QUERY to select it. 

Step 2. CLICK the DESIGN VIEW  
Step 1. ADD the AMOUNT PAID FIELD to the query 
Step 2. Type >20000 as the criterion for the Amount Paid Field

 
Step 3. CLICK on the RUN option 
Step 4. RIGHT-CLICK the QUERY TAB to view the short-cut menu 
Step 5. CLICK on the CLOSE ALL option 
Step 6. If asked to save, CLICK on the YES option

 

CALCULATIONS 
In a query Access allows you to create mathematical calculations based on numeric fields.  If a special 
calculation is required for a query, you need to determine whether the calculation is an individual record 
calculation (for example, adding the values in two fields for one record) or a group calculation (for 
example, finding the total of the values in a field on all the records).  

You can use these mathematical operators:  +  Addition; –  Subtraction; *  Multiplication;  /  Division.  You 
create calculations on numeric, $ and date fields. 

Step 1. With the Unit 14 PrattLast Associates company file open, CLICK on the CREATE 
TAB to display the Create Ribbon 

Step 2. In the Queries group, CLICK the QUERY DESIGN button 
Step 3. The SHOW TABLE option should automatically pop up, CLICK on ACCOUNT. If the 

Show Table option is not showing, you may need to bring it to view.  In the Show/Hide 
group, CLICK on Table Names.  This will open the Show Table option 

Step 4. CLICK on the ADD option.   This adds the table to the blank query. 
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Step 5. CLICK on the CLOSE option in the Show Table dialog box.  This will remove the 
dialog box from the screen. 

Step 6. ADD the FOLLOWING FIELDS to the 
query: 
• Account Number 
• Account Name 
• Amount Paid 
• Current Due 

Step 7. RIGHT-CLICK the FIRST OPEN FIELD row in the open column to display a 
shortcut menu 

Step 8. CLICK the ZOOM option on the menu 
Step 9. Type Total Amount:[Amount Paid]+[Current Due] in the Zoom dialog box  
Step 10. CLICK the OK option 
Step 11. CLICK on the RUN option 
Step 12. RIGHT-CLICK the 

QUERY TAB to view the 
short-cut menu 

Step 13. CLICK on the CLOSE 
ALL option 

Step 14. CLICK on the YES to save 
Step 15. CLICK YES to name the 

query 
Step 16. Query Name: m02q10 
Step 17. CLICK the OK option 
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CHANGE A CAPTION 

Step 18. RIGHT-CLICK the m02q10 query 
Step 19. CLICK on DESIGN VIEW 
Step 20. In the design grid, CLICK the AMOUNT PAID field 
Step 21. DISPLAY the PROPERTY SHEET (Design tab, show/hide group) 
Step 22. In the General Tab, CLICK on CAPTION 
Step 23. Type Paid as the caption 

Step 24. CLICK the CURRENT DUE field 
Step 25. In the Property Sheet, CLICK the CAPTION box 
Step 26. Type Due as the caption 
Step 27. CLICK on the RUN option 
Step 28. RIGHT-CLICK the QUERY TAB to view the short-cut menu 
Step 29. CLICK on the CLOSE ALL option 
Step 30. CLICK on the YES to save 

CALCULATE STATISTICS 

Step 1. With the Unit 14 PrattLast Associates company file open, CLICK on the CREATE 
TAB to display the Create Ribbon 

Step 2. In the Queries group, CLICK the QUERY DESIGN button 
Step 3. The SHOW TABLE option should automatically pop up, CLICK on ACCOUNT. If the 

Show Table option is not showing, you may need to bring it to view.  In the Show/Hide 
group, CLICK on Table Names.  This will open the Show Table option 

Step 4. CLICK on the ADD option.   This adds the table to the blank query. 
Step 5. CLICK on the CLOSE option in the Show Table dialog box.  This will remove the 

dialog box from the screen. 
Step 6. ADD the Amount Paid field to the query 
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• In the show/hide group, CLICK on TOTALS.  The total row will appear in the 
design grid

 
• In the total row, CLICK the GROUP BY option to 

view the drop-down menu 
• CLICK on AVG 
• CLICK on the DESIGN TAB CLICK on the RUN 

option 
Step 7. RIGHT-CLICK the QUERY TAB to view the short-cut 

menu 
Step 8. CLICK on DESIGN VIEW 
Step 9. ADD the Account Manager 

Number field to the query 
• In the total row, CLICK the GROUP 

BY option to view the drop-down 
menu 

• CLICK on WHERE 
• In the CRITERIA row, ENTER 31 
• UNCHECK the SHOW option 
• CLICK on the DESIGN TAB  
• CLICK on the RUN option 

Step 10. RIGHT-CLICK the QUERY TAB to view the 
short-cut menu 

Step 11. CLICK on the CLOSE ALL option 
Step 12. CLICK on the YES to save 
Step 13. CLICK YES to name the query 
Step 14. Query Name: m02q11 
Step 15. CLICK the OK option 



  

~ 287 ~ 

 

USE GROUPING 

Step 1. With the Unit 14 PrattLast Associates company file open, CLICK on the CREATE 
TAB to display the Create Ribbon 

Step 2. In the Queries group, CLICK the QUERY DESIGN button 
Step 3. The SHOW TABLE option should automatically pop up, 

CLICK on ACCOUNT. If the Show Table option is not 
showing, you may need to bring it to view.  In the Show/Hide 
group, CLICK on Table Names.  This will open the Show 
Table option 

Step 4. CLICK on the ADD option.   This adds the table to the 
blank query. 

Step 5. CLICK on the CLOSE option in the Show Table dialog 
box.  This will remove the dialog box from the screen. 

Step 6. In the show/hide group, CLICK on TOTALS.  The total 
row will appear in the design grid 
• ADD the Account Manager Number field to the 

query 
o Total: Group By 

• ADD the Amount Paid field to the query 
o Total: Avg 

Step 16. CLICK on the DESIGN TAB  
Step 17. CLICK on the RUN option 
Step 18. RIGHT-CLICK the QUERY TAB to view the 

short-cut menu 
Step 19. CLICK on the CLOSE ALL option 
Step 20. CLICK on the YES to save 
Step 21. CLICK YES to name the query 
Step 22. Query Name: m02q12 
Step 23. CLICK the OK option 



  

~ 288 ~ 

 

CREATE A CROSSTAB QUERY 
Crosstab queries in Microsoft Access allow you to do what normal 
SELECT queries do not: aggregate data across columns as well 
as rows.  

Crosstab queries are data retrieval queries used primarily for 
reporting purposes. They differ from typical SELECT queries in 
Microsoft Access in that they can pivot aggregated row data into a 
columnar format. The one prerequisite to this query is that the 
data must be aggregated in some fashion. The results from these 
queries are somewhat like spreadsheets in their format. However, 
the meaningful data is represented in columns, rather than rows. 

Step 1. CLICK the CREATE TAB to view the Create 
Ribbon band 

Step 2. CLICK the QUERY WIZARD button in the Queries group 
Step 3. In the New Query dialog box, CLICK the CROSSTAB QUERY WIZARD 
Step 4. CLICK the ACCOUNT TABLE  
Step 5. CLICK the NEXT option 
Step 6. With the table option button open, ADD the STATE 

field for the row headings 
Step 7. CLICK on the NEXT option. This will display the 

information for the column headings screen.   
Step 8. CLICK the ACCOUNT MANAGER NUMBER 

field 
Step 9. CLICK the NEXT option 
Step 10. CLICK the CURRENT DUE in the fields option 
Step 11. CLICK the SUM in the function options 
Step 12. CLICK the NEXT option 
Step 13. Type State-Manager Crosstab as the name of 

the query 
Step 14. CLICK on the FINISH option 

Step 15. CLOSE the PrattLast Associates database.  
Remember Access has been saving your information as you complete each query, report 
or form; however, you cannot upload the database unless the program is 
completely closed.  

Step 16. Navigate to your UNIT 14 folder for the class. 

SUBMIT YOUR ASSIGNMENT TO u14a1 ASSIGNMENT AREA 
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PrattLast Associates 

ON YOUR OWN ACTIVITY 

Step 1. OPEN MS Access 
Step 2. BROWSE to UNIT 13  
Step 3. CLICK on Museum Gift Shop 
Step 4. If you are prompted to enable content, CLICK the ENABLE option. 
Step 5. CLICK on the FILE TAB to display the Backstage View 
Step 6. CLICK on the SAVE AS option  

Step 7. An option to Save Database As pops up CLICK on the Access Database 
option 

Step 8. CLICK on SAVE AS again.  This is giving you the opportunity to save this file in 
a new location.   

Step 9. NAVIGATE to your UNIT 14 folder. 
Step 10. CLICK on SAVE.  Because the database is now in a new folder, you will not 

lose your original company files created in UNIT 13. Access saves as you go 
along. If you plan to modify the structure of the database, saving various stages 
of the process is a good practice.  

Step 11. CLICK on ENABLE content. You are ready to begin the UNIT 14 on your own 
activity. 

Step 12. Create a query for the Item table that includes all fields and all records in the Item 
table. Save the query as Step 1 Query 

Step 13. Create a query for the Item table that includes the Item Number, Description, 
Wholesale Cost, and Vendor Code fields for all records where the vendor code is 
AW. Save the query as Step 2 Query 

Step 14. Create a query for the Item table that includes the Item Number and Description 
fields for all items where the description starts with G.  Save the query as Step 3 
Query 

Step 15. Create a query for the Item table that includes the Item Number and Description 
for all items with a Wholesale Cost greater than $15.00.  Save the query as Step 
4 Query 
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Step 16. Create a query for the Item table that includes the Item Number, Description, and 
Wholesale cost fields for all items with a Wholesale Cost between $5.00 and 
$10.00. Save the query as Step 5 Query 

Step 17. Create a query for the Item table that includes the Item Number, Description, On 
Hand, and Wholesale Cost fields for all items where the number on hand is less 
than 5 and the wholesale cost is less than $15.00.  Save the query as Step 6 
Query 

Step 18. Create a query for the Item table that includes the Item Number, Description, 
Wholesale Cost, and Vendor Code for all items that have a Wholesale Cost 
greater than $20.00 or a Supplier Code of SD. Save the query as Step 7 Query 

Step 19. Create a query that join the Vendor and the Item tables.  Include the vendor 
Code and the Vendor Name from the Vendor table and the Item Number, 
Description, wholesale Cost, and Retail Price fields from the item table.  Sort the 
query in ascending order by Description within Vendor Code. Save the query as 
Vendor-Item Query 

Step 20. Create a form for the Vendor-Item Query. Save the form as Vendor-Item Form 
Step 21. Create a report using the Vendor-Item Query. Save the report as Vendor-Item 

Report 
Step 22. Create a query for the Item table that includes the Item Number, Description, 

Wholesale Cost, and Retail Price. Calculate the difference between Retail Price 
and Wholesale Cost (Retail Price – Wholesale Cost).  Assign the alias Mark Up 
to the calculated field.  Save the query as Step 12 Query 

Step 23. Create a query for the Item table that displays the average Wholesale Cost and 
the average Retail Price of all items.  Save the query as Step 13 Query 

Step 24. Create a query for the Item table that displays the Item Number, Description, On 
Hand and Retail Price for the 5 items with the lowest retail price.  Save the query 
as Step 14 Query 

Step 25. CLOSE the Museum Gift Shop database.  Remember Access has been saving your 
information as you complete each query, report or form; however, you cannot upload 
the database unless the program is completely closed.  

Step 26. Navigate to your UNIT 14 folder for the class. 

SUBMIT YOUR ASSIGNMENT TO u14a2 ASSIGNMENT AREA 

Museum Gift Shop 
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UNIT 15 – ACCESS MAIL MERGE ACTIVITY 

Suppose you have an Access Database containing the names and addresses of your customers. Every 
now and again you may want or need to send a standard letter to each customer who has opted in to 
such mailings. However, you are aware that these letters are going to look so much better, and work so 
much more effectively, if they are personalized to each recipient. A basic example of this is to print the 
name and address of the customer at the top of the letter, and to include the customers title and surname 
in the greeting line. We can go much further than this, of course, and include information about the 
customer’s account and even their previous orders (if appropriate). 

There are two ways of doing this. We could create an access report which is fine and good. After all, the 
data is stored in Access, so why not create the letter by means of such a report? It is certainly possible to 
do so. However, there may well be an advantage in merging your customer data stored in an Access 
table or query into an MS Word word-processing document. It is arguably much easier to sit down and 
compose a well-presented standard letter using MS Word (than it is to create the same document in an 
Access report). It might be said that Word is a better tool for this job. 

SETUP THE LINK FROM ACCESS TO WORD 

The process whereby data from a table is integrated into a word processing document is known as mail 
merge.  The following exercise create for Unit 15 uses and existing database to generate a form letter in 
MS Word that will merge all the records from the database.   

Step 1. OPEN the Willows Personnel Updated.accdb database located in your UNIT 15 
Student Files 

Step 2. CLICK on the EXTERNAL DATA tab to view the External Data Ribbon 
Step 3. SELECT the Smithfield query 
Step 4. In the Export group, CLICK the WORD MERGE option 
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Step 5. When asked “What do you want the wizard to do?” You have two choices, 
either to link your data to an existing Microsoft Word document or to create 
a new document. At this point you can create a new document. It will take 
the computer a few seconds to open a new Word file and bring it to the front 
of your screen.  

Step 6. SAVE your Word Document. Make sure that you have chosen your UNIT 15 folder as 
the saving area. Save your file as u15a1 Letter.   

Step 7. Add ClipArt to your Word 
Document – In the Word document, 
insert the Golf Logo from your UNIT 
15 student files.  

Step 8. RESIZE the Golf logo and enter a Word Art with the company name The 
Willows.  

Step 9. PLACE the WordArt next to the Golf Logo (you are creating a letterhead).  

Step 10. CUT the grouped LETTERHEAD and place it in the HEADER of the page.  

NOTE: You can change the shape, color and font of your Word Art any way you want.  In my example, I 
added a shape outline to the Word Art and then sized it, so it was the same size as the golf logo.  My next 
step would be to group the two and create a top/bottom wrap. 
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SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

CREATE THE FORM IN WORD 

Step 1. Set your MARGINS to NORMAL.  
Step 2. HIT ENTER until your curser is 2 inches from the top of the page. You 

can check your position through the Word status bar.  
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Step 3. CLICK the INSERT tab to display the Insert Ribbon 

Step 4. In the text group, CLICK on the DATE option 

Step 5. SELECT the THIRD OPTION (Month day, year) 

Step 6. HIT your ENTER key TWICE after the date is inserted. 

Step 7. CLICK the MAILING tab to display the mailings ribbon.   

Step 8. In the Write & Insert Fields group, CLICK on the INSERT MERGE FIELD 
icon.  Notice that all the fields available are now displayed.  

Step 9. CLICK on the field First Name and then press the space bar (this 

will generate a space between the first and last name).  
Step 10. CLICK the Insert Merge Field icon  
Step 11. CLICK to highlight the field Assistant_ManagerLast_Name  
Step 12. HIT the ENTER key. 
Step 13. CLICK the Insert Merge 

Field icon  
Step 14. CLICK to highlight the field 

Street 
Step 15. HIT the ENTER key 
Step 16. CLICK the Insert Merge 

Field icon  
Step 17. CLICK to highlight the field 

City hit your comma  
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Step 18. HIT your SPACE BAR 
Step 19. CLICK the Insert Merge 

Field icon  
Step 20. CLICK to highlight the State 

field  
Step 21. HIT your SPACE BAR 
Step 22. CLICK the Insert Merge 

Field icon  
Step 23. CLICK to highlight the field Zip  
Step 24. HIT the ENTER key. 
Step 25. ENTER the greeting Dear 

Step 26. HIT your SPACE BAR 

Step 27. CLICK the Insert Merge Field icon  
Step 28. CLICK to highlight the First_Name Field.   

Step 29. HIT the ENTER key 

Step 30. You will now create a letter to the assistant 
managers letting them know of the new ride 
sharing program which the Willows is 
offering. When you enter the sample text 
remember to press Insert Merge Field icon 
and select the appropriate field. 

SAMPLE TEXT:  

The Willows will be participating in a new ride share program. The company has 
decided that we will try the program out with individuals who live in Smithfield. 
Your manager, «The_Willows_ManagersLast_Name» said you might have 
interest in the new program. Please contact the Personnel Office as soon as 
possible so we can establish our van pool. 

Step 31. HIT the ENTER key 

Step 32. Type the complementary close – Respectfully 

Step 33. HIT the ENTER key TWICE 

Step 34. Type Your Name 
Step 35. Now remove the extra space in the inside address area.  Select the name 

and street.  On the Home Ribbon Band Paragraph Section >Choose 
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paragraph and line spacing> remove space after. Save your file.

 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

PREVIEW THE LETTERS 

Step 1. Once the letter is complete, select the Mailings 
Ribbon and Preview Results icon and you should 
see the contents of the first record of information fill 
the form letter.  

Step 2. Select the Finish and Merge icon and select Edit 
Individual Documents and then select All. Word 
will produce a separate letter for each customer in 
the query.  Save your file as u15a1 Letters 
Complete. 

Step 3. Save your result and upload it to Canvas under u15a1.  You will be 
uploading both files 
1. u15a1 Letter.docx - Make sure your field names are in view before you upload the 

file.  I need to see the fields you used to give you full credit. The trick here is to turn off 
the preview option.  Save the letter and upload it with the field names showing.  

2. u15a1 Letters Complete.docx 
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Your u15a1 Letters Complete.docx will contain 12 letters to the individual assistant 
managers in the Smithfield query.

 

 

EXTRA CREDIT ACTIVITY 
To complete this activity, you need to add the salary field to your letter.  Follow these instructions to add 
the field: 

Step 1. From your Unit 15 folder, OPEN the u15a1 Letter you have already saved and 
uploaded to Canvas.  

Step 2. HIT the ENTER key after the paragraph ending in van pool. 

SAMPLE TEXT TO INSERT 

Our current records indicate that you may qualify for a special transportation 
allowance.  Please verify the current salary information we have on file: 

• EMPLOYEE: Insert the correct fields (make sure your space between the 
First_name and Assistant_ManagerLast_Name) 

• SALARY: Insert the Salary Field 
• HIRE DATE: Insert the Date_Employed field 

SAVE YOUR CHANGES 

Save the file as u15e1 Letter Extra 
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FIX THE SALARY FORMAT 

Step 3. Once the letter is complete, select the Mailings Ribbon and Preview Results 
icon and you should see the contents of the first record of information fill the form letter.  

When you preview the document, you will find the salary field is not formatted for currency.  Numbers 
don’t always automatically display with the correct formatting (currency, decimals, etc.) To fix that, follow 
these instructions: 

Step 4. On your original source document (before completing the merge), right-click on the field 
and select “Toggle Field Codes.” 

Step 5. It will look something like this (where “Price” is your particular field name): 
{MERGEFIELD “Price”} 

Step 6. Place your cursor before the closing bracket and type: \# $,#.00 (There is a space 
between the first # and the $.) 

Step 7. It should look something like this: {MERGEFIELD “Price” \# $,#.00} 

Step 8. Right-click on the field name once again and select “Toggle Field Codes” to return to the 
original view.  Your prices should now display appropriately. 

WHAT DO THE SYMBOLS MEAN? 

\# Begins the “switch” which tells the document to apply formatting to the number. 

$ The character to display at the beginning of the number (in this case, a dollar sign). 

, Indicated that you want commas to designate thousands. 

# The number of number signs (#) typed after the comma indicates the number of digits that should 
be forced to display. 

.00 Indicated that you want to include a decimal point to two places with each number.  Anytime a 
number to be merged doesn’t include decimals, it will display with zeros. 

SAVE YOUR UPDATES 

Since the file is already saved you can now save your updates by simply holding down the CRTL key and 
taping the S key.  This is a good habit and keeps you from losing your work. 

u15e1 FILES TO SUBMIT: 

1. u15e1 Letter Extra.docx - Make sure your field names are in view before you upload 
the file.  I need to see the fields you used to give you full credit. The trick here is to turn off 
the preview option.  Save the letter and upload it with the field names showing.  

2. u15e1 Letter Extra Complete.docx 
 

UNIT 16 – GROUP POWERPOINT PROJECT 
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Now that you have a product, service or idea which you are going to market and 
spreadsheets which substantiate your product, service or idea, the final stage of the project is 
to incorporate a database which goes along with your current project. 

TASK FOR EACH GROUP MEMBER: 

Your task for this activity is to find some creative graphics that information you have compiled 
in all of the activities.  You can adjust your current information; however, if you should do so 
you will need to update the information in your group booklet.  For your review, these are 
some of the guidelines you have already established: 

1. Roles and Responsibilities of each Group Member 
2. Marketing Flyer 
3. Letter explaining the ethical considerations for your company 
4. Graph showing your company progress 
5. Reports that represents your company goals and/or projections. 

U16A1 PROJECT GUIDELINES 

Creating the PowerPoint Demonstration 

• Introduction: This is the part of the demonstration that should introduce your team 
members (active members only).  Give a brief description of what each member has 
contributed to your project and how they have fulfilled their responsibility to the group. 

• Marketing Flyer:  Use the marketing flyer you created in your PowerPoint to market 
your company and the products or business you are promoting.  You are not required to 
use the entire flyer.  It is just a reference, but you can certainly do so if you prefer. 

• Ethical Considerations:  I do not what a long explanation here.  What you should do is 
highlight the major points using bullets or some sort of creative display that emphasizes 
the ethical considerations of your company and the direction you will be implementing 
throughout the lifecycle of the business. 

• Graph:  Be creative!  Use the best graph from your group that shows and interesting 
projection or detail regarding your company.  Make an introduction to this slide and 
include it into your presentation. 

• Multi-Media Link:  Your presentation should have at least one multi-media link added to 
the PowerPoint.  This can be in the form of an embedded video or an existing video. 

WHAT TO TURN IN 

• Group Leader Upload to Canvas – In the group submission area the group PowerPoint 
should be submitted to Final Project assignment area. Group leaders make sure you 
include all the names of the members that participated in the final submission. 
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GRADING 

The PowerPoint presentation will be graded using the grading criteria below.  Make sure you 
review this totally.  I am looking for originality, slide transitions, proper theme layout. 

• Company Name and Logo - Company name and logo are incorporated into the 
PowerPoint. Color of PowerPoint blends with company logo  

• Ethical Considerations - The company major ethical considerations have been 
highlighted using bullets or some sort of creative display that emphasizes the ethical 
considerations of your company  

• Graph - Be creative! Use the best graph from your group that shows and interesting 
projection or detail regarding your company. Make an introduction to this slide and 
include it into your presentation. 

• Multi-Media Link - Your presentation should have at least one multi-media link added to 
the PowerPoint. This can be in the form of an embedded video or an existing video. 

• Overall Presentation and Images - Amount of text and images are a good 
balance/contrast; text is easy to read; company name, location, and an image of where 
the company can be located are presented. Project Objective and Group Introduced. 

INCORPORATING MULTI-MEDIA INTO A POWERPOINT PRESENTATION 

Studies have shown that multimedia presentations, using Microsoft PowerPoint, are an effective tool for 
encouraging retention of information. Educators often make use of presentations to teach students new 
concepts. In the business environment, presentations are often used as a sales tool. However, it is 
essential that multimedia technology is used appropriately to ensure successful outcomes.  

ADDING VIDEO FROM YOUR HARD DRIVE 
Step 1. While on the slide that you’d like to add the video to, 

go to the INSERT tab to view the Insert Ribbon 
Step 2. In the media group, CLICK the VIDEO option 
Step 3. CLICK on VIDEO ON MY PC 
Step 4. Navigate to the video file you would like to insert into 

the slide.  CLICK on the name of the VIDEO 
Step 5. CLICK on the INSERT. This will insert the video 

into your PowerPoint demonstration. 

EMBEDDING A VIDEO FROM YOUTUBE 
Step 6. Find your desired YouTube video.  If you see a share option at the 

bottom right of the screen, the video is available to embed into your 
PowerPoint presentation.  CLICK on SHARE 

Step 7. In this screen, you will find several options.  CLICK on EMBED 
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Step 8. This will open the code you need to embed the video into PowerPoint.  COPY the 

CODE 
Step 9. CLICK the SLIDE you want to add the video to 
Step 10. CLICK the INSERT tab to display the Insert Ribbon 
Step 11. In the media group, CLICK on the VIDEO option 
Step 12. CLICK on the ONLINE VIDEO option 
Step 13. CLICK on the box for “From a Video Embed Code” 
Step 14. RIGHT-CLICK the BOX for the code  
Step 15. CLICK the PASTE option. The code is now ready to 

insert into your demonstration 
Step 16. CLICK on the RIGHT ARROW that appears next to the box.  This will insert the 

code into the slide.  
Step 17. The video may originally appear as a black box; however, once you show the slide it will 

have the option to play.  TEST your SLIDE.  

ADDING MUSIC TO SLIDES 
If you want to spice up your PowerPoint presentation, a good soundtrack can make it much more 
compelling. PowerPoint allows you to use any WAV or MP3 file to play in the background. If you want to 
play multiple songs back-to-back, you'll get the best results by combining the songs into a single file first. 

Step 1. Open the slide you want to start the music on. If you want the music to play from the 
beginning of the presentation, select the first slide. 

Step 2. CLICK the INSERT tab to view the Insert Ribbon. If you want to use a song from 
iTunes, you'll need to convert it to MP3 first by right-clicking on the song in iTunes and 
selecting "Create MP3 Version". WAV files 
can be quite large and can make the 
PowerPoint presentation difficult to share. 
Consider converting the WAV file to MP3. 
You can do this by importing the WAV into 
iTunes, or by using a free online converter. 
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Step 3. In the Media group, CLICK the AUDIO option 
Step 4. SELECT the “Audio from My PC” option from the list.  
Step 5. BROWSE for the music file you want to play. You can select any WAV or MP3 

file that's stored on your computer or on any network drives. 
Step 6. CLICK the INSERT option from the dialog box 

Step 7. Decide if you want the music to start automatically or play when you click. There 
are two basic options for setting when your music starts. You can either have the song 
play when you click the button, or you can have the song play automatically in the 
background. There are two presets which allow you to quickly select one of these 
options:

 

If you want the song to start automatically and play in the background across all your 
slides, select the "Play in Background" option in the Playback tab. This will set the song 
to start automatically, continue playing when slides are changed, loop when finished, and 
hide the sound button. The song will start playing immediately when that slide is opened. 

If you prefer to click the button to start the sound instead, select "No Style" from the 
Playback tab. The song will play when you click the audio button. You can change the 
look of the button using the Format tab. This will let you design a button or import a 
picture to use instead. 

Step 8. Make basic edits to the audio file. PowerPoint includes some basic audio editing tools 
that allow you to change where the song starts playing from,  Adjust the volume, fade in 
and out, and more.  Select the audio object to open the Playback tab if  it isn’t already.   

Add bookmarks to the track. When you hover over the audio object, you'll see a track 
time slider. Select a spot on the track and click the "Add Bookmark" button to create a 
clickable bookmark at that point in the track. This will allow you to quickly jump to specific 
spots. 

Click the "Trim Audio" button to cut out unnecessary parts of the song. Useful for songs 
that are too long, or that you only need a piece of. Use the sliders in the Trim Audio 
window to select the new starting and ending point for the song. 
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Use the Fade Duration options to set the fade in and fade out times. The longer the 
duration, the more gradual the fade will be. 

Use the Volume button to adjust the master volume for the song. Make sure to test the 
song before the presentation and adjust the volume accordingly so that you don't startle 
the audience. 

Step 9. PowerPoint 2019 will embed the MP3 file into your presentation file. This will allow 
you to share the file with others without having to worry about sending the music file 
along with it.  Keep in mind that the size of the presentation will increase based on the 

size of the MP3 file. 

OPEN EDUCATIONAL (OER) AUDIO AND VIDEO SOURCES 

ccMister – ccMixter is a community music remixing site created by Creative Commons, which features music 
samples and complete remixes for public use. Each track is licensed under a Creative Commons license; 
however, the licenses may vary from item to item.  

Free Music Archive – The Free Music Archive is a library of free, legal audio downloads directed by the WFMU - 
a freeform radio station. Inspired by the open source movement and Creative Commons, the songs 
provided are openly licensed under terms set by the individual artists. 

Free Sound – FreeSound is a collaborative database of audio snippets, samples, sound recordings, and sound 
effects that have been released under open licenses to allow others to make use of them. Pay attention to 
the licenses of the individual items.  

Jamendo – Jamendo is an open music site that first was created as part of the open source/free culture movements. 
It provides free music in a variety of genres, available for download under Creative Commons licenses. 
Pay attention to the licenses granted for the individual songs. 

 

 

  

http://ccmixter.org/
http://www.freemusicarchive.org/
https://freesound.org/browse/
https://www.jamendo.com/start
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